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EDITOR’S NOTE JANICE CHEN THE PC IS THE GREATEST personal-productivity device ever to land on a desktop—if you know how to harness its maximum potential. And that’s what our feature “75 PC Tips & Tricks” (p. 79) is all about. Like most of our readers, I know my way around a computer keyboard pretty well. Yet given the complexity of Windows and the increasing number of applications we use daily, it’s hard to keep up with the latest shortcuts and performance tweaks. It doesn’t help that some of the best timesaving tricks lie hidden just below the surface of the interface. Our tips feature uncovers those secret tweaks, starting with general Windows XP advice (do you know how to disable those pesky balloon-help pop-ups?) and continuing with tips on Microsoft’s power quartet: Word, Excel, PowerPoint, and Outlook. You’ll finish this story a better browser, thanks to up-to-theminute advice on optimizing Internet Explorer and Mozilla’s Firefox. We round it all out with pointers on networking, MP3-file management, and essential system maintenance. In short, we show you how to save time by using your software smarter. Those looking to save space, however, should flip to our roundup of nine compact PCs. Whether you live in a shoebox apartment or simply want to ditch that unsightly tower, one of



LETTERS SKY-HIGH-DEFINITION TV



D



Although I bought an HD-ready television about three years ago, I still don’t have HD because of the lack of programming. Comcast may be recruiting Best Buy and Circuit City to sell for them (“Viewers Need Clearer Picture on HDTV,” June, p. 16), but there are several things they don’t tell you. First, you must get digital cable and the HD upgrade to get HD programming. And this still doesn’t mean your favorite channel is high-definition, nor is every show on an HD channel broadcast in HD. Want HBO or Showtime in high definition? That’s more money. If the stores want fewer returned HDTVs, Comcast is going to have to start justifying the cost of its service. Paul Williams



PSP SHUNS WINDOWS 98 Your review of the Sony PlayStation Portable (June, p. 50) missed an important



WIN!



the undersize guys in “Space Savers” (p. 95) is sure to fit your spatial and aesthetic needs. These desktops run the gamut of small from barely there to muscularly squat. Yet none skimp on power—or great looks, for that matter. Finally, if you prefer the look of a small telephone bill, turn to “The Broadband Bells” (p. 106). We installed and tested nine popular Voice over IP (VoIP) phone services, which enable you to attach a phone adapter to your broadband router and make inexpensive phone calls. Setup is snap-simple, and, for the most part, the audio quality of calls was truly surprising. We found that these services offer a host of cool digital features analog carriers can’t touch, all at prices as low as $19.95 per month for unlimited minutes throughout the United States. And that’s one of the best tips we can offer talkative techies. [email protected]



a JVC TH-C6 DVD Digital Theater System Go to computershopper.com/survey. See sweepstakes rules on p. 88.



fact: The PSP does not have backwardcompatibility support for Windows 98 out of the box. The PSP is the first USB device I’ve bought that came without a Windows 98 driver. But I learned from your GameFAQs message board that you can use a digital camera’s driver to connect the PSP with a Windows 98 machine. The driver at www. vivitar.com/CustService/ download/v3615/3615.zip worked for me. Chuangang Xie



MORE PANS, PLEASE! When I was in school, some students flunked, some excelled. Not so with your reviews. Every product receives a good review with minor caveats. Is your policy not to publish bad reviews, or has every single product remarkably shown no flaws? Just once, I would



like to see a reviewer comment: “This product sucks. I wouldn’t recommend buying it, ever.” Tom Lyon We began using a new ratings system with the July issue. While we’ve preserved our familiar 1-to-10 scale, we’ve recalibrated the criteria. This revised scale gives us a better opportunity to emphasize the differences between one product and another. For more information, go to www.computershopper. com/ratings. —Ed.



We want to hear from you. Letters, Computer Shopper 28 E. 28th St., 10th Fl. New York, NY 10016-7922 E - M A I L : [email protected] Letters may be edited for length and clarity, and may be published in any medium. WRITE:
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UPCOMING TECHNOLOGIES AND PRODUCTS



Intel, AOpen to Offer a Rival to Apple’s Mac Mini AOPEN has unveiled an Intel-based competitor to the Apple Mac Mini desktop, at press time called the Mini PC MP-915. At 2x5.9x5.9 inches, the Mini PC is slightly smaller than the 2x6.5x6.5 Mac Mini, and it has a similar whiteand-silver housing. Taiwan-based AOpen, an affiliate of PC maker Acer Group, serves mostly as a contract manufacturer for other companies. It is expected to sell bare-bones Mini PC systems starting around September, possibly under a different name. At press time, depending on the configuration, pricing was planned to begin at $499, like the Mac Mini, and go up to $699. (Bare-bones PCs usually sell without RAM or hard drives preinstalled.)



The Mini PC uses the new ATX Pentium M i915Ga-HFS, a hybrid motherboard based on a Socket 479 Pentium M (Dothan) CPU, Intel’s 915G



AOpen Mini PC MP-915



desktop chipset, and ICH6 I/O controller. It’s the first ATX Pentium M motherboard, according to AOpen. The system offers VGA, DVI, S-Video, and componentvideo outputs, two USB ports,



Phishing Scams Get More Sophisticated Users Fast-Forward PVR Growth Microsoft Discloses Details on Office 12 Gear



• TRENDSPOTTING



—Michael Singer, News.com, with



This past May marked the first time notebooks outsold desktops in the United States over the course of a full month. Analysts with research firm Current Analysis say laptop sales jumped to 53.3 percent of the total PC retail market in May. Last year, notebooks made up 45.9 percent of the total PC retail market. Occasionally, notebooks have outsold desktops, but those moments have happened during oneweek periods and are usually the result of extremely heavy promotions, according to Current Analysis.



Sean Portnoy



—M.S., News.com



and built-in 802.11a/b/g wireless networking. It will have an option for a DVD burner, DVD-ROM/CD-RW combo drive, or DVD-ROM drive, as well as Bluetooth support, depending on the configuration. The new design lets Intel take another run at the entertainment PC, heralded at the Consumer Electronics Show in 2004. The first generation didn’t sell well. This year, Donald MacDonald, a vice president of Intel’s digital home group, has said that future living-room units will be smaller, more stylish, and likely less costly. As for the Mini PC’s resemblance to the Mac Mini, AOpen says it has been developing small-form-factor desktops for more than two years, before Apple’s launch earlier this year of its tiny computer.



VoIP Still on Hold? Have you switched, or are you planning to switch, to a Voice over Internet Protocol (VoIP) service? Have switched to VoIP



5.7% What’s VoIP?



6.6%



Planning to switch to VoIP



10%



Not planning to switch



77.7%



Dell to Offer ‘Lexus’ Line of Premium PCs Dell has announced a new premium PC brand targeted at high-end home customers. The No. 1 PC maker says the brand, not yet named at press time, is slated to debut this fall. It would include both desktops and notebooks priced between $1,200 and $3,500, positioned just above the company’s Dimension and Inspiron product families. “Consider this the Lexus of our lineup,” says Mike George, vice president and chief marketing officer of Dell’s U.S. consumer business. According to George, the brand will appeal to a new breed of upper-tier PC buyers, not just “gearheads” always looking for the fastest system.



George says the initial machines would have a similar look and feel to Dell’s current XPS designs, such as its 9100-series PCs, then evolve as next-generation hardware features are introduced. Dell says the premium line will include new form factors as well as traditional multimedia consoles, towers, minitowers, desktops, and laptops. Despite robust sales for its high-end PC products, George says Dell is recognizing that an increasing number of customers are asking for more advanced systems with faster processors and memory, higher-capacity storage, and additional software bundles. —M.S., News.com



Source: Computer Shopper reader survey
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TRENDS TECH NEWS



SPAMMERS and phishers are learning more about potential victims to better hone their attacks. Phishing is a prevalent type of online fraud that attempts to steal sensitive information such as usernames, passwords, and credit-card numbers. The thieves then sell the information or use it to commit identity theft. The schemes typically combine spam e-mail and fraudulent Web pages that look like legitimate sites. Web sites that use e-mail addresses as identifiers for password reminders and registration are open to exploitation by scammers to generate detailed profiles of people, according to a recent research report by security company Blue Security. In the technique described in the report, spammers and



phishers automatically run thousands of e-mail addresses through Web-site registration and password-reminder tools. Because many online



businesses return a specific message when an e-mail address is registered with the site, attackers can find out whether that address represents a valid customer. Using information gathered from a number of sites, they can tailor malicious e-mail to



the recipient. That makes it more difficult for Internet users to distinguish real messages from those that are junk or part of a cyberscam. Also, customized messages are less likely to be caught by spam filters, experts say. “Imagine that somebody knows all the Web sites you ever registered with, and think about what one can infer from that,” says Eran Reshef, CEO of Blue Security. “By aggregating all this information, you create a very detailed profile of the person, not just snippets of information.” Reshef points out that some Web-site operators—major banks and eBay, for example— appear aware of the problem, preventing people from using their e-mail addresses as their login name. They also require additional information for registration or password reminders, or use other security measures. —Ina Fried, News.com



Study Finds Users Fast-Forwarding PVR Growth THE NUMBER of households subscribing to personal video recorder (PVR) services has grown to 9.2 million, up about 155 percent from a year ago, according to a new study from market-research firm In-Stat. In May 2004, only 3.6 million households worldwide had access to a PVR service. Hardware vendors had a windfall in 2004, with PVR shipment volume jumping to 11.4 million units, up from 4.6 million pieces sold in the previous year. “The deployment of PVR



16



products has been a success story for both pay-TV service providers and consumer-electronics manufacturers,” Mike Paxton, an In-Stat senior analyst, said



recorders with built-in hard drives, other product segments like cable-TV set-topbox-based PVRs are also flying off the shelves.” In addition, a recent InStat survey revealed that 89



Humax DRT-400 DVD Recorder with TiVo



in a release. “While the current growth of PVRs is being spurred by satellite-TV settop-box products and DVD
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percent of households were either “extremely satisfied” or “very satisfied” with their PVR service. —News.com Staff



How Will Microsoft Sweeten Office 12? While Microsoft is still not discussing most of the features it will add with Office 12, the company is promising to have the productivity-software suite ready by the second half of next year. Microsoft has revealed a few specific features it plans to add. As part of its attempt to let workers better make sense of evergrowing amounts of data, the company is adding into Excel the ability to create dashboards and scorecards that offer a quick way to visually keep track of just how a business is doing. Meanwhile, in PowerPoint, Microsoft says it is working to automate more of the graphics features from within the presentation program so workers can create documents that look good without much design effort. To handle the increase in e-mail, as well as the rise of instant messaging and other forms of electronic communication, Microsoft is trying to develop software that can do a better job of sorting out the really important messages. The new Office edition is slated to arrive at roughly the same time as Longhorn, the next version of Windows. The company has scrapped earlier plans that would have seen the two products tightly coupled together, however. Office 12 is expected to run on both Longhorn and older Windows versions, with the major changes to Office not dependent on any shifts in Windows. —I.F., News.com



Illustration by David Flaherty



Scammers Get More Sophisticated at Phishing



GEAR NEW PRODUCTS BY BRIAN BENNETT



Hassle-free headphones Want a wireless way to listen to music and other stereo audio residing on your PC? Check out Motorola’s Bluetooth Stereo Headset HT820 and Bluetooth USB PC Adapter PC850, which outfit your PC with modern technology for cordfree listening. The headset also acts as a handsfree headphone set for use with Bluetoothequipped cell phones. (Pricing was not set at press time.) Motorola, www.hellomoto.com
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Calling all pixels Merging the characteristics of a full-fledged digital camera and an advanced mobile phone, the $499.99 Samsung MM-A800 for Sprint PCS features a 2-megapixel charge-coupled-device sensor for snapping images that look sharp (by camera-phone standards). Sliding open to reveal its keys, the MM-A800 weighs 4.3 ounces and is moderately compact. Sprint, www.sprintpcs.com



Light weight Not just for nerds, Mitsubishi’s $799 PocketProjector is remarkably small and easy to carry. The 14-ounce device practically fits in your palm, and can project SVGA images on walls under dim-light conditions. It’s great for presentations on trips, or for displaying big video in small places. Mitsubishi Digital Electronics America, www.mitsubishipresentations.com



Hold everything Back up your data properly with the Netgear Storage Central SC101. Costing $129.99, the Storage Central chassis has space for two 3.5-inch IDE hard drives and connects to routers and network switches via its 10/100 Ethernet port. The Storage Central also accommodates RAID configurations. Netgear, www.netgear.com



Tough sack No ordinary knapsack, the $89.99 Targus Global Executive Backpack is a state-of-the-art tool for high-tech travelers. The air-cushioned case weighs 3.2 pounds, is protected by a scratch-resistant lining and weather-thwarting bottom, and has room for laptops with screens up to 15.4 inches in size. It even has a retractable blue light so you won’t have to fear the dark. Targus Group International, www.targus.com/us



Cellular navigation ALK’s $349 CoPilot Live Smartphone software package and pocket-size Bluetooth receiver transforms a Windows Mobile-based cell phone into a highly portable navigation platform. Shown here with the $249.99 Audiovox SMT5600, this Global Positioning System (GPS) module communicates with compatible handsets, which then display 3D maps in real time. ALK Technologies, www.alk.com
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REVIEWS THE LATEST HARDWARE AND SOFTWARE PRODUCTS



Velocity Micro ProMagix DCX Dual-core CPU yields design powerhouse VELOCITY MICRO has put together a digital design powerhouse. The $4,644 ProMagix DCX and its 3.2GHz Intel Pentium Extreme Edition 840 dual-core processor delivered the fastest application performance to date—especially during digital content creation. Though it may not hold the crown for long, considering what we’ve seen from AMD’s Athlon 64 X2 4800+, it’s the reigning performance champion. The DCX’s hulking case EDITORS’ RATING 7.3 offers lots of expansion opportunities inside and out, 0 BETTER >> 10 but it’s far from empty. The PROS Solid multithreadedExtreme Edition 840 not application performance; wellonly has the distinction of built; three-year warranty having two physical procesCONS Large case sors on one chip, but SPECS 3.2GHz Pentium Exit’s also the first treme Edition 840; 1GB DDR2; overclocktwo 74GB hard drives; 400GB able Intel hard drive; double-layer processor in DVD±RW; DVD-ROM/CD-RW combo; no monitor; ATI Radeon years. (Ours X850 XT Platinum Edition graphwas overclocked to ics (256MB); Windows XP Pro4GHz, the highest CPU clock fessional; WordPerfect Office 11 speed we’ve seen.) With 1GB Velocity Micro, 800-303-7866 of 667MHz DDR2 RAM, two www.velocitymicro.com 10,000rpm 74GB hard drives Direct Price $4,644 for fast access to frequently



What’s the Deal? In creating the powerful ProMagix DCX, Velocity Micro took full advantage of the overclocking capability of Intel’s dual-core Pentium Extreme Edition 840 CPU and surrounded it with excellent components. What it’s for: Digital content creation and running highend multithreaded applications. Who it’s for: Multimedia professionals and power users with deep pockets. What’s included: Three-year parts-and-labor warranty with toll-free phone support and a year of onsite service; Microsoft Internet keyboard and optical scroll mouse; WordPerfect Office 11 suite; Ulead Digital Creation Suite Extra essentials: High-end video-editing applications; 3D-graphics-design software; monitor; speakers The bottom line: Featuring an overclocked, dual-core processor, a blazing graphics card, and a smart trio of hard drives, the DCX is a serious digital-contentcreation PC—albeit for a steep price.



used apps and files, and an additional 7,200rpm 400GB drive for mass storage, the configuration is smart for a design PC. ATI’s high-end 256MB Radeon X850 XT Platinum Edition video card achieved an awesome 60 frames per second on our Half-Life 2 1,600x1,200 test, making this a great machine not just for graphics but for gaming. Everything is backed by a three-year warranty. With its overall score of 286 on BAPCo SYSmark 2004, the DCX delivers the fastest application performance we’ve seen. The breakdown of the individual scores speaks exceedingly well for the DCX’s suitability for design work. On office-productivity tests, its 227 score was only 2 points higher than our leading single-core PC, the Overdrive Torque.SLI. But on Internet-content-creation tests, the DCX’s 361 score All that overclocked processing power needs sufficient cooling. beat the Overdrive PC by Velocity used a side-panelmore than 100 points. mounted liquid-cooling system —John R. Delaney
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to keep things chilled.



in this section



PalmOne LifeDrive The first handheld with a built-in hard drive AIMING TO DELIVER productivity and entertainment in one slick device, the PalmOne LifeDrive is the first handheld with an integrated hard drive, giving users 4GB of storage space. Although the PDA performs well, its $499 price may limit its appeal to hard-core early adopters only. The LifeDrive is packed with features, so it’s no surprise the device is on the hefty side, at 6.8 ounces. The device’s 3.7-inch-diagonal, 320x480-pixel screen



EDITORS’ RATING 0



7.2



BETTER >>



10



PROS Integrated 4GB hard drive; Bluetooth, Wi-Fi; doubles as USB drive; plays MP3s, video; sharp screen



CONS Expensive; battery not userreplaceable; slow Web browsing; unimpressive battery life; thin sound PalmOne, 800-881-7256 www.palmone.com



Direct Price $499 grabs your attention with crisp text and colorful images. Also, its 4GB Hitachi hard drive provides plenty of room for Office documents, e-mails, appointments, and contacts. Even better, the PDA can serve as a storage drive when



connected to your PC via the included USB cable. Bluetooth wireless and 802.11b Wi-Fi wireless networking are also integrated. Powered by a fast 416MHz Intel XScale processor, the LifeDrive has enough pep to play back MP3 and WMA music, JPEG pictures, and even MPEG-4 movies. Videos were watchable, though we noted pixelation and blurriness during some intense action sequences. Also, Web pages loaded achingly slowly, and we observed some lag when switching between applications and opening files. Viewing photographs, however, was a treat on the sharp, bright screen. Though tunes sounded a bit thin, audio playback was relatively clear and quite loud. One drawback: The LifeDrive’s battery is not user-replaceable. Playing a looped MP3 playlist, the device petered out after 6 hours and 40 minutes. That’s not bad for a PDA, but below par compared with today’s MP3 players that use compact —Bonnie Cha hard drives.



The LifeDrive’s ample hard drive storage gives you plenty of room for the fun stuff, like photos, movies, and music.
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REVIEWS DESKTOPS



Dell Dimension XPS Gen 5 Media Center and gamer in one box DELL’S DIMENSION XPS Gen 5 doesn’t have the design polish or the components competing boutique-PC builders offer, such as 10,000rpm hard drives or a Scalable Link Interface (SLI) motherboard for dual-graphics-card support, but it does pack Intel’s dual-core 3.2GHz EDITORS’ RATING 6.0 Pentium Extreme Edition 0 BETTER >> 10 840 CPU. Although games PROS Dual-core processor don’t yet take advantage of provides strong multimedia platdual-core CPUs, the Gen 5 is form; lots of storage; quiet; poweran entertainment PC, and ful 3D performance its Windows Media Center CONS Flimsy plastic case; Edition 2005 operating syslimited selection of high-end tem and two-tuner TV card components will benefit from the multiSPECS 3.2GHz Pentium Extreme media and multitasking caEdition 840; 1GB DDR2; two pabilities of the dual-core 250GB hard drives; double-layer DVD±RW; DVD-ROM; 20-inch Dell processor. LCD; ATI Radeon X850 XT PlatThe Gen 5 retains the inum Edition graphics (256MB); Gen 4’s tool-less, rather Windows XP Media flimsy plastic silver-andCenter Edition 2005 black clamshell case, Dell, 800-915-3355 www.dell.com which offers plenty of exDirect Price $3,799 pansion room. Getting



Falcon Northwest Talon Slick SLI gamer at a reasonable price



around inside can be challenging, however. A green-plastic shroud directs airflow from one of three case fans to the processor, and a second shroud covers the hard drive bays. Two more fans cool the 650-watt power supply, which resides in a separate chamber at the base of the system. Even with all these fans spinning, the PC is remarkably quiet. Along with the 840 CPU, our $3,799 test configuration came with 1GB of 667MHz DDR2 SDRAM, a pair of 250GB hard drives, and a 256MB ATI Radeon X850 XT Platinum Edition graphics card. Its BAPCo SYSmark 2004 score of 230 ranks high among our current application-performance leaders, making the Gen 5 an excellent multitasker. It also turned in a respectable 54 frames per second on our demanding 1,600x1,200-resolution —John R. Delaney Half-Life 2 test.



EDITORS’ RATING 0



BETTER >>



6.4 10



PROS Large case leaves room THE MOST AFFORDABLE PC we’ve seen to date with dualgraphics-card Scalable Link Interface (SLI) support, the Falcon Northwest Talon is a good fit if you seek an expandable platform for gaming or midlevel graphics tasks. The case is more functional than flashy, and the system is customizable, but your choices are limited. Our $2,148 review unit arrived BYOE—Bring Your Own Everything—so you’ll need to supply the monitor, keyboard, mouse, and speakers. The all-black tower measures nearly 18 inches tall and just as deep. With just a small, single 80GB hard drive, a multiformat card reader, and a doublelayer DVD±RW drive in the case, plenty of space remains for upgrades. You’ll find four unoccupied external bays (three 5.25-inch and one 3.5-inch), three



to expand; 650-watt power sup-



extra hard drive bays, and ply; SLI graphics for reasonable two usable PCI slots. In adprice dition, the 650-watt power CONS Small hard drive on test supply provides enough unit; noisy; performance tweaks juice to grow. The large don’t have big impact transformer, plus CPU and SPECS 2.2GHz Athlon 64 GPU cooling fans, make 3500+; 1GB DDR; 80GB hard the Talon a noisy madrive; double-layer DVD±RW; two nVidia GeForce 6600 GT graphics chine, however. cards (256MB); no monitor; WinFalcon slightly dows XP Home Edition overclocked both the Falcon Northwest, 888-325-2661 2.2GHz Athlon 64 www.falcon-nw.com 3500+ CPU (up to Direct Price $2,148 2.4GHz) and the pair of BFG GeForce 6600 GT graphics cards. You’ll have to call Falcon to request the performance tweaks, though, which are covered under its one-year warranty. The adjustments didn’t amount to much, but the Talon didn’t disappoint, achieving 35 frames per second on our 1,600x1,200 HalfLife 2 test, indicating you can enjoy the most demanding 3D games at playable frame rates. Application performance was solid, too, with a score of 196 on BAPCo —Rick Broida SYSmark 2004. SECTION CONTINUES ON PAGE 34
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REVIEWS DESKTOPS



Cyberpower Gamer Infinity 9900 Pro Pricey processor proves potent CYBERPOWER’S Gamer Infinity 9900 Pro does everything from e-mail and word processing to image editing and digital entertainment. For $2,965, you get a highly competent gaming PC with lots of advanced components, inEDITORS’ RATING 6.7 cluding Intel’s 0 BETTER >> 10 high-end 3.6GHz Pentium 4 PROS Liquid-cooled CPU; lots 660 CPU, an excellent of drive-bay expansion space; built-in Wi-Fi; motherboard 19-inch LCD, and a 7.1 speaker enables overclocking system. Its case is a little extreme for a power-user PC, but CONS RAM sockets difficult to reach it can still tackle any task you throw at it. SPECS 3.6GHz Pentium 4 660; The X-Alienpower server 1GB DDR2; two 74GB hard drives; double-layer DVD±RW; case is not quiet, but overall DVD-ROM; 19-inch ViewSonic noise was lower than with the LCD; nVidia GeForce 6800 Ultra average PC, due in part to the graphics (256MB); Windows XP processor’s liquid cooling sysHome Edition tem. The interior, lit by blue Cyberpower, 800-707-0393 neon, is respectably tidy for www.cyberpowersystem.com Cyberpower. Only two PCI Direct Price $2,965 slots are free, but six drive



MPC ClientPro 365 Lack of speed hurts overall good package



0



6.3



BETTER >>



10



PROS Low-profile case; lots of USB ports; three-year warranty with onsite service CONS Below-average overall performer SPECS 3.2GHz Pentium 4 540J; 512MB DDR; 80GB hard drive; CD-RW; 17-inch MPC LCD; Intel integrated graphics; Windows XP Professional; Microsoft Office Standard Edition 2003 MPC Computers, 888-224-4247 www.buympc.com



Direct Price $1,399



Dell Dimension 5100C FIRST



Dell’s refresh of most of its Dimension desktop line



TAKE brings to an end its drab, gray-on-grayer, no-non-



THE MPC ClientPro 365 is a no-frills desktop in a compact, low-profile chassis. With a surprisingly sharp analog 17-inch LCD included, our $1,399 test system is a good deal, but its performance leaves something to be desired. Built around a 3.2GHz Pentium 4 540J with 512MB of RAM, integrated graphics, and an 80GB hard drive,



EDITORS’ RATING



bays are unoccupied. The Asus P5AD2-E Premium motherboard is loaded with overclocking features and has a built-in 802.11g wireless adapter that also acts as an access point. Getting to the motherboard’s empty RAM sockets is tricky, however. As you’d expect from a computer featuring a Pentium 4 660 CPU and backed by 1GB of 667MHz DDR2 memory and dual 10,000rpm 74GB hard drives, the 9900 Pro’s application performance is tops. The PC powered through our BAPCo SYSmark 2004 test with an exceptional overall score of 225, with particularly strong performance on the Internet-content-creation tests. On our 1,024x768 Half-Life 2 graphics test, the 256MB nVidia GeForce 6800 Ultra graphics card flipped frames at 73 per second. With this level of performance, the 9900 Pro could easily do dou—Bill O’Brien ble-duty as a gamer and graphics workstation.



the 365 is a model small-office PC. In our tests, though, it lagged behind similarly configured PCs, scoring a belowaverage 173 overall on BAPCo SYSmark 2004. On the plus side, MPC left room to beef up the PC internally, and six USB 2.0 ports—two in front, four in back—allow for plenty of peripherals. The software bundle and MPC’s threeyear warranty with onsite service up the value, too.



sense design, and the small-form-factor (SFF) Dimension 5100C is among the beneficiaries. It replaces the 4700C, shrinking the case even further and beefing up the internal components. Upside: The arctic-silver and alpine-white exterior is finished off with rounded corners and an interesting case cut-out for better ventilation. A pop-up panel up front hides the optical drive, USB 2.0 and FireWire ports, headphone jack, and flashmemory-card reader, a new option for Dell. The PC is highly configurable with a wide range of processors, from the budget Celeron D to a dual-core Pentium 4. Downside: Performance will depend on the components you choose, and the base configuration is pretty meek: 2.8GHz Pentium 4 520, 256MB of RAM, a CD-ROM drive, a 40GB hard drive, and integrated graphics (sharing system memory). Considering these components, $1,049 isn’t a great value. Worse, the warranty is only 90 days. Outlook: The new direction Dell has taken with the Dimension line was long overdue. Sleeker, quieter, and with better components, the 5100C will fit nicely on a desk in the dorm or at home in the den. —Joshua Goldman p Dell, 800-388-8542, www.dell.com Direct Price $1,049 (base configuration)



—Rick Broida SECTION CONTINUES ON PAGE 41
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REVIEWS NOTEBOOKS



HP Compaq NX9600 Desktop replacement needs a speed boost



Lenovo ThinkPad X41 Longevity in a tiny package AFTER RECENTLY PURCHASING IBM’s PC division, Lenovo continues the long line of ThinkPad X notebooks with the ThinkPad X41. It delivers a strong combination of portability, performance, battery life, and features. EDITORS’ RATING 6.7 Our $2,299 X41 0 BETTER >> 10 test model used a PROS Thin, light; comfortable 1.5GHz Low Voltkeyboard; includes fingerprint age Pentium M reader, dedicated security hard758 processor, ware; excellent battery life 512MB of DDR2 CONS Sluggish 4,200rpm hard memory, and a drive 4,200rpm 40GB hard drive. The SPECS 1.5GHz LV Pentium M 758; 512MB DDR2; 40GB hard 12.1-inch display drive; DVD-ROM/CD-RW combo; is clear and sharp. 12.1-inch TFT; Windows XP Though the lapProfessional top lacks a builtLenovo, 866-968-4465 in optical drive, its www.lenovo.com dock came with a Direct Price $2,299 DVD-ROM/CD-RW combo drive. The black, wedge-shaped X41 has a petite 1x10.4x8.2-inch footprint and weighs just 2.5 pounds (3.9 with its AC adapter). The laptop’s keyboard has full-size keys with a generous 2mm of depth. You’ll also find a TrackPoint pointing nub and a handy scroll button, plus a keyboard light for typing in dimly lit environments. A fingerprint scanner, along with a dedicated internal security chip, can block access and encrypt key data. The X41’s basic connections include two USB 2.0 ports, Gigabit Ethernet, and an Intel 802.11b/g Wi-Fi chip. Achieving a BAPCo MobileMark 2002 score of 165, the X41 proved to be a nimble ultraportable when running business applications. The little notebook also impressed us with its excellent 5 hours and 26 minutes of battery life. Lenovo covers the ThinkPad X41 with a three-year warranty, and it includes lifetime tech support. —Brian Nadel



THE HP COMPAQ NX9600 is a well-designed desktop-replacement notebook, but it lags behind the competition on performance. Although its 3.6GHz desktop Pentium 4 560 processor is theoretically fast, the EDITORS’ RATING 5.8 NX9600 has 1GB of fairly slow 400MHz 0 BETTER >> 10 DDR2 memory and a poky 4,200rpm PROS Large screen; strong 100GB hard drive. Our $2,149 test unit graphics performance; plenty of also carried an immense 17-inch display connectors with a superfine 1,680x1,050 native resolution, an advanced 128MB ATI Mobility CONS Slow compared with other desktop replacements; Radeon X600 graphics chip, and a multishort warranty format DVD burner. You get 802.11a/b/g Wi-Fi and Bluetooth connectivity, a SPECS 3.6GHz Pentium 4 560; 1GB DDR2; 100GB hard drive; FireWire port, Gigabit Ethernet networkDVD±RW; 17-inch TFT; Windows ing, and four USB 2.0 ports. XP Professional This laptop was a slow performer comHewlett-Packard, 800-888-0262 www.hp.com pared with other desktop replacements, Direct Price $2,149 though it earned decent scores on our 3D-graphics-application tests due to its Radeon X600 chip. The NX9600 comes with only a one-year warranty and a year of 24/7 toll-free phone —Stephanie Bruzzese support.



Dell Latitude X1 Svelte ultraportable has executive appeal THE DELL LATITUDE X1 is a sleek EDITORS’ RATING 7.0 ultraportable that serves up the power 0 BETTER >> 10 business users demand. The X1 weighs just 2.5 pounds, or 3.1 PROS Sleek, lightweight depounds with its AC adapter. The keysign; wide-screen display; selfpowered, external optical drive board is barely big enough to type on. It’s easy enough to manipulate the cursor CONS Cramped keyboard; with the touch pad, however. mediocre battery life Our $2,141 test configuration arrived SPECS 1.1GHz ULV Pentium M with a 1.1GHz Ultra Low Voltage Pentium 733; 512MB DDR; 60GB hard M 733 processor, a 60GB hard drive, and drive; DVD-ROM/CD-RW combo; 512MB of 400MHz DDR memory. The lap12.1-inch TFT; Windows XP Professional top also featured a self-powered external USB 2.0 DVD-ROM/CD-RW combo drive. Dell, 800-388-8542 Integrated graphics drive the 12.1-inch www.dell.com 1,280x800 (WXGA) wide-screen LCD. You Direct Price $2,141 also get Bluetooth and 802.11b/g wireless networking. The X1 scored a respectable 167 on our BAPCo MobileMark 2002 test. Less impressive was its battery life: 3 hours and 2 minutes, a short showing. Dell backs the X1 with a generous three-year —B.N. warranty and 24/7, toll-free tech support.
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Sony VAIO VGN-T350P A wireless pioneer for those who travel far and wide IF YOU’RE a hard-core road warrior who must remain in frequent contact with the office at any cost, then you’re a prime candidate for the $2,299 Sony VAIO VGN-T350P. Though it’s expensive, this ultraportable delivers extremely long battery life and a built-in cellular card. Our midnight-blue test unit came with a 1.2GHz Ultra Low Voltage Pentium M 753 processor, 512MB of slow 6.3 EDITORS’ RATING 266MHz memory, and an integrated graphics subsys0 BETTER >> 10 tem that borrows up to PROS Small, light case; built-in 64MB from main memory. cellular, Wi-Fi; integrated DVD The laptop’s screen was a burner; long battery life small 10.6-inch display with CONS Expensive; small keya 1,280x768 native resoluboard, display; costly cellular data tion. A midsize 60GB hard plans drive spinning at a sluggish SPECS 1.2GHz ULV Pentium M 4,200rpm and a built-in 753; 512MB DDR; 60GB hard DVD±RW burner rounded drive; DVD±RW; 10.6-inch TFT; out the VGN-T350P’s main Windows XP Professional storage options. For connecSony Electronics, 877-865-7669 tions, Sony included two www.sonystyle.com USB 2.0 ports, Bluetooth Direct Price $2,299 and 802.11b/g Wi-Fi net-



MPC TransPort T2300 Pricey traveler for business or pleasure



working, and a Memory Stick card. The VGN-T350P roams on Cingular’s Enhanced Data GSM Environment (EDGE) cellular data network, but monthly plans are costly ($19.99 for 5MB, $79.99 for unlimited data). In addition, we never achieved a transfer speed faster than 445Kbps. Weighing 3.1 pounds, the VGN-T350P is the size of a hardcover book. Even with its 11.5-ounce AC adapter, the laptop won’t be an undue burden. Not surprisingly, the keyboard and mouse buttons are tiny—though the touch pad is spacious. Recording a satisfactory BAPCo MobileMark 2002 score of 158, the VGN-T350P should have at least enough pep for ordinary business tasks. The laptop persevered for a long 6 hours on our battery-drain tests before powering down. The VGN-T350P ships with only a single year of return-to-depot service, and toll-free phone support also lasts for just a year. —Stephanie Bruzzese



EDITORS’ RATING 0



BETTER >>



6.6 10



PROS High-resolution display; MPC’S TRANSPORT T2300 is a costly but versatile laptop that well-heeled travelers will appreciate. It combines solid performance with extra security and remains light enough for long hauls. We tested a $2,510 model that arrived with a 1.86GHz Pentium M 750 processor, 512MB of 533MHz memory, a 15-inch display, and a small 5,400rpm 40GB hard drive loaded with Windows XP Professional. The sturdy, aluminum-cased TFT display supports a lush resolution of 1,400x1,050 (SXGA+); it’s driven by ATI’s Mobility Radeon X600 graphics chipset, backed by 128MB of RAM. Also, a hot-swappable DVD±RW/DVD-RAM drive provides a full range of disc-burning and backup options. The T2300’s 6.2-pound weight and dimensions of 1.25x12.9x10.8 inches make for easy portability. The wide keyboard includes
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handy programmable conlightweight; includes fingerprint scanner, multiformat DVD drive trols, while the touch pad and mouse buttons are CONS Small hard drive; comfortable and large. expensive In addition, a useful fingerSPECS 1.86GHz Pentium M print scanner takes the 750; 512MB DDR2; 40GB hard hassle out of frequent drive; DVD±RW/DVD-RAM; 15-inch TFT; Windows XP logins. Professional In our tests, the T2300 didn’t blow away similarly MPC Computers, 888-224-4247 www.mpccorp.com configured systems, but it delivered a competent Direct Price $2,510 BAPCo MobileMark 2002 score of 194. The laptop’s battery endured for a decent, if not spectacularly long, 3 hours and 11 minutes. The T2300 supplies a full range of connectivity options, including 802.11a/b/g Wi-Fi, Gigabit Ethernet, a combination SD/Memory Stick Pro/Memory Stick Duo card reader, four USB 2.0 ports, and one FireWire port. MPC’s standard three-year warranty, augmented by 24/7 toll-free tech support, makes the —Levy Vargas T2300 a reassuring investment.



REVIEWS COMPONENTS



LaCie d2 Extreme With Triple Interface Slick hard drive delivers ample capacity, fast performance TEXT FILES and spreadsheets may not take up much space, but all those digital images and music files sure do. If your hard drive’s getting a little crowded, LaCie’s d2 Hard Drive Extreme with Triple Interface (in 160GB, 200GB, or 250GB capacities) can give you some expansion room. It also makes a great backup device to protect against hard drive failure. Built like a tank, the d2 is quiet, roomy, and fast. With its matte-silver exterior and subdued front panel, it’s also stylish. The drive’s best attribute, however, is its versatility. The back panel houses an abundance of ports, providing connectivity via USB 2.0, the new EDITORS’ RATING 8.0 FireWire 800 standard, or its predecessor, FireWire 400. A > > 0 BETTER 10 Kensington-lock slot works PROS Stylish; excellent with optional locking gear to performance; FireWire 800 prevent drive theft. In addisupport tion, a heat-dissipating vent CONS Requires FireWire 800 keeps the interior cool. card for fastest performance The d2 performed well in LaCie, 503-844-4502 our 400MB-folder and 1.9GBwww.lacie.com large-file copy tests, averagDirect Price $179 (160MB); ing 10.2MB per second with $219 (200MB); $249 (250GB) USB 2.0, 11.4MB per second



Logitech MX518 Pinpoint accuracy for those who hate to lose FORGET FAST processors and pricey graphics cards—if you’re looking for a gaming upgrade, you need Logitech’s MX518 Gaming-Grade Optical Mouse. Whether you’re homing in on an enemy or surfing the Web, this $49.99 mouse is a must. Outfitted in gray and black, the MX518 has five user-programmable buttons, a scroll wheel, two dedicated buttons for adjusting the mouse’s sensitivity on the go, and an application-switching button (the equivalent of hitting Alt+Tab). The MX518, which connects to your PC via USB, is designed for right-handed gamers only. If you are one, though, you’ll find the mouse extremely comfortable to use. Even during intense deathmatches, we never once hit the wrong button. The MX518 has an EDITORS’ RATING 8.7 amazingly sharp 1,600-dotper-inch (dpi) resolution 0 BETTER >> 10 that we originally found too PROS Comfortable; five prosensitive, but we discovered grammable buttons; 1,600dpi the sweet spot with some optical sensor with on-the-fly tweaking. In fact, we consensitivity-adjustment buttons sistently found ourselves CONS Designed for rightchanging the mouse’s senhanded users only sitivity during gameplay— Logitech, 800-231-7717 an option you’ll wonder www.logitech.com how you ever lived without.



Direct Price $49.99
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—William O’Neal



with FireWire 400, and a whopping 12MB per second with FireWire 800. (With any interface, the previous high on our tests was 9MB per second.) If the incremental speed boost FireWire 800 provides is important to you, you’ll need one of Apple’s latest Macs or an adapter such as the $79.99 Adaptec FireConnect 8300 to take full advantage of it. In a single-drive setup, it’s a noticeable but not monumental gain. In a RAID array, where you’d piggyback two external drives for redundancy, the doubled band—Jon L. Jacobi width would have a much greater impact.



Sony DRX-800UL FIRST



Sony is renowned for designing stylish devices with



TAKE premium price tags, and its DRX-800UL is no exception. This external DVD drive offers plenty of power in a sleek, compact case built to complement today’s most distinguished PCs. Equipped with both FireWire and USB interfaces, this drive is also as versatile as it is good-looking. Upside: The DRX-800UL writes to DVD+R and DVD-R media at 16x, fast enough to burn a full disc in just 6 minutes. The drive also writes to double-layer discs at 4x, as well as to DVD+RW and DVD-RW discs at 8x and 6x, respectively. In addition to its impressive speeds, the drive ships with a suite of Nero software that includes Nero Burning ROM 6 SE, NeroVision Express 6, and Nero BackitUp. Downside: There’s little to dislike about the DRX-800UL. Though it doesn’t feature the fastest doublelayer burning speeds (currently, the fastest drives max out at 6x), it still offers a respectable 4x. Outlook: A comprehensive software bundle, fast rewriting times, and double-layer support make the DRX-800UL worth considering for PC users looking to upgrade their optical drive or purchase a quick backup solution. —Louis Ramirez p Sony Electronics, 877-865-7669, www.sonystyle.com Direct Price $209.99 (before $30 mail-in rebate)



REVIEWS DISPLAYS



AG Neovo M-17 Stylish LCD offers mediocre performance WITH ITS MAC-LIKE STYLING and stunning looks, AG Neovo’s $329 M-17 is a sturdy LCD for anyone in a design-conscious setting. Though it offers inconsistent image quality and a rigid design, the M-17 is adequate for most daily tasks. The downside to the M-17’s easel-like shape is that it’s not as adjustable as other 17-inch displays. You can tilt the panel back about 20 degrees, but there’s no side-to-side swivel, no portrait/landscape pivot EDITORS’ RATING 6.2 function, and no height adjustment. On the upside, a 0 BETTER >> 10 kickstand leg gives the disPROS Sturdy, good-looking play a sturdy feel, and the design; two built-in USB ports LCD features two USB ports, CONS Minimal adjustability; as well as both analog and image quality varies depending digital inputs. on viewing angle; poor integrated The M-17’s menu buttons speakers are intuitive, and navigating AG Neovo, 408-321-8210 through the onscreen menu www.neovo-usa.com is easy. With the push of a List Price $329 button, you can switch among six preset modes, each with different brightness, contrast, and color-temperature settings. With its sharp text and vibrant colors, the M-17 is fine for everyday use. Our DisplayMate tests revealed hue shifting



and color-tracking errors, however. Moreover, the display was incapable of reproducing the most extreme shades of dark and light gray. Gray-scale performance was at its best when the display was completely vertical. Screen uniformity was similarly affected by the viewing angle, though even when we held it upright, the top half of the screen looked darker than the bottom. Also, we were unimpressed by the built-in speakers, which sounded tinny and faint even at their loudest setting. —Kristina Blachere



HP L1940



EDITORS’ RATING



Flexible LCD proves unstable



0



6.1



BETTER >>



10



PROS Clear text; highly WHAT WE LIKE the most about HP’s 19-inch L1940 is also what we dislike: its adjustability. The L1940 is so flexible, it borders on unstable. Nevertheless, its image quality, especially with text, is good, making this $499 LCD worth a look. The panel’s lazy-Susan-like base swivels the entire display 360 degrees, which allows the monitor to wobble back and forth at the slightest touch. Likewise, the L1940’s double-hinged neck makes it so fluid that it moves by itself. The two hinges, one at the base of the neck and one at the top, allow the top of the display to rise almost 20 inches above your desk, or the bottom to drop within just 1.5 inches of
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its surface. Ironically, rotatadjustable; three USB 2.0 ports ing the L1940 from landCONS Unstable base; lacks scape to portrait orientation pivoting software, speakers, headphone jack, DVI cable is difficult because its joints don’t Hewlett-Packard, 800-888-9909 move as easily. www.hp.com HP doesn’t inDirect Price $499 clude pivoting software with the LCD, so you’ll need to spend $40 for Portrait Displays’ Pivot Pro software. Also missing are a headphone jack, integrated speakers, and a DVI cable, though we appreciated the inclusion of three USB 2.0 ports. We tested the L1940 at its native resolution of 1,280x1,024 using a VGA connection, and the results were favorable, especially with text. Performance with colors was less impressive, however. Instead of smoothly progressing from dark gray into black, the screen jumped abruptly to black. Blues and reds had an equally hard time transitioning smoothly. On our DVD-playback test, the L1940 showed an unexpected knack for displaying accurately colored flesh tones in a performance that was otherwise average. —Jeffrey Fuchs



REVIEWS PRINTERS



Canon ImageClass MF5750 Multifunction laser offers all the basics CANON’S IMAGECLASS MF5750 is a machine geared for home offices, combining a 600-dot-per-inch (dpi) mono0 BETTER >> 10 chrome laser printer with a 1,200dpi PROS Fine text quality; gray-scale and color scanner. accurate color scans; toll-free The $399 MF5750 features a 50-page tech support automatic document feeder, along with CONS Copies slowly; limited a 250-sheet removable paper tray. expansion options; expensive But there’s no room for a duplexer, nor toner can you buy additional paper trays. Canon U.S.A., 800-652-2666 Furthermore, the unit’s 2,500-page usa.canon.com combined toner cartridge and drum Mfr. Est. Price $399 costs $74, so a page of ordinary text runs almost 3 cents to print. In our tests, the MF5750 turned out impressive black text at 14.8 pages per minute (ppm). Likewise, grayscale print jobs produced a pleasing range of shades, although gray-scale scans lacked contrast. (Color scans were more accurate.) The MF5750 clocked in at 3.9ppm scanning gray-scale documents and 3.7ppm for color. Photocopying averaged a poky 4.2ppm. In addition to its business-friendly software package, the MF5750 also comes with access to —Dan Littman live, toll-free phone support.



EDITORS’ RATING



HP Deskjet 6840 Budget inkjet doubles as photo lab FAMILIES, home offices, and organizations on a tight budget will appreciate the HP Deskjet 6840. This $179.99 inkjet delivers reliable print quality, fast photo-print speeds, and built-in Wi-Fi and Ethernet capability. Beneath its gloss-black exterior, the 6840 houses a 50-sheet output tray that awkwardly doubles as the cover of the 150EDITORS’ RATING 7.6 sheet input tray. For two-sided printing, 0 BETTER >> 10 business users will PROS Consistently good print have to add the quality; impressive print speeds; $79.99 duplexer or built-in Wi-Fi, Ethernet the $99.99 duplexer CONS Clumsily designed outwith a photo-paper put tray; must-have business tray. extras increase price The 6840 conceals Hewlett-Packard, 888-999-4747 USB and Ethernet www.hp.com ports in its back panDirect Price $179.99 el, as well as built-in 802.11b/g wirelessnetworking compatibility. Digicam owners can take advantage of the unit’s PictBridge port, which allows for quick, computer-free printing direct from your PictBridge-enabled camera. The 6840’s print speeds were impressive, delivering text at 6.7 pages per minute (ppm) and breezing through an 8x10-inch photo at 0.52ppm. Text was heavily saturated with ink and appeared ultradark and crisp. Our graphics test lacked some detail but easily passed the grade for everyday use. Despite a few flaws, photos looked good, with smooth skin tones and fine details. We printed our tests using black and three-color cartridges, but for better results, you may want to replace the black cartridge with HP’s $24.99 photo-ink cartridge for six-color photo printing. Should you ever run out of black ink, the 6840’s automatic ink-backup mode lets you make emergency prints—black text would be composed of three color inks. HP estimates ink costs at 8 cents per color page, 4 cents per text page. —Kristina Blachere
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6.8



Fujifilm Digital Mobile Printer MP-70 FIRST



Now that most cell phones are equipped with built-in cameras,



TAKE there remains one question: What to do with those pictures once you’ve taken them? E-mailing the impromptu shots still costs you a pretty dollar, and most phones don’t have the capacity to store too many images. Enter Fujifilm’s Digital Mobile Printer MP-70. Upside: The MP-70 lets you wirelessly print photos from your infraredcapable cell phone or PDA. Despite its diminutive, audiocassette-size dimensions, the battery-powered printer churned out detailed 254-dotper-inch shots in our informal testing. The Polaroid-like prints (10-pack, $5.99) develop instantly and are roughly the size of a baseball card. Phones that lack infrared capabilities can opt for the $49 USB infrared add-on that lets any cell phone or digital camera jump in on the fun. Downside: Although we like the idea of printing directly from our camera phone, most of today’s phones still lack the power to take high-resolution shots. In addition, the MP-70 will not print images larger than 3 megapixels, so think again before printing those high-res shots stored on your PDA. Outlook: The MP-70, without a doubt, offers the most fun we’ve had with a printer. It’s easy to use, addictive, and relatively inexpensive. Stay tuned for a complete review in a future issue. —Louis Ramirez



p Fuji Photo Film U.S.A.,



800-800-3854, www.fujifilm.com Direct Price $99



REVIEWS MOBILE PRODUCTS



Garmin iQue M5 GPS-capable PDA is impressive but pricey FEATURING HIGHLY CAPABLE navigation software and maps, Garmin’s iQue M5 is a powerful hybrid Pocket PC with built-in GPS hardware. Its performance is outstanding, but, at $749.99, the M5 costs significantly more than other GPSequipped PDAs. Weighing 5.9 ounces and measuring 2.8x5x0.8 inches, the M5 follows typical Pocket PC design and size. We like the way the GPS antenna folds down and closes flush inside the case. Garmin didn’t include the jog-dial control it did on preEDITORS’ RATING 7.0 vious models, however—a 0 BETTER >> 10 regrettable omission. PROS Same size as typical We found the M5’s 3.5Pocket PC; excellent navigation inch-diagonal, 320x240-pixel capabilities; built-in Bluetooth screen difficult to read outnetworking; includes windshield doors. On the upside, Garmin mount, car charger supplies both a USB synchroCONS Expensive; screen is nization cradle/charger and a hard to read outdoors; no jog suction-cup windshield dial; average battery life mount. The latter includes an Garmin, 800-800-1020 in-vehicle charger that has www.garmin.com its own speaker. List Price $749.99 The M5 is competently



configured, with a 416MHz Intel PXA272 XScale processor, 64MB of ROM, and 64MB of RAM. An SD/MMC flashmemory slot is included, as is Bluetooth wireless networking. The GPS-navigation functions worked flawlessly. Maps proved attractive and easy to read, and the device integrates handily with your address book for streamlined routing. Just tap any entry, select Que, click Route To It, and you’re on your way. In addition, the M5 features an excellent address-lookup utility, and it’s adept at finding points of interest. In lab testing, the M5 offered good performance but slowed noticeably when multiple applications were open. The battery —Rick Broida life of 4.4 hours was merely respectable.



Hawking HWC54D Hi-Gain Wireless-G CardBus Adapter



Samsung SGH-p777



Extends Wi-Fi range, but saps battery life HAWKING’S HWC54D Hi-Gain Wireless-G CardBus Adapter optimizes weak wireless network signals to boost your laptop’s Wi-Fi range. The $59 PC Card incorporates a high-gain antenna that swivels. This makes the HWC54D heavier than other Wi-Fi cards, and the card extends an ungainly 1.6 inches from the side of the notebook. The HWC54D installs in just minutes. Offering both 802.11b/g and 802.11b-only modes, the card’s software interface is excellent. Both Wired Equivalent Privacy (WEP) and Wi-Fi ProEDITORS’ RATING 6.9 tected Access (WPA) encryp0 BETTER >> 10 tion are supported. PROS High-gain swiveling With a fast maximum antenna; well-designed softthroughput of 24.2Mbps, the ware; fast throughput; extraordiHWC54D demonstrated an asnary range tonishing range of 325 feet. CONS Juts far out of noteThat said, the card consistentbook; significant battery drain ly drained our test notebook’s Hawking Technology battery an hour faster than 949-790-0800 when we used the notebook’s www.hawkingtech.com built-in Wi-Fi adapter.



Mfr. Est. Price $59
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—Brian Nadel



A slick slider cell that’s media-savvy SAMSUNG’S $299.99 SGHEDITORS’ RATING 7.6 p777 is an impressive phone that’s well-configured for mul0 BETTER >> 10 timedia tasks. Overall, this adPROS 1.3-megapixel camera; vanced handset is a stylish deMP3 player; solid call quality; vice with significant extras. EDGE data speeds; e-mail supIts design is attractive, but port; AIM, ICQ preinstalled at 3.6x1.8x0.8 inches and 3.8 CONS Lacks Bluetooth, speakounces, the SGH-p777 is by no er; proprietary headphone jack; means small. A large, bright bulky 1.75-inch-diagonal screen Samsung Telecommunications displays 262,000 colors. America, 888-987-4357 www.samsung.com/wireless Outfitted with 100MB of memory, the SGH-p777 stores Direct Price $299.99 (with 1,000 phonebook entries. It Cingular service contract) supports Enhanced Data GSM Environment (EDGE) highspeed transmission, plus POP3, SMTP, and IMAP4 e-mail and AOL and ICQ instant messaging. Its 1.3-megapixel camera captures pictures and video. You also get a handy MP3-playback feature with proprietary headphones, but no speakerphone or Bluetooth networking. We tested the phone on Cingular’s network in San Francisco and experienced good call quality. Talk time was 4 hours, and standby time —William O’Neal was 7 days.



REVIEWS DIGITAL CAMERAS



Sony Cyber-shot DSC-P200 Better battery life than image quality THE $399.95 Sony Cyber-shot DSC-P200 is one of the most compact 7-megapixel digicams available, offering good per0 BETTER >> 10 formance, outstanding battery life, and PROS Excellent battery life; adequate photo quality. video clips can be edited on camera The DSC-P200 provides only a barebones roster of features suitable for baCONS Minimal feature set; color-cast problems sic snapshooting, including nine scene modes. One nice touch is the ability to Sony Electronics, 877-865-7669 trim video clips in the camera itself. www.sonystyle.com Excellent battery life and generally Direct Price $399.95 quick response times spice up the DSC-P200’s appeal. We got 984 shots out of a charge of the Sony InfoLithium rechargeable cell, half of them with flash, interspersed with a healthy amount of zooming, card formatting, and picture review. Wakeup time is 2 seconds, and you can snap follow-up shots every 1.6 seconds (2.8 seconds with flash) until the camera’s buffer fills. Color problems plagued many photos shot in the field, producing undesired casts both indoors and out. Otherwise, the DSC-P200 took generally well-exposed images with almost too-rich color saturation that looked good at standard viewing —D. D. B. distances.



EDITORS’ RATING



Pentax *ist DS Compact dSLR with great features A COMPACT DESIGN, flexible power sources, and a strong feature set make the 6.1-megapixel Pentax *ist DS a digital single-lens-reflex (dSLR) camera for the on-the-move photo enthusiast. The first thing you notice about this camera, apart from its peculiar name, is its small size. No dSLR is pocketable, but EDITORS’ RATING 7.0 this enthusiast camera won’t dominate your > > 0 BETTER 10 carry-on luggage. AlPROS Most compact dSLR though the *ist DS available; accepts AA batteries; doesn’t ship with a outstanding viewfinder, LCD rechargeable battery CONS Some overly saturated and charger, its two colors; no TIFF mode CR-V3 lithium cells Pentax Imaging, 800-877-0155 can be replaced with www.pentaximaging.com four AA batteries of Direct Price $799.95 (body your choice. The batonly), $899.95 (kit with lens) tery options work nicely with the camera’s compact design to make it a practical choice for traveling photographers. The *ist DS accepts K-, KA-, KAF-, and KAF2mount lenses directly, but you can also use Pentax screw-mount lenses dating back as far as the mid1960s. If you purchase the kit version of the camera, the supplied lens is equivalent to a 27.5mm-to84mm zoom on a 35mm full-frame camera. The camera features a brilliant optical viewfinder and a 2-inch LCD, both of which are easy on the eyes. The *ist DS’s performance neither disappoints nor excels in comparison with the dSLR competition. Though it can shoot RAW images, it lacks a TIFF mode. The *ist DS produced uniformly good exposures with lots of detail in shadows and highlights, and had a slightly lesser tendency to blow out the whites than its competitors. Skin tones were neutral and lifelike, although some colors, especially the reds and oranges, were often more saturated than we’d like, at times verging on the garish. —David D. Busch



6.8



Casio QV-R62 A choice camera for novice snapshooters THE $299.99 Casio QV-R62 is a EDITORS’ RATING 7.0 6-megapixel digicam that’s easy to use and a good choice for snapshooters 0 BETTER >> 10 who want a little more than just the PROS Easy to use; excellent basic point-and-shoot. help, newbie features Newbies will love the QV-R62’s 23 CONS Sluggish flash recycle; Best Shot scene modes, especially besoft-looking nonflash photos; cause each mode is accompanied by a movie recording lacks sound text explanation and photographic exCasio, 800-836-8580 ample. Equally useful is the rollover www.casio.com help system, which uses pop-ups to Mfr. Est. Price $299.99 identify settings as you change them. Casio also attends to the needs of more-experienced users with a wide selection of tweaking tools. The 3x optical zoom was responsive and moved smoothly through its six steps, but using the flash was frustrating, taking more than 6 seconds to recycle for the next shot. Also, unlike many competitors, the QV-R62’s Movie mode doesn’t record sound. Color rendition was, with only a couple of exceptions, quite accurate, but nonflash photos looked notably soft, regardless of illumination or shutter —Theano Nikitas speed. SECTION CONTINUES ON PAGE 58
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REVIEWS DIGITAL VIDEOCAMERAS



Panasonic PV-GS250 Proving that three color chips are better than one EDITORS’ THE PANASONIC PV-GS250 is a great choice for an CHOICE amateur videographer with serious aspirations or just a discerning eye. This $999.95 cam is part of Panasonic’s second generation of three-chip consumer camcorders. Three-chip cameras generally produce images with richer colors and greater detail than do single-chip cameras, and the PV-GS250 is no exception. The camera’s Leica Dicomar lens offers a 10x zoom, which is fairly limited by contemporary standards. That’s ameliorated somewhat by the wide end of the zoom, which is wider than much of the competiEDITORS’ RATING 8.0 tion and may be more useful than a supertelephoto 0 BETTER >> 10 zoom. Other successful lens PROS Great-looking three-chip features are the excellent color; effective image stabilizaoptical image stabilizer and tion; responsive manual controls the Tele-macro mode; the CONS Only average image latter enables extreme quality in low light; slow close-ups of objects located automatic controls about 16 inches from the Panasonic, 800-405-0652 camera. www.panasonic.com The PV-GS250 can take Direct Price $999.95 stills at a variety of output



resolutions, from 640x480 to 2,048x1,512. The higher resolutions are not native, however, but achieved via Panasonic’s pixel-shift technology. Automation features—including autofocus, autoexposure, and automatic white balance—tended to be accurate but slow. When set to manual, the camera responded quickly and precisely to the controls. In our tests, video of daylight exteriors looked vibrant and subtle throughout the spectrum, noticeably superior to typical images from single-chip cams. The lens proved sharp and contrasty as well. In low light, however, this camera lost its advantage over the single-chip competition. Like most consumer camcorders, the PV-GS250 offers special low-light modes, but its MagicPix option relies on a slow shutter that —Ben Wolf makes any motion unacceptably blurry.



Canon ZR300



Sony DCR-HC90 Handycam



Affordable shooter lacks some extras



Camcorder shines in low lighting



LOOKING FOR hassle-free moviemaking? The $499 Canon ZR300 is a pointand-shoot camcorder that delivers pleasing color and commendable battery life for a reasonable price. The ZR300 features a big 22x optical zoom, and it also caters to wide-screen shooting with true 16-to-9 recording. Novices will appreciate the presence of its Easy Recording mode, which automatically controls focus, exposure, and other settings. Canon has omitted some key extras, including a microphone jack, an accessory shoe, a separate battery charger, and videocapture and -editing software. But the overall performance of the ZR300 should more than satisfy the needs of family EDITORS’ RATING 6.7 moviemakers. 0 BETTER >> 10 Under optimal lighting, the PROS Pleasing color quality; camera captures sharp, 22x zoom; novice-friendly vibrant images with warm shooting mode colors, but it exhibited a CONS No microphone jack, distracting amount of noise separate battery charger; grainy in dim conditions. As for still still photos; no video software photos, the ZR300 managed included to reproduce colors pretty Canon U.S.A., 800-652-2666 well, but our sample photos usa.canon.com appeared grainy and slightly Mfr. Est. Price $499 —Rick Broida washed-out.



THE $999.99 Sony DCR-HC90 EDITORS’ RATING 7.0 MiniDV Handycam positively shines when the lights are low, 0 BETTER >> 10 and it offers amenities such as PROS Excellent low-light a 2.7-inch wide-screen LCD. performance; crisp, colorful video; support for 16-to-9 What’s more, it snaps 3.3recording megapixel still photos and has the pocket-friendly proporCONS Slow autofocus; awkward interface tions of an entry-level camcorder. Only a sluggish autofoSony Electronics, 877-865-7669 www.sonystyle.com cus system and an awkward touch-screen interface keep Direct Price $999.99 the DCR-HC90 from rising to the top of the pack. While the camcorder’s Easy mode simplifies shooting for novices, videographers will find plenty of manual controls at their disposal. With the exception of its autofocus, the DCR-HC90 is a speedy, solid performer. The camera features a 1/3-inch CCD, which enables true 16-to-9 recording. It produces rich, vibrant color footage both indoors and out, and ranks among the best lowand no-light camcorders we’ve used. Its photos looked crisp and detailed when scaled down, but appeared soft on closer —R.B. inspection.
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REVIEWS DIGITAL AUDIO



Sirius Starmate Tiny satellite-radio receiver IF YOU’RE LOOKING for a compact plugand-play receiver for Sirius Satellite Radio programming, the company’s Starmate is 0 BETTER >> 10 easy to shuttle between home and car. PROS Compact design; FM For $99.99 the device comes with a car transmitter can transmit to 100 different frequencies kit, and you can also purchase it with a home kit for an additional $39.99. ProCONS Problematic car mount gramming costs $12.95 per month. Sirius Satellite Radio, At 2.4x4x1 inches and 6 ounces, the 888-539-7474 Starmate is bigger than an iPod, about www.sirius.com the size of a small cassette Walkman. Direct Price $99.99 (with car The unit’s compact size has its downkit); $139.98 (with home kit) sides, though: The station-preset buttons are tiny, and the display is limited to just three lines. One advantage the Starmate has over other plug-and-play competitors is its FM transmitter’s ability to send the Sirius signal to any of 100 different frequencies. The receiver’s car kit includes a cigarette-lighter adapter, a roof-mounted antenna, a remote control, and a suctioncup mount for the windshield. We had a tough time getting the mount to adhere, —Sean Portnoy however.



EDITORS’ RATING



iRiver PMC-120 Portable Media Center lacks Zen THE $499.99 iRiver PMC-120 is one of just three portable devices that run Microsoft’s Windows Mobile-based Portable Media Center (PMC) operating system, which lets you EDITORS’ RATING 7.0 play and display music, video, and pictures 0 BETTER >> 10 with ease. While betPROS Intuitive Portable Media ter than Samsung’s Center OS; removable battery YH-999, iRiver’s player CONS No recording capability; can’t beat out the Crelacks preset bookmark buttons ative Zen Portable MeiRiver America, 800-399-1799 dia Center as our fawww.iriveramerica.com vorite of the three. The PMC-120 is reaDirect Price $499.99 sonably sized for a personal video player with a 3.5-inch color screen, fitting snugly between the bulky Zen and the slimmer YH-999. All PMCs share the same basic specs, including a 400MHz Intel XScale processor, 64MB of RAM, a USB 2.0 interface for synchronization, and a 320x240 screen. The current models all feature 20GB hard drives. The PMC-120 supports native playback of MP3, WMA (including DRM-protected files), WMV, and JPEG files, but you’ll need to convert DivX files to WMV format to play them on the device. Also, the player lacks video- or audio-recording capabilities. On the plus side, the PMC OS is simple, smooth, logical, and smart, unlike the archaic interfaces seen on many non-PMC personal video players. The PMC-120 is missing a wonderful feature found on the Zen: preset bookmark buttons, which will take you to any point in a song within a playlist or to a scene in a movie. It also trails the Zen in battery life, though our test results of 13.5 hours for audio playback and 6.7 hours for video beat the YH999’s times. Like the Zen’s, the PMC-120’s battery is —James Kim removable.
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6.3



Sony NW-E105 Shows up iPod Shuffle



EDITORS’ RATING 0



BETTER >>



7.7 10



BUDGET-CONSCIOUS music fans who PROS Long battery life; tiny; want more than what the Apple iPod solid audio quality Shuffle has to offer—an LCD screen, for CONS No FM tuner, recording instance—will be pleased with Sony’s options; doesn’t play secure $99.95 Psyc Network Walkman NWWMAs; must use SonicStage app E105 512MB flash-memory player. to transfer songs The circular NW-E105 may not be as Sony Electronics, 877-865-7669 beautiful or as slim as the iPod Shufwww.sonystyle.com fle, but measuring 2.2 inches in diamDirect Price $99.95 eter and weighing just 1.6 ounces, the player slips easily into any pocket. Like the Shuffle, it lacks an FM tuner or recording options. To get songs onto the NW-E105, you must use Sony’s SonicStage software, which will convert unprotected WMA files into Sony’s ATRAC3 format. The player natively supports MP3 files, but you can’t play protected WMA files from online services such as Musicmatch and Napster. The NW-E105 produced crisp sound with clear highs and lows, as well as plenty of bass. We were able to squeeze out an impressive 35.6 hours of battery life —Jasmine France in our tests.



REVIEWS DIGITAL LIVING



Logitech Harmony 880 Impressive remote unites your home theater devices THE LOGITECH HARMONY 880 Advanced Universal Remote is the first Harmony remote to feature a color screen and a built-in rechargeable battery with a docking station. The $249.99 remote also performs just as well as previous Harmony models we’ve tested. Though slightly larger than its predecessors, the 880 retains a similar dumbbell shape, measuring 8.1x2.3x1.3 inches and weighing 5.8 ounces. The 128x160-pixel color display is fairly low-resolution, but it’s a big improvement over the monochrome screens found on earlier Harmonys. It’s also slightly larger, with the extra room allowing for a total of eight onscreen contextual icons, corresponding to adjacent hard buttons. Recharging the 880’s battery requires simply EDITORS’ RATING 8.1 placing the remote in its 0 BETTER >> 10 cradle. The battery is rePROS Web-programmable; color placeable, so when it evenscreen; rechargeable battery tually wears out—and it will—you’ll be able swap a CONS Low-res display new one in. Another nice Logitech, 800-231-7717 feature is the motion senwww.logitech.com/harmony sor, which turns the reDirect Price $249.99 mote on automatically



when you pick it up. Programming a universal remote can often be frustrating and time-consuming, but you painlessly program Harmony remotes by connecting them to your computer with the supplied USB cable and answering a questionnaire on the company’s Web site about your home theater devices. The remote’s software then uploads all the relevant control codes. The Web site also provides macro-style options for delay times, multistep commands, and other functions. After a couple of tweaks, we were in command of a six-component system. —David Carnoy, with John P. Falcone



Panasonic DMR-ES10K



EDITORS’ RATING



DVD recorder works best with DVD-RAM discs



0



BETTER >>



6.8 10



PROS Excellent recording quality; chasing playback, Quick Start



PANASONIC’S new entry-level DVD recorder, the $199.95 DMRES10K, delivers sharp recordings even in its 4-hour LP mode, and its compatibility with DVD-RAM discs gives you plenty of features typical of a hard drive, including chasing playback (which lets you watch a program from the beginning while it’s being recorded) and the ability to watch one title while another is recording. Still, its skimpy editing options for DVD discs in formats other than DVD-RAM make for tedious navigation once it’s time to watch your recordings. You won’t find an electronic programming guide or infrared blaster for changing the channel on your cable or satellite set-top box, so you need to schedule recordings either manually or with VCR Plus+. The unit does offer a 60-second commercial-skip feature, as well as a 1.3x playback mode. The DMR-ES10K provides a handy Flexible
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Recording mode for fitting a recordings with DVD-RAM discs precise amount of video CONS Can’t create chapter onto a DVD while maintainstops on DVD+R, DVD-R, DVDRW discs; no infrared blaster for ing optimal video quality. In timed recordings addition, the recorder has a Quick Start function that lets Panasonic, 800-211-7262 www.panasonic.com it begin recording a DVDRAM within a second of Direct Price $199.95 powering up. The deck comes with a solid set of connections, especially for an entry-level model, including outputs for component and composite video, as well as S-Video and optical digital audio. The DMR-ES10K records to all DVD formats except DVD+RW. You can’t add chapter stops to DVD+R, DVD-R, or DVD-RW discs, and the deck doesn’t add them automatically. The only editing you can do with non-DVD-RAM discs is to change the title name —Ben Patterson and the menu thumbnail.



REVIEWS SOFTWARE



DIY PC Maintenance Tune up that sluggish system with these diagnostic-tool suites IF YOU’RE LIKE MOST people, you install and uninstall software or save and delete images, media files, and e-mail many times over the life of your PC. All that activity can cause Windows to slow down, burdened by broken shortcuts, leftover Registry entries, and the inevitable defragmentation of your hard drive. You could buy a new system or take your old one into the shop for repair—or, you could diagnose your PC woes yourself. For years, Norton Utilities reigned as the de facto cure-all for PCs. Those basic Norton tools have since evolved into Symantec’s Norton SystemWorks, a gigantic suite of diagnostic tools. We had trouble installing the latest version, Norton SystemWorks 2005 Premier, and even after we did, we were less than impressed with the overall package. Instead, we recommend Iolo Technologies’ System Mechanic 5 Professional. For $30 less, it includes many of the same features as SystemWorks but requires less hard drive space and system resources.



NORTON SYSTEMWORKS 2005 PREMIER



inscrutable printed manual and sketchy in-product help for Norton Utilities. Symantec’s Web site provides a useful searchable knowledge base, but live, toll-free phone support is pricey—$29.95 per incident.



SYSTEM MECHANIC 5 PROFESSIONAL Iolo Technologies takes several large steps forward with System Mechanic 5 Professional. This latest suite is loaded with new PCdiagnostic and -repair applications. Factor in the breadth of what was already there, and you have a well-stocked computer-utility package that’s worth the $69.95 investment. The only thing missing is disk-imaging software for backups. Unlike SystemWorks, which requires separate installations for its individual apps, System Mechanic requires just one install. Our experience was flawless. After installation, System Mechanic occupies just 60MB of hard drive space, roughly one-quarter the footprint of SystemWorks. Running System Mechanic is a snap—its interface is both clean and intuitive. Click any of the six main tool-group tabs (Clean, Fix, Maintain, Optimize, Protect, 1-2-3 Options) to display its tools. Highlighting any tool with your mouse displays a brief but helpful explanation at the bottom of the screen. Three of the new utilities are truly impressive. Program Relocator allows you to move programs to a different folder or drive, simultaneously updating links, shortcuts, and configuration data. The new boot-time defragmenter, by working before Windows loads, defragments system files that are normally out of reach. And SafetyNet serves as a handy multilevel undo for all of System Mechanic’s tool actions. Given the expanse of the suite, the absence of a manual— printed or electronic—is inexplicable, though System Mechanic’s context-sensitive in-product help system is excellent. Online support is plentiful, and telephone support is free, but not toll-free.



With the $99.99 Norton SystemWorks 2005 Premier, Symantec takes the all-inclusive approach to maintenance. In addition to the basic utilities found in SystemWorks 2005 (pop-up-ad prevention, junk-file removal, antivirus and spyware detection and removal, confidential-file protection, memory defragmentation, data recovery, and Internet-speed optimization), Premier adds Norton Ghost 9.0 and Smith Micro’s CheckIt Diagnostics. SystemWorks 2005 Premier doesn’t pack the overall punch of System Mechanic, but current SystemWorks users may want to upgrade, if only to get Ghost. Most of the included apps require separate installations—installs that were fraught with difficulty. Two out of our four installation attempts failed, with one reporting the suite was suc—Barry Brenesal and Robert Vamosi cessfully installed when it clearly wasn’t. When Product Summary fully installed, SystemWorks consumed 260MB of our hard drive, quite a bit more than System Norton SystemWorks 2005 Premier System Mechanic 5 Professional Mechanic’s 60MB. EDITORS’ RATING 7.0 7.7 SystemWorks’ interface is clean and easy to naviPROS Useful hard drive utilities; easy to Broad range of utilities; thorough navigate in-product help; easy to use gate, but it’s not especially intuitive. Tab organizaCONS Installation is a nightmare; poor built-in No printed manual; lacks disk-imaging tion, for instance, is a little haphazard, leaving us to help; expensive live support software guess the location of a handful of utilities. KEY FEATURES System optimization; virus protection; System optimization; firewall; virus The addition of Ghost, a leading backup and resystem restore; data-privacy protection; protection; file recovery; data-privacy hard drive backup and partitioning; protection; hard drive scrubber; adware/ covery tool, is welcome, though the advanced testing adware/spyware removal spyware removal tool CheckIt is really for computer pros who know COMPANY Symantec Iolo Technologies how to read its extensive technical reports. 888-810-9896 877-239-4656 For a serious diagnostic suite, SystemWorks www.symantec.com www.iolo.com lacks much in the way of support, with an DIRECT PRICE $99.99 (full version); $69 (upgrade) $69.95 (full version); $39.95 (upgrade)
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REVIEWS SOFTWARE



Microsoft Windows XP Professional x64 Edition 64-bit OS is not for the faint of heart WITH THE RELEASE of Windows XP Professional x64 Edition, Microsoft takes a big first step toward a 64-bit world. The rollout will be slow, though, because little software is available in 64-bit versions and many hardware devices don’t yet have compatible drivers. In fact, many of the native apps in the OS, such as Outlook Express and Windows Media Player, still run in EDITORS’ RATING 5.8 32-bit mode. The main ad0 BETTER >> 10 vantage of the PROS Supports 128GB of 64-bit OS is its physical memory; promises ability to handle speed boosts when coupled with huge amounts of memory: up 64-bit processors, software to 128GB of physical RAM and CONS Included apps Outlook 16TB of virtual memory. ComExpress, Windows Media Player pared with the 4GB RAM limit remain 32-bit; possible hardware incompatibilities; requires fresh on 32-bit Windows, the 64-bit install Windows blows this limitation away. Microsoft designed XP Microsoft, 800-642-7676 www.microsoft.com Professional x64 for workstation apps such as CAD/CAM Direct Price $299; free for users of 32-bit XP Professional and 3D modeling, where the who own 64-bit PCs support for extra memory



promises a big boost in performance. The OS gives developers a solid Windows platform for writing apps that can harness the potential of 64-bit, as well. For the average user, though, 64-bit Windows is little more than a curiosity. Current compatibility issues far outweigh any immediate speed boosts, making it an inadvisable upgrade for all but the most die-hard hobbyists. XP Professional x64 isn’t available as a stand-alone product—you can obtain it only through OEM vendors and licensing agreements. It’s priced the same as the 32-bit Windows XP Professional ($299), and, for a limited time, current XP Professional users with 64-bit PCs can upgrade for free. You can’t upgrade directly from 32-bit Windows, however—you’ll need to do a fresh install to get the 64-bit OS up and running. —Ken Feinstein



Mac OS X 10.4 Tiger Mac lovers should pounce on this solid upgrade



EDITORS’ RATING 0



ANOTHER BIG-CAT NAME, another solid OS: Apple’s Mac OS X 10.4 Tiger brings several useful new features and enhancements, making it a worthwhile purchase for those who skipped 10.3 Panther or have waited until Tiger’s release to purchase Apple hardware. Installing Tiger is easy. You load the DVD and click an installer icon. With the disc still in the drive, the computer automatically reboots into the Tiger installer. You’re given three install options: Upgrade from a previous version of OS X; erase and install; or archive and install, which saves all of your system data to a special folder and puts a clean install of Tiger on your computer. Even casual Mac users will immediately see the differences from Panther. Tiger includes significant overhauls to take advantage of more



BETTER >>



8.0 10



addressable memory space. PROS Better interface responPlus, several new core techsiveness, overall speed; Spotlight search feature; improved nologies provide benefits, cross-platform compatibility such as faster onscreen graphics and new programCONS Most upgrades are ming interfaces. hidden under the hood; Dashboard clashes with Apple’s Apple lists more than 200 user-interface guidelines new features for Tiger. While Apple Computer, 800-692-7753 a lot of them are under the www.apple.com hood, improving performance and crossDirect Price $129 platform compatibility, some of the enhancements are visible. Spotlight, an embedded desktop search feature, indexes your entire hard drive so you can quickly find almost anything on your system. Also new and prominent is Dashboard, a flashy interface populated by widgets, single-purpose mini-apps such as a dictionary and a weather chart. Longtime Apple users will note, though, that almost every element of Dashboard runs counter to the standardized user-interface guidelines the company so carefully built up over the years. —Daniel Drew Turner SECTION CONTINUES ON PAGE 74
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REVIEWS SOFTWARE



Microsoft Works Suite 2005 Well-integrated apps for home basics



Ulead PhotoImpact 10 Delightful, inexpensive image editing ULEAD PHOTOIMPACT 10 is a terrific basic image editor. With version 10, Ulead has added a broad range of handy new features, making this program a steal at $89.99. For starters, Ulead has added photo frames, 17 new effects filters (Pen and Ink, Cartoon, and Engraving, to name a few), and a new touch-up tool for subtly removing image defects. Three new selection tools make it easier to work with specific areas of an image: Smart Lasso, which draws a selection border around complex objects; Extract Object, which isolates an image element from a background; and Match Background Color, for EDITORS’ RATING 7.8 seamlessly merging 0 BETTER >> 10 an extracted element PROS Excellent value; terrific back into the image. interface; includes vector, bitmap, Version 10’s intertext, animation, panorama tools face is totally configCONS Photo organizer needs urable, with dockable updating toolbars, buttons, and Ulead Systems, 800-858-5323 panels that can be www.ulead.com dragged and dropped Direct Price $89.99 (full around the screen. version); $49.99 (upgrade) Ulead has retained the unusual (and clever) visual thumbnails for applying effects as well. PhotoImpact is equally at home with bitmap, vector, and text objects, providing a full range of tools for assembling surprisingly complex documents. Digital-camera support is beefed up with a wizard for downloading images, a Browse manager to view EXIF information, and an updated High Dynamic Range feature. The High Dynamic Range tool combines multiple exposures into a single image to brighten dark areas and darken lights in high-contrast photos; it now compensates for movement between the bracketed original shots. Even if there were nothing else in the box, PhotoImpact alone would be a bargain, but Ulead bundles extras like PhotoImpact Album, a decent image manager that’s beginning to show its age, and Cool 360, a wizard-driven app that creates panoramas —Susan Glinert Stevens from a set of photos.
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WITH THE $99.95 Works Suite 2005, MiEDITORS’ RATING 7.4 crosoft packages its popular software alongside Works 8.0, an entry-level pro0 BETTER >> 10 ductivity app. The suite spans five CDs PROS Includes Word, Money, and includes Word 2002, Works 8.0, PicEncarta, Streets & Trips; wellintegrated applications ture It Premium 10, Encarta Encyclopedia Standard 2005, Money Standard 2005, and CONS Doesn’t include Excel, Streets & Trips 2005—well worth the cost PowerPoint; Word is not current if you planned to purchase the programs version separately. Excel and PowerPoint are Microsoft, 800-642-7676 omitted, however, with Works 8.0 taking www.microsoft.com their place. Although this replacement is Direct Price $99.95 (before adequate for home users, it’s a poor sub$20 mail-in rebate) stitute for the other Office apps. Still, the suite’s offerings work well together. A task manager, when launched, opens automatically to a Calendar tab, displaying any pending appointments as well as an immediate view of your contacts. Icons across the task manager’s top give instant access to various resources, including built-in templates for just about any task. —Robert Vamosi



Bias SoundSoap 2



EDITORS’ RATING



Wash digital audio clean



0



7.5



BETTER >>



PROS Effectively reduces



10



BIAS SOUNDSOAP 2, compatible with noise in audio files; Mac-, both Windows and Mac, precisely isolates Windows-compatible; functions as stand-alone app or plug-in and eliminates noise problems in digital audio files, such as clicks, pops, electrical CONS Incompatible with hum, rumble, and background hiss. The MPEG-1, MPEG-2, DivX files in $99 SoundSoap isn’t foolproof, and masstand-alone mode; slight learning curve tering it takes a little practice, but it’s a great choice for cleaning up analog-toBias, 800-775-2427 www.bias-inc.com digital recordings, improving roughsounding MP3 files, or enhancing diaDirect Price $99 (full logue in camcorder footage. version); $49 (upgrade) We tested SoundSoap as a standalone app, but it also works as a plug-in with compatible host programs, including Apple’s GarageBand, Adobe Premiere, Steinberg’s Cubase, and Sony’s Sound Forge. In standalone mode, SoundSoap is compatible with the file formats you’d expect, including AIFF, AVI, MP3, MP4, WAV, WMA, and WMV. DivX fans will be disappointed, however, by the app’s incompatibility with that format, as well as MPEG-1 and —Nathaniel Wilkins MPEG-2.



Top25



This month’s best desktops, notebooks, 17-inch LCD monitors, graphics cards, and music-download services.



PERFORMANCE DESKTOPS



>> Top-of-the-line machines that pack lots of computing power.



PRODUCT



PRICE



SPECS/REQUIREMENTS



BOTTOM LINE



Apple Power Mac G5 www.apple.com



$1,999



2GHz PowerPC G5; 512MB DDR; 160GB HDD; Radeon 9600



Once hailed as the world’s fastest PC, the Power Mac G5 is a tried-and-true speed demon, delivering top-notch performance for creative pros and power users.



Overdrive Torque.SLI www.overdrivepc.com



$3,315



2.75GHz Athlon 64 3700+; 1GB DDR; 74GB, Other dual-graphics-card PCs have shown promise, but the Torque.SLI blows them all 200GB HDDs; two GeForce 6800 Ultras away with its ridiculously fast 3D frame rates and awesome application performance.



8.4



Velocity Micro ProMagix PCX www.velocitymicro.com



$2,409



3.6GHz Pentium 4 560; 1GB DDR2; 74GB, 400GB HDDs; GeForce 6800



8.2



ABS Ultimate M5-64* www.abspc.com



$3,024



2.4GHz Athlon 64 4000+; 2GB DDR; 250GB The cost will scare away plenty, but anyone in search of powerful graphics and HDD; GeForce 6800 Ultra blistering speeds will find this zippy system is worth every dime.



8.1



2.6GHz Athlon 64 FX-55; 1GB DDR; 74GB, 250GB HDDs; two GeForce 6800 Ultras



8.0



Velocity Micro Gamer’s Edge $3,745 DualX www.velocitymicro.com



ULTRAPORTABLE NOTEBOOKS



The high-end ProMagix PCX is overkill for most homes and offices, but graphic artists, video hobbyists, and gamers will like what they find under the hood.



Record-breaking 3D-benchmark scores plus Velocity Micro’s expert construction make this an outstanding, if expensive, PC for gamers and power users who demand the best.



RATING



8.7



>> Superlight notebooks for those on the move.



Dell Latitude D400 Series* www.dell.com



$1,815



1.6GHz Pentium M 730; 512MB DDR2; 40GB HDD; DVD/CD-RW; 12.1-inch TFT



One of the fastest, best-looking, and most affordable Pentium M ultraportables on the market, the Latitude D400 Series offers stellar performance for its class.



8.4



Toshiba Portégé R100* www.toshiba.com



$1,999



ULV 1.1GHz Pentium M 733; 512MB DDR; 40GB HDD; 12.1-inch TFT



With its roomy keyboard, built-in 802.11b wireless, and solid battery life, Toshiba’s smallest laptop is an excellent on-the-road companion for corporate travelers.



7.8



HP Compaq NC4010 www.hp.com



$2,049



1.7GHz Pentium M 735; 512MB DDR; 40GB HDD; 12.1-inch TFT



HP’s NC4010 may lack the battery life to support a true road warrior, but this nimble little notebook’s performance and features are sure to satisfy.



7.1



Sharp Actius MM10 www.sharpusa.com



$1,299



1GHz Crusoe TM5800; 256MB DDR; 15GB HDD; 10.4-inch TFT



The Actius MM10 weighs just 2.1 pounds, making it a great travel companion. Battery life is short, but the convenient docking station makes recharging easy.



7.1



Dell Latitude X1 www.dell.com



$1,698



ULV 1.1GHz Pentium M 733; 256MB DDR2; 30GB HDD; DVD-ROM; 12.1-inch TFT



The Latitude X1 squeezes everything a business user needs into a sleek, featherweight case. There’s no integrated optical drive, but a self-powered external is included.



7.0



17-INCH LCD MONITORS



>> Elegant, space-saving displays that improve your view.



Samsung SyncMaster 173P www.samsung.com



$536



1,280x1,024 native resolution; 25ms pixel response; DVI, VGA inputs



This 17-inch LCD delivers above-average image quality in a handsome package. Extras include a pivot feature with software, a VESA wall mount, and digital and analog cables.



8.3



Lenovo ThinkVision L170p www.lenovo.com



$389



1,280x1,024 native resolution; 25ms pixel response; DVI, VGA inputs



The well-priced L170p offers a winning combination of image quality, chic design, and connectivity. Plus, you can toggle between input signals at the push of a button.



7.6



Samsung SyncMaster 711T www.samsung.com



$599



1,280x1,024 native resolution; 25ms pixel response; DVI, VGA inputs



Though it costs a bit more than other 17-inch LCDs, the SyncMaster 711T is a stylish, highly adjustable display with a high contrast ratio and good image quality.



7.3



BenQ FP783 www.benq.com



$489



1,280x1,024 native resolution; 12ms pixel response; DVI, VGA inputs



BenQ’s uniquely colored LCD gives your workspace a dose of high style, and the 12ms response time minimizes ghosting. Extras include three USB ports and both cables.



7.1



Envision EN7220 www.envisiondisplay.com



$449



1,280x1,024 native resolution; 16ms pixel response; VGA input



Inelegant pencil cups and photo clips notwithstanding, the EN7220 is a simple, highly adjustable flat panel that performs well and costs less than many 17-inch LCDs.



6.7



GRAPHICS CARDS



>> State-of-the-art video boards for silky-smooth gameplay.



ATI Radeon X800 XT Platinum Edition www.ati.com



$499



Radeon X800 GPU; 256MB GDDR3; AGP 8x/4x; DirectX 9; VGA, DVI



After years of finishing second to nVidia, ATI has finally handed a defeat to its rival. This card is an awesome combination of power and manageable size.



9.0



ATI Radeon X800 XL www.ati.com



$299



Radeon X800 GPU; 256MB GDDR3; PCI Express x16; DirectX 9; VGA, DVI



Designed to deliver stellar 3D graphics at a reasonable price, the X800 XL doesn’t disappoint. It’s currently the best bargain for a high-performance graphics card.



8.3



PNY Verto GeForce 6800 Ultra www.pny.com



$499



GeForce 6800 Ultra GPU; 256MB GDDR3; AGP 8x/4x; DirectX 9; VGA, DVI



The PNY Verto may take up two expansion slots and demand a big power supply, but it’s a muscular card with some great features, including dual DVI ports.



8.1



ATI Radeon X850 XT Platinum Edition www.ati.com



$549



Radeon X850 GPU; 256MB GDDR3; PCI Express x16; DirectX 9; VGA, two DVI



The Radeon X850 XT Platinum Edition is one of the fastest solutions out there that doesn’t require a pair of video cards. Plus, its dual DVI ports support two digital LCDs.



8.0



GeForce 6800 Ultra GPU; 256MB GDDR3; AGP 8x/4x; DirectX 9; VGA, two DVI



Overclocked to 425MHz from the factory-standard 400MHz, the GeForce 6800 Ultra OC is blazingly fast, though your PC might need a power-supply upgrade to run it.



8.0



BFG GeForce 6800 Ultra OC www.bfgtech.com



$429.99



MUSIC-DOWNLOAD SERVICES



>> Download your favorite tunes (legally) using these online music providers.



Apple iTunes 4.8 www.itunes.com



99 cents per song



1-million-plus song library; MP3, AAC formats; Mac-, PC-compatible



Thanks to its user-friendly interface and vast song library, Apple iTunes remains the best one-stop shop for ripping, organizing, playing, and buying digital music.



8.3



MSN Music music.msn.com



99 cents per song



1-million-plus song library; secure WMA format; PC-compatible



A latecomer to the online music game, MSN Music has gained serious momentum due to its wide library of quality music files and integration with Windows Media Player 10.



8.0



Musicmatch Jukebox 10 www.musicmatch.com



99 cents per song



800,000-plus song library; secure WMA format; PC-compatible



With a revamped interface and better overall performance, this venerable all-in-one jukebox provides tight, easy integration with Musicmatch’s On Demand music store.



8.0



Rhapsody 3.0 www.rhapsody.com



99 cents per song



1-million-plus song library; MP3, AAC, WMA formats; PC-compatible



This popular streaming service continues to impress in its latest version, which now comes in three variants, including Rhapsody To Go for portable players.



8.0



500,000-plus song library; secure WMA format; PC-compatible



The selection of independent labels is limited, and it requires Windows Media Player, but the discount king’s music service is cheap and easy to use.



8.0



Wal-Mart Music Downloads 88 cents www.walmart.com per song



= Editors’ Choice



76



* = Configuration changed from original review.



August 2005 computershopper.com



5 7 PC TIPS & TRICKS Our insider secrets will help you master your PC and all its applications.



YO U R P RO C E S S O R ’ S SW I F T ,



your RAM’s abundant, and your hard



drive’s regularly reformatted. Don’t stop there. We’ve got lots of ways to boost your PC productivity. From 10-second shortcuts for everyday tasks to performance-enhancing tweaks, we share our computer screen, whether it’s a little or a lot.



M



secrets for getting the most out of the time spent in front of your BY LOUIS RAMIREZ
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MICROSOFT WINDOWS XP



double-click it. In the General tab, select Disabled from the “Startup type” pull-down menu, and click OK.



TAKE SHORTCUTS CUSTOM SLIDE SHOW Windows XP lets you create your own slide-show-based screensaver. First, drag and drop the pictures you’d like to use into your My Pictures folder, located inside the My Documents folder. Now, right-click an empty space on your desktop, and choose Properties. Click the Screen Saver tab, and from within the pull-down menu, highlight the My Pictures Slideshow option. The Settings button lets you adjust parameters such as size and transition effects. Click Preview for a quick demonstration, or click OK to activate your screensaver.



ELIMINATE ANIMATIONS Ending useless animations in Windows will improve performance. Right-click the desktop, choose Properties, and then the Appearance tab. Click the Effects button, and make sure everything is unchecked in the next window.



TERMINATE INDEXING For a slight speed boost, try disabling Windows’ Indexing, a feature that keeps a record of all files on your hard drive. Go to Control Panel > Performance and Maintenance > Administrative Tools, and double-click Services. Scroll down to Indexing Service, then



A TIDIER TASKBAR You can lump open windows belonging to the same application within a single taskbar icon by right-clicking the taskbar, selecting Properties, and checking the “Group similar taskbar buttons” box. Plus, if you want to close the program without having to close each window individually, all you have to do is right-click the icon and select Close Group.



For instant access to your desktop, hold down the Windows key and hit D.



You can quickly burn a CD using Windows’ integrated applet. To begin, go to Start > My Music, and navigate to the folder with the tunes you want to burn, if you’re not already there. On the left side of the window, select “Copy all items to CD,” or highlight the songs you want to burn and click Copy to Audio CD. You can also copy a single song by right-clicking the file and selecting Copy to CD or Device.
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If your Windows clock has a habit of losing track of time, synchronize it with an Internet time server. Double-click the time located on your taskbar. Select the Internet Time tab and check “Automatically synchronize with an Internet time server.” Don’t bet your next job interview on it, though—the time’s synchronized only once a week. If you want to synchronize immediately, click Update Now.



HIDE ALL WINDOWS



Instant copies
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Synchronize Windows’ clock



APPS IN AN INSTANT For one-click access to frequently used apps, right-click the taskbar, select Toolbars, and check Quick Launch. Now drag your shortcut icons onto the Quick Launch bar to the right of the Start button. To view more of them, click the double chevron for a list, or hover your mouse over the dotted area until it turns into a double-sided arrow and slide it over to the right.



DISABLE BALLOON HELP To disable balloon pop-ups, click Start > Run, type regedit, and hit Enter. In the left column, drill down to HKEY_CURRENT_ USER > Software > Microsoft > Windows > Current Version > Explorer > Advanced. Right-click anywhere in the right column, select New > DWORD Value, and rename it EnableBalloonTips. Double-click this new entry, and give it a hexadecimal value of 0. Then close the Registry Editor, and restart your computer. Just be careful; Registry mistakes are irreversible.



Keyboard/Getty Images



Create your own shortcut-key combinations to your favorite applications by right-clicking the app of choice and selecting Properties. Under the Shortcut tab, enter your own key combination, such as Ctrl+6, in the “Shortcut key” field. If the combination you choose is already taken, Windows selects something similar.



MICROSOFT WORD



Spelling & Grammar tab. Clear the checkbox labeled “Check grammar as you type,” and hit OK.



USE BOOKMARKS Word’s Bookmark feature lets you navigate quickly through lengthy documents. Simply go to a page you’d like to bookmark, and, from the Insert menu, click Bookmark. Name your Bookmark, and click Add. To find your bookmark, hit Control+F, then click on the Go To tab. Select Bookmark from the menu on the left, and enter the bookmark name to jump straight to it.



SEAL OF APPROVAL Give your documents a professional look by adding a watermark to the background. To add one to your document, select Format > Background > Printed Watermark. Select “Picture watermark” or “Text watermark,” then click OK.



WORD-O-METER You can count the words in a document with a single click by adding a word counter to your toolbar. Go to View > Toolbars, and check Word Count. Drag onto your toolbar the small bar that pops up. Now you can just click Recount whenever you want to know your word count.



SELECTIVE HIGHLIGHTING If you don’t want Word grabbing an entire word when you make a selection, go to Tools > Options > Edit, and uncheck the box that reads “When selecting, automatically select entire word.”



MICROSOFT EXCEL



KEEP THE RIGHT FORMAT



INSERT DATE AND TIME



Want to paste formatted text into Word without losing the original format? After copying the selected text, select Edit > Paste Special. You can choose among Formatted Text (RTF), Unformatted Text, HTML Format, or Unformatted Unicode Text.



To insert the current date in a cell, hold Ctrl, then press the colon/semicolon key. To insert the time, hold Ctrl and Shift, and hit the same key.



LOSE THE WRONG FORMAT To quickly remove the formatting from your document, highlight the relevant text, then press Control+Shift+N.



COLOR COORDINATION You can color-code the tabs on your Excel spreadsheets for easier navigation. Click the tab you’d like to color, then select Format > Sheet > Tab Color. Select the color you want, and click OK.



CLEAR FORMATTING To clear the formatting in an Excel spreadsheet, highlight the cells you want changed, and select Edit > Clear > Formats.



KEEP A CLOSE WATCH The Watch Window lets you monitor cells on other workbooks. To add a cell to the Watch Window, right-click it, then select Add Watch. You can then position the Watch Window above or below Excel’s standard toolbar.



Instant quotes Excel can recognize stock symbols and fetch stock quotes using MSN MoneyCentral Investor. First, enable Smart Tags by selecting Tools > AutoCorrect Options > Smart Tags. Make sure “Label data with smart tags” is checked, and hit OK. Log on to the Internet, and enter a stock symbol (in all caps) into a cell. A small green triangle appears in the lower right corner of the cell. Hover your cursor over the cell, click the icon that pops up, and choose “Insert refreshable stock price.” Select “On a new sheet” to display the quote on another worksheet, or “Starting at cell” to display the stock price in the current cell.



HIDE YOUR SHEET STOP CORRECTING ME Speed up spell-check by preventing Word from grammar-proofing your documents. To disable grammar check, go to Tools > Options, and click the



You can hide Excel worksheets to reduce the number of sheets on your screen. Just select the sheets you’d like to hide, and select Format > Sheet > Hide. To restore them, click Unhide.



Calculator and Stock Ticker/Getty Images



Count on Word To use Word’s built-in calculator, select Tools > Customize > Commands. In the Categories column, highlight All Commands, and, in the Commands column, scroll down to ToolsCalculate. Drag this command to the Tools menu, then rename it “Calculate” by right-clicking it and choosing Name. Calculate is available only when you’ve selected text with numbers in it. It ignores any text that isn’t a number and is useful for adding numbers in tables or paragraphs.



ALL TOGETHER NOW To change the typeface or point size of all cells in a spreadsheet at once, click the box in the top left corner to select the entire spreadsheet, then make your changes.



SORT THINGS OUT You can rearrange the data in a spreadsheet any way you like by clicking the box in the top left corner and selecting Data > Sort. In the Sort window, select the column you’d like to sort by and whether you want the data in ascending or descending order.
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MICROSOFT POWERPOINT E-MAIL SLIDES PowerPoint lets you resize, crop, and e-mail individual slides. To begin, open the slide, and click View > Notes Page. The file will appear on the notes page as an image. Next, right-click the slide image, and click Copy. The image is now on your clipboard, and you can paste it into your program of choice for e-mailing or resizing.



your desktop and select New > Shortcut. Type mailto: in the Shortcut wizard. Then name your shortcut. Now you can just double-click the shortcut to open a blank e-mail message.



CREATE ARCHIVES Avoid reaching your mailbox’s memory capacity by archiving your messages. Go to Tools > Options, and select the Other tab. Click the AutoArchive button, and make your selections.



YOU’RE OUT OF ORDER



REDUCE OR ELIMINATE SPAM



While viewing a slide show, you can call up any slide out of order. Just type the number of the slide, and hit Enter.



To decrease your daily dose of spam, select Tools > Options > Junk E-mail, and click the High radio button. To eliminate spam completely, select the Safe Lists Only radio button to receive e-mails only from the people you allow. If you’re concerned about missing any e-mails, check your Junk E-mail box regularly.



POWERPOINT ALBUMS You can use PowerPoint to create an impromptu photo album. Select Insert > Picture > New Photo Album. Under the “Insert picture from:” heading, click File/Disk, select the pictures you want to include, and hit Insert. Next, you can specify the look of the album you want under Album Layout. Finally, click Create.



Secure your presentations Prevent others from modifying your PowerPoint file (or any Office file, for that matter) by enabling password protection. Select Tools > Options > Security, enter a password in the “Password to modify” box, and hit OK.



SAVE MULTIPLE ATTACHMENTS… To save multiple file attachments in an e-mail message all at once, click File > Save Attachments, then select Save All Attachments.



…BUT GET RID OF THE LARGE ONES Free up your in-box by deleting messages with large attachments. Go to the View menu, click the Arrange By drop-down list, and select Size. Now you can delete e-mails with the largest attachments first and work your way down.



CREATE MULTIPLE SIGNATURES You can specify a different signature based on whether you’re sending a new message, a reply, or a forward. Go to Tools > Options > Mail Format. Under Signatures, select the signature you want to use from the “Signature for new messages:” drop-down menu.



cally opens an appointment window, in which you can set up the time and the place, and set a reminder.



MICROSOFT INTERNET EXPLORER MAKE YOUR HISTORY A MYSTERY To clear your AutoComplete history in Internet Explorer, go to Tools > Internet Options, and click the Content tab. Under “Personal information,” click AutoComplete, and, in the resulting window, press Clear Forms. To disable the feature entirely, uncheck the Forms box.



Browse ahead iRider ($29, www.irider.com/ irider) lets you surf the Web at warp speed with an inventive function called Surf-Ahead. Because pages download while you’re still on your current page, the next one’s usually ready by the time you’re done reading. Pages appear in the left pane as thumbnails. You can also select multiple links and click one to open them all at the same time.



To make annotations on a presentation, open the file in Slide Show view. Rightclick in the window, point to Pointer Options, and select a writing implement. When you’re done, press Esc.



MAKE YOUR BOSS BLUE Color-code incoming messages based on who they’re from by highlighting a message from that individual, clicking Tools > Organize > Using Colors, and selecting a color from the drop-down list.



MICROSOFT OUTLOOK



BROWSE WITH TABS SCHEDULE APPOINTMENTS



QUICK E-MAILS Send out a quick e-mail without launching Outlook. Right-click an empty area on
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To turn an e-mail message into an appointment, drag it over to your Calendar bar until it turns orange. This automati-



Tabbed browsing isn’t reserved for Firefox users anymore. Maxthon (www. maxthon.com) is an Internet Explorer plug-in that arranges multiple Web pages



Speedometer/Kent Leech; Lock/Getty Images



SCRIBBLE SOME NOTES



by tabs for easy navigation. In addition, it groups sites together so you can open your most-visited addresses all at once.



MOZILLA FIREFOX



OPEN A TAB To open a particular tab in Firefox, hit Ctrl+1 through Ctrl+9. Tabs aren’t numbered, though, so you’ll have to physically count them.



OPEN TABS WITH ONE CLICK Instead of right-clicking a link and choosing Open Link in New Tab, click a link with your mouse’s scroll-wheel button to open it in a new tab. You can also click that tab with your scroll wheel to close it. (You may have to disable any function assigned to your click wheel for this to work, however.)



ONE-CLICK COMBOS Don’t have a scroll wheel? Hold down Ctrl while left-clicking a link to open a URL in a new tab, or hold Shift and left-click to open a URL in a new window.



MORE ON AUTOCOMPLETE To eliminate your AutoComplete history in Firefox, go to Tools > Options > Privacy. In the Saved Form Information area, click the Clear button. To disable this feature entirely, click on the plus symbol next to the Saved Form Information area and uncheck “Save information I enter in web page forms.”



KEEP TABS ON YOUR TABS You can control how new tabs open in Firefox in one of three ways: Open the page in a new window, open the page in a new tab in the front window, or replace the current page in the front window. Click the Advanced section of the Options window to customize it to your liking.



SMOOTH SAILING Put an end to jerky document scrolling by enabling Firefox’s “Use smooth scrolling” feature in the Advanced section of the Options window.



SEARCH IN SHORTHAND Type a word in the address bar, then hit Ctrl+Enter to automatically add http:// www and .com to the beginning and end, respectively, of the word. (Ctrl+Shift+Enter adds .org, and Shift+ Enter adds .net.)



ZOOM IN AND OUT Hit Ctrl and the plus sign to increase text size on your current Web page, or Ctrl and the minus to decrease it. To restore the original size, hit Ctrl+0.
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USE LIVE BOOKMARKS Get the latest headlines from your favorite RSS news sites and blogs. Just click the square, bright-orange icon in the bottom right corner of your browser, and click “OK to save as bookmark.” The Live Bookmark will now function as your RSS aggregator.



GOOGLE AND GMAIL INSTANT 411 You can perform basic Google searches from your cell phone by sending textmessage queries to 46645 (GOOGL). To search for general services in your vicinity, type a word of description followed by a period and your city/state or ZIP code (sushi.10018). To get the weather, use the same format preceded by the word “weather,” or for addresses and phone numbers, by the name of the business. You can even get driving directions by typing from followed by the ZIP code of your starting point and to followed by your destination’s ZIP code—for instance, from 10016 to 10018. You’ll receive text-message responses free of charge (depending on your carrier’s text-messaging plan) within seconds.



Gmail calling Can’t live without e-mail? Have your Gmail sent directly to your cell phone as a text message. Log on to your account, and click the Settings page. Select the Forwarding and POP tab, then the radio button labeled “Forward a copy of Incoming Mail to.” Enter your cell phone’s e-mail address, and click Save Changes. Verizon customers, for instance, would enter their 10-digit phone numbers, followed by @vtext.com. T-Mobile users would enter @tmomail.net, and Sprint customers enter @messaging. sprintpcs.com.



LOST IN TRANSLATION? Need to translate text? Head over to Google Translate (www.google.com/ translate_t), paste the text into the field, and make a selection from the drop-down menu. You can also insert URLs to translate Web pages.



PERSONALIZE YOUR NEWS



Create a virtual drive Turn your Gmail account into an Internet hard drive with Softpedia’s free Gmail Drive shell extension 1.0.5 (www. softpedia.com/get/Internet/ E-mail/Mail-Utilities/ GMail-Drive-shell-extension. shtml). This app adds to your PC a virtual drive that uses your 2GB of Gmail storage space.



You can customize Google’s news page at news.google.com by clicking “Customize this page.” Delete sections, increase the number of stories shown, and even add news categories of your own. To view your customized page from any computer, click the link “Share your customized news with a friend” at the bottom of the page, and e-mail the URL to your Internet-based mail account.



HOME NETWORKING SET YOUR PREFERRED NETWORK To make sure you always connect to the same wireless network, open the Network icon in your system tray, click the Advanced button, and, under “Preferred networks,” move the network to the top of the list.



GO STEALTH



OPT FOR CHANGE



Tighten your home network’s security by disabling its Service Set Identifier (SSID) broadcast. By default, all access points broadcast their SSID, or network name, to anyone within range. Disabling this feature will deter hackers.



Wired Equivalent Privacy (WEP) has been cracked before, but changing your WEP key often will add another level of protection to your network.



CHANGE FREQUENCIES To avoid potential interference from your cordless phone, buy one that operates on a frequency different from your network’s. Companies such as Uniden now offer phones that operate on a 5.8GHz frequency; most Wi-Fi networks operate on 2.4GHz.



Channel surfing Too many wireless networks nearby? If you’re experiencing trouble, try changing the Wi-Fi channel to avoid interference. Check your manual for instructions.



RESTRICTED AREA If your access point supports it, use access lists to specify which machines can log on to your network.



MAINTENANCE AUDIO USE SYSTEM RESTORE… LET ’ER RIP In Windows Media Player 10, you can automatically rip CDs when you insert them into the drive. Select Applications > Tools > Options > Rip Music, and check “Rip CD when you insert the CD” and “Eject CD when you’ve finished ripping.” Click OK to save your settings.



MUSIC MANAGEMENT In iTunes, you can edit song info such as ratings, album name, and album art on multiple song files all at once. Control-click the files you want to edit, then right-click and select Get Info. Click Yes to the pop-up window and check off the sections you want to edit. Press Enter to make the changes.



NAME CHANGE



REPEAT PERFORMANCE Adding a repeater is the quickest and easiest way to broaden the range of your wireless network. Just place the repeater halfway between your router and your computer.



BUILD A WALL Create a virtual wall of protection between your network and the Internet by installing a firewall on every computer logged on to your network. This will keep Internet pests at bay. To enable Windows’ built-in firewall, go to Control Panel > Security Center > Windows Firewall. Make sure the On radio button is selected, and hit OK. For even better protection, another alternative is Zone Labs’ free ZoneAlarm firewall application (www.zonelabs.com).



86



August 2005 computershopper.com



and import them back into iTunes as MP3s. Choose Edit > Preferences > Importing. From the Import Using pulldown menu, click MP3 Encoder. From now on, all imported files will be saved as MP3s. You can later delete the AAC files by choosing Show Duplicate Songs from the Edit menu. Now you’ll have a backup of your music on CD, and you can use iTunes even if you don’t own an iPod.



Windows Media Player 10 lets you customize how music files are named. Choose Applications > Tools > Options > Rip Music, and click the File Name button. In the resulting window, check the box with the information you’d like shown in the filename. Click OK when you’re done to activate the settings.



ACCESS DENIED When transferring your iTunes library from your old computer to a new one, don’t forget to deauthorize your old computer to head off problems with songs protected by digital rights management (DRM).



Always create a restore point using System Restore when installing or deleting software. You’ll find the applet in Accessories > System Tools > System Restore.



…UNLESS YOU’RE INFECTED If your computer has been infected by viruses or spyware, System Restore may actually preserve these Net nasties. Temporarily disable System Restore and perform a full system scan. After you’ve cleaned your PC, delete old restore points and start fresh.



DON’T DOWNLOAD FROM STRANGERS Before you install anything, ask yourself if the software is trustworthy. If you don’t have a good reason to trust it, pass.



Blast spyware Prevent browser hijacks and other Internet-related annoyances by keeping updated copies of Lavasoft’s Ad-Aware (www. lavasoftusa.com) and Spybot— Search & Destroy (www. safer-networking.org) on your hard drive. Both are freeware and help immunize your computer against potential threats.



DELETE COPYCATS Weed out duplicate songs cluttering your iTunes library by selecting Show Duplicate Songs from the Edit menu.



DITCH DRM Want a non-DRM-protected library of songs for your iPod? You can purchase AAC files via iTunes, burn them to CD,



SPYWARE



SPACESAVERS THESE NINE BARELY-THERE BOXES SQUEEZE INTO THE TIGHTEST OF PLACES WITHOUT SKIMPING ON POWER. EDITED BY JOSHUA GOLDMAN
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NOT EVERYONE HAS ROOM for a fullsize desktop PC. And even those with enough space may prefer to ditch a typical tower monolith in favor of a more petite chassis. The development of smaller, faster, cooler-operating components not only allows for smaller PCs, but powerful ones as well. In fact, a few of the desktops in this roundup can handle video editing and 3D gaming. For the most part, however, these systems fall in the middle of the performance spectrum, with plenty of oomph for everyday chores. Because everybody’s space constraints are different, we’ve sorted our nine selections into three categories: all-in-one, low-profile, and small-formfactor (SFF) PCs. And to help you find the best fit, we’ve laid out some basic buying advice for each group. GET IT TOGETHER: ALL-IN-ONE PCS ONE-STOP SHOPPING AT ITS FINEST, an all-in-one PC combines computer and monitor in a single chassis. At one time, these units were, for lack of a better word, ugly. They were big, bulky, and boxy be-



Sony VAIO VGC-V520G 20” TV-PC



MPC ClientPro 414 All-in-One



Feature Comparison Apple iMac G5



MPC ClientPro 414 All-in-One



Sony VAIO VGC-V520G 20” TV-PC



7.0



7.5



7.0



1.8GHz PowerPC G5 512MB DDR ATI Radeon 9600 (128MB) 160GB DVD-ROM/CD-RW combo None 17-inch LCD Built-in stereo Mac OS X 10.4 One year



3.2GHz Pentium 4 540J 1GB DDR2 ATI Radeon Mobility X600 (128MB) 160GB DVD±RW CD-ROM 17-inch LCD Creative I-Trigue L3300 Windows XP Professional Three years



3.2GHz Pentium 4 540 1GB DDR nVidia GeForce FX Go5700 (128MB) 250GB DVD±RW (double layer) None 20-inch LCD Built-in stereo Windows XP Home Edition One year



COMPANY



Apple Computer 800-692-7753 www.apple.com



MPC Computers 888-224-4247 www.mpccorp.com



Sony Electronics 877-865-7669 www.sonystyle.com



DIRECT PRICE



$1,359



$3,239



$2,549



EDITORS’ RATING CONFIGURATION Processor System Memory Graphics Card



Hard Drive Capacity First Optical Drive Second Optical Drive Monitor Speakers Operating System Warranty (Parts and Labor)



cause of their CRT displays, making it hard to tell if you really were saving any space. Plus, many were underpowered. Today’s all-in-ones, thanks in no small part to the affordability of quality LCD screens, are sleek, slim, and—at least the ones we’ve featured here—attractive. Their designs are inherently rife with limitations, however. Because components need to be packed so tightly, heat dissipation is a major concern, and PC makers therefore use low-end and midrange parts, which give off less heat. Some makers, including MPC Computers and Sony Electronics, even use notebook components, which supply ample power at lower temperatures. Lack of internal expansion is another side effect. In addition, prepurchase configuration options are scarce. Of the three all-in-ones reviewed here, only the MPC ClientPro 414 All-in-One offered a decent amount of component choices. Chances are good your PC will be obsolete before its LCD dies, forcing you to dispose of a functioning display, if and when you buy a new system. Conversely, if your LCD fails after your warranty ends, the rest of your PC goes with it. If your needs are basic and your quarters tight, however, all-in-ones are the ultimate space savers.



Apple iMac G5 Apple iMac G5



Editors’ Rating: 7.0 out of 10 Pros: Attractive, slim design; excellent software bundle; wide-screen display; quiet operation Cons: Limited expandability The Apple iMac G5 is the natural evolution of a desktop that keeps getting more compact. In this third iteration, the computer has seemingly disappeared alto-
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gether. We looked at the $1,299 17-inch iMac with a 1.8GHz PowerPC G5 processor. Apple has improved its standard configuration to include a 160GB hard drive, 512MB of RAM, and built-in Bluetooth 2.0 and 802.11b/g wireless connectivity. An included Bluetooth keyboard-and-mouse set bumped our model’s price up to $1,359. This iMac’s screen is slightly less flexible than the last generation’s, but it uses less desk space, and the anodized-aluminum base leaves you a place to tuck your keyboard and mouse when not in use. The amazingly quiet components reside behind and beneath the 17-inch wide-screen LCD, and two downward-firing internal speakers provide respectably powerful sound. The power button, audio line-in, optical audio-out, and video-out, as well as all the ports—three USB 2.0 and two FireWire 400—line up along the back. The case is easy to open, but there isn’t much you can upgrade. Performance was average, considering the midrange component set. Graphics get a boost from the 128MB ATI Radeon 9600 graphics accelerator, an old but still potent solution. Apple includes a full version of its superb iLife ’05 software for working with digital images, video, and audio. You also get AppleWorks, which handles tasks such as word processing and spreadsheet creation; it can create documents in (as well as open) Microsoft Office file formats. Though the parts-and-labor coverage is a standard one year, toll-free phone support ends after 90 days. To extend it, you’ll have to upgrade to a three-year warranty, which costs an extra $169.



WinBook PowerSpec MCE410



MPC ClientPro 414 All-in-One Editors’ Rating: 7.5 out of 10 Pros: Configurable; solid application performance, 3D frame rates; generous warranty Cons: Expensive; monitor position hard to adjust The MPC ClientPro 414 All-in-One is a solid computer that won’t detract from your decor. Our test system’s price was steep at $3,239, but it included 1GB of memory, both DVD±RW and CD-ROM drives, and Microsoft Office Standard Edition 2003. The core components reside in a 2inch-thick slab behind the LCD. The wide silver bezel around the 17-inch LCD looks quite sharp, and the screen itself is bright. The stand is rigid, however, and doesn’t allow for much repositioning. You get a full array of connectivity options with the ClientPro, including six USB 2.0 ports, a FireWire connector, a PC Card slot, and an S/PDIF digital audio jack. The ClientPro is also highly configurable; options include a TV tuner, the Microsoft Windows XP Media Center Edition 2005 OS, a built-in flash-memorycard reader, 802.11a/b/g wireless networking, and alternative LCD sizes (15 and 19 inches). With its 3.2GHz Pentium 4 540J processor, the ClientPro proved a respectable workhorse in our tests. Its 128MB ATI Radeon Mobility X600 graphics card is fine for business use and gaming at low resolutions. For more robust graphics, you can spend an additional $219 for a 256MB nVidia GeForce Go 6600 PCI Express (PCIe) card. The standard warranty is generous: three years for parts and labor, with onsite service and toll-free, 24/7 phone support.



Sony VAIO VGC-V520G 20” TV-PC Editors’ Rating: 7.0 out of 10 Pros: Gorgeous 20-inch wide-screen LCD; robust DVR, multimedia features; built-in Wi-Fi; lots of software Cons: Inconveniently placed drives, ports; overly complex multimedia software Sony’s $2,549 VAIO VGC-V520G 20” TV-PC is a sophisticated all-in-one media-center PC that combines multimedia and TiVoesque capabilities, desktop power, and a truly glorious 20-inch wide-screen LCD. It suffers from a few design problems, but none is a deal breaker. On the right side of the shiny black chassis are a power switch for the inte-



grated 802.11b/g wireless networking, a double-layer DVD±RW drive, an i.Link (FireWire) port, a PC Card slot, a Memory Stick-only card reader, and a pair each of USB 2.0 and audio ports. Because the case tapers sharply to the rear, you have to crane your head behind the LCD to access any of these items. Worse, the remaining ports and connections are located in recessed bays behind the monitor, making access cumbersome. The LCD is gorgeous, and the sharpness of live television was particularly impressive. The VGC-V520G doesn’t support high-definition television (HDTV), but you can capture and edit 1080i high-definition video from a camcorder. The PC and its 3.2GHz Pentium 4 540 processor, 1GB of RAM, and 250GB hard drive team up to deliver strong application performance. The 128MB nVidia GeForce FX Go5700 mobile-level graphics will suffice for media-centric tasks. Sony bundles plenty of software for handling every type of multimedia or office task. Its mediacontrol center, VAIO Zone, is sexier than Microsoft’s Windows XP Media Center Edition, but it’s not as simple to use. The electronic program guide and TV-recording features are particularly complex.



INCREDIBLE SHRINKING TOWERS: LOW-PROFILE DESKTOPS PREVIOUSLY RESERVED FOR MASS deployment in big-business settings, lowprofile desktops have emerged as no-non-



Feature Comparison



Alienware Bot



Dell OptiPlex GX280 BTX



sense enclosures for home and small offices. The size and shape are versatile: Often, you can stand a low-profile PC on end, lay it flat, mount it under a desk, or secure it behind a specially made LCD, such as those in Dell’s OptiPlex line. Looks aren’t the first consideration for these systems, but PC makers are becoming more appearance-conscious. Because low-profiles typically offer little room for internal expansion, they’re best for people who just want to get their work done and don’t plan to mess around inside. Compo-



Alienware Bot



Dell OptiPlex GX280 BTX



WinBook PowerSpec MCE410



EDITORS’ RATING



6.6



7.3



8.2



CONFIGURATION Processor System Memory Hard Drive Capacity First Optical Drive Second Optical Drive Graphics Card



3GHz Pentium 4 530J 512MB DDR 160GB DVD±RW (double layer) None ATI Radeon X300 (128MB)



Monitor Speakers Operating System Warranty (Parts and Labor)



15-inch BenQ LCD Creative Inspire T5400 Windows XP Home Edition One year



3.4GHz Pentium 4 550 512MB DDR2 80GB DVD-ROM/CD-RW combo None ATI Radeon X300 (128MB) 15-inch Dell LCD None Windows XP Professional Three years



3GHz Pentium 4 530 512MB DDR 160GB DVD±RW (double layer) None ATI Radeon X300 LS (64MB) 30-inch WinBook LCD Altec Lansing VS4121 Windows XP MCE 2005 One year



COMPANY



Alienware 800-494-3382 www.alienware.com



Dell 800-999-3355 www.dell.com



WinBook Computer 800-651-4519 www.winbook.com



DIRECT PRICE



$1,489



$1,427



$2,098 (before $100 monitor rebate)
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nents tend to be low-end to midrange, and most models aren’t very configurable. You’ll likely find integrated graphics and sound, fine for day-to-day tasks but not for newer 3D games. Some offer a PCIe slot for a graphics card, so turning one into a modest graphics workstation isn’t out of the question. With the birth of the Windows XP Media Center Edition OS, case manufacturers began changing standard low-profile designs to look more like A/V components, helping them match the look of other home entertainment equipment. We wouldn’t hesitate to put one of these in a room where you mix your work and pleasure, however.



Alienware Bot Editors’ Rating: 6.6 out of 10 Pros: Slim, elegant tower; fast double-layer DVD burner; solid performance; top-end Microsoft mouse, keyboard Cons: Media-card reader is $20 option; small monitor; lean software bundle Alienware’s Bot targets budget buyers who still want that Alienware cachet. Prices start at just $669, but our test configuration cost more than double ($1,489) with a few upgrades, speakers, and a good-but-small LCD. The Bot tower has an appealingly slender look. Three spring-loaded doors hide front-facing audio jacks, two USB 2.0 ports, and a single FireWire port (complemented by four USB 2.0 connectors and The new Bot line will stay another FireWire compact port around back). but feature a The interior is clean, more typical Alienware as well, if a bit look. cramped. Alienware name aside, the Bot is a fairly ordinary desktop with a few standout features, among them a vertically mounted double-layer DVD±RW drive and a top-end Microsoft mouse and keyboard. We’d rather have a media-card reader (a $20 option) than the floppy drive our test unit came with. Also, bundled software was in short supply. Though you can’t expect from the Bot the high-end gaming power synonymous with the Alienware brand, performance was above-average for its breed. The PC should ably handle day-to-day computing activities. (At press time, the company revealed plans to update the Bot’s plain case. (See picture above)
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Dell OptiPlex GX280 BTX Editors’ Rating: 7.3 out of 10 Pros: Quiet operation; strong performer; easy to service; three-year warranty with onsite service Cons: No speakers, FireWire ports Dell’s OptiPlex GX280 BTX offers a compact, versatile design, solid performance, and a stellar three-year warranty that includes onsite service. Despite a few minor shortcomings, such as the absence of speakers, it ranks among the top business PCs in its class. The latticework on the front face of our $1,427 test unit is a nice alternative to staid, traditional case designs. It’s also a function of the GX280’s BTX architecture. (The components on a BTX motherboard are laid out to facilitate cooling, resulting in near-silent operation.) The easy-to-access interior is largely modular, though cramped, with individual levers to free the optical drive, hard drive, and expansion-slot module from their respective bays. Two of the four RAM sockets are vacant, but adding more modules would require removing the optical drive. Outside, however, you’ll find a surprising abundance of USB 2.0 ports—six in back, two in front—though no FireWire. The included 15-inch Dell UltraSharp 1505FP LCD may be small, but it’s as versatile as any LCD we’ve seen. As for power, the GX280 should have most basics covered. Its 3.4GHz Pentium 4 550 processor, 512MB of RAM, and 80GB hard drive will handle some heavy multitasking, and ATI’s PCIe Radeon X300 graphics card provides more than enough muscle for typical 2D graphics.



packed case is more room for expansion than you’d expect. Running Windows XP Media Center Edition 2005, the PC sells for $999 and comes stocked with a 3GHz Pentium 4 530 processor and 512MB of memory—sufficient power to run the OS smoothly. It also includes a 160GB hard drive—smaller than we’d expect, but fair, given the price—and a double-layer DVD±RW drive. Avid gamers may take issue with the 64MB ATI Radeon X300 LS graphics card, which lacks the muscle for demanding titles. We didn’t expect much from the display we tested with the MCE410, the 30inch PowerSpec LC30D LCD TV/monitor, given its relatively low price of $1,099 (before a $100 mail-in rebate). But to WinBook’s credit, it’s a sharp monitor, a colorful HDTV, and surprisingly capable overall. Wi-Fi networking isn’t included, and WinBook supplied a wired mouse and keyboard—clearly illogical for a PC designed for computing from the couch.



LIVIN’ SMALL: SFF PCS A GOOD FIT FOR JUST ABOUT ANYONE wanting full-tower power in a tiny space, the small-form-factor (SFF) PC is becoming a big thing. The originator of the SFF movement was Taiwanese manufacturer Shuttle. Intended for do-it-yourselfers, Shuttle’s early boxes were bare-bones, meaning they included only a case and motherboard. In 2004, the company began building fully assembled systems, continuing in its pioneering efforts by offering a CONTINUES ON PAGE 102



Polywell MiniBox 939AX



WinBook PowerSpec MCE410 Editors’ Rating: 8.2 out of 10 Pros: Low price; 30-inch LCD HDTV/monitor; beautiful, versatile rack-mount case Cons: Wired input devices; no built-in Wi-Fi EDITORS’ If you’re looking for a livingCHOICE room-friendly Media Center PC, set your sights on the WinBook PowerSpec MCE410. Start with the sexy rack-mount case, which looks right at home among stereo components. Along with a big volume dial and a digital status display, the case serves up front-accessible goodies such as a pair of USB 2.0 ports, a FireWire connector, audio jacks, playback buttons, and a memory-card reader. Four more USB 2.0 ports and another FireWire port are around back. Inside the low-rise, densely



Apple Mac Mini



Shuttle XPC G5 9500g



CONTINUED FROM PAGE 98



Feature Comparison Apple Mac Mini



Polywell MiniBox 939AX



Shuttle XPC G5 9500g



7.0



6.6



7.5



1.25GHz PowerPC G4 256MB DDR ATI Radeon 9200 (32MB) 40GB DVD-ROM/CD-RW combo None None None Mac OS X 10.4 One year



2GHz Athlon 64 3200+ 512MB DDR ATI Radeon Xpress X200 (64MB) 200GB DVD±RW (double layer) None 17-inch Hyundai LCD Creative SBS560 Windows XP MCE 2005 Three years (parts), five years (labor)



2.4GHz Athlon 64 3800+ 512MB DDR ATI Radeon X800 Pro (256MB)* 250GB DVD±RW (double layer) None 17-inch Shuttle LCD Logitech Z-5500 Digital Windows XP Home Edition One year



COMPANY



Apple Computer 800-692-7753 www.apple.com



Polywell Computers 800-900-5836 www.polywell.com



Shuttle Computer 888-972-1818 us.shuttle.com



DIRECT PRICE



$499



$1,299



$2,614



EDITORS’ RATING CONFIGURATION Processor System Memory Graphics Card



Hard Drive Capacity First Optical Drive Second Optical Drive Monitor Speakers Operating System Warranty (Parts and Labor)



* = Now ships with nVidia GeForce 6800 GT



wide range of configurable SFFs, from budget to powerhouse. You can load up an SFF PC with the latest high-end components, even multiple hard drives. Size still limits expandability, but you can generally expect two RAM sockets, one x16 PCIe or AGP slot for a graphics card, and one full-size PCI-card slot. Many SFFs are easy on the eyes, too. On the downside, the more performance-oriented the box, the greater the heat concerns. And because of their size, most use small, fast-spinning fans to keep things cool. This makes them a bit loud, which is especially noticeable if you keep your PC on your desk.



Apple Mac Mini



Shuttle XPC G5 9500g DVD/CD-RW combo-drive slot. On the back are two USB 2.0 ports (too few, in our judgment), as well as one FireWire 400 port, a 10/100BaseT Ethernet connector, a modem jack, and a DVI video-out port. In our real-world tests, the Mac Mini’s limited 256MB of RAM and older 1.25GHz PowerPC G4 CPU didn’t exactly wow us. In addition to the lack of memory, the slowspinning 4,200rpm hard drive contributes to the performance lag. The lack of expansion is another obvious drawback. Like many budget systems, the Mini doesn’t deliver dazzling graphics performance, but it will ably handle the apps found in Apple’s included (and outstanding) iLife ’05 software suite for manipulating photos, music, and movies.



Editors’ Rating: 7.0 out of 10 Pros: Sub-$500 Mac; extremely compact; whisper-quiet; includes iLife ‘05



Polywell MiniBox 939AX



Cons: Just 256MB of RAM; no keyboard, mouse, speakers; slow hard drive; only two USB 2.0 ports



Pros: Highly configurable; reasonable price Cons: Below-average performance; only basic software, docs included



Windows users are running out of excuses for not at least trying Mac OS X. At $499, the stand-alone Mac Mini (and it really stands alone—it ships without keyboard, mouse, monitor, or speakers) offers would-be Apple converts an inexpensive, stylish entry-level Mac. The Mac Mini is also the epitome of an SFF system, with Apple squeezing a full-on budget desktop into a beautiful box weighing just over 2 pounds. Its performance is glacially slow for processor-intensive tasks, so power users should look elsewhere, but it’s a great buy for everyday home computing. The Mac Mini looks striking in any environment and, when powered on, is marvelously quiet. Up front, you’ll see only a



Polywell’s MiniBox 939AX Media Center PC—and, dare we say, the company’s PCs in general—are for knowledgeable buyers willing to put up with a few rough edges to save some green. This SFF PC serves up geek chic, with its glossy black front, matte-silver cladding, and blue neon lights. Below the sole optical drive (a double-layer DVD burner) sits a media-card reader along with a pair of USB 2.0 ports, a FireWire connector, and headphone and microphone jacks. Around back are four additional USB 2.0 ports and another FireWire connector. Inside, the case is tight, but access is still acceptable for a few upgrades, including an x16 PCIe graphics card.
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Our $1,299 test unit included a 17-inch LCD and a six-channel speaker set. You get a respectable, middle-of-the-road configuration: a 2GHz Athlon 64 3200+ CPU, 512MB of RAM, onboard ATI Radeon Xpress X200 graphics, and a 200GB hard drive. The integrated video and sound aren’t ideal for running the Media Center Edition 2005 OS, but Polywell offers upgrade options. Performance is predictably pedestrian, but you’ll still be able to run the 2D graphics—TV programming, DVDs, videos, and photos—expected from a Media Center PC. Note, though: You don’t get much useful documentation with the 939AX, nor any preloaded software utilities.



Editors’ Rating: 6.6 out of 10



Editors’ Rating: 7.5 out of 10 Pros: Sleek SFF case; beautiful monitor; killer graphics card Cons: Costly; noisy optical drive Judging from Shuttle’s XPC G5 9500g, it’s no wonder SFF PCs are all the rage. Our $2,614 test unit packs as much computing strength inside its tiny shell as many fullsize desktops. Shuttle’s shiny little case has all the trappings of the typical SFF PC: a single optical drive (in this case, a noisy doublelayer DVD±RW), a multiformat media-card reader, and convenient front-panel ports (two USB 2.0, plus one mini-FireWire, headphone, and microphone). Inside, it’s standing-room only, typical of most SFFs. Our G5 came well-stocked with a fast 2.4GHz Athlon 64 3800+ CPU, a 250GB hard drive, and ATI’s fire-breathing Radeon X800 Pro graphics card. With this kind of graphics power, you can tackle almost anything; indeed, the G5 is a perfect companion for any LANparty gamer. (Note that Shuttle now offers an nVidia GeForce 6800 GT card in place of the X800.) Though the system chewed through games, application performance was below-average. (We suspect the bottleneck is in the SFF motherboard.) The G5 is by no means a slow machine, however, and it showed no signs of sluggishness in any of our real-world tests. One of the true highlights of this package is Shuttle’s gorgeous XP17 monitor, a 17-inch dual-input LCD with a built-in carrying handle. Reviews by Rick Broida, Troy Dreier, and Asa Somers



The Broadband Bells WE DIAL UP NINE VOIP SERVICES TO SEE WHICH DIGITAL PHONE PROVIDER CAN BEST REPLACE YOUR LANDLINE.



Replacing your analog phone service with a Voice over Internet Protocol (VoIP) provider is no longer just for the early adopters. According to research firm IDC, VoIP subscribers in the United States will rise to 3 million this year, and by 2009 that number will swell to 27 million. The number of VoIP services is growing, too. When we did a roundup of providers last year, we looked at five services; this time out, we’re looking at nearly twice as many. What’s the appeal of using the Internet to handle your phone calls? Price, for one thing. Most VoIP services have unlimited-minutes plans for calls to the United States and often Canada for under $35 a month; if you need fewer minutes, even cheaper plans are available. International calls are also a bargain— usually a few cents per minute to Western Europe. Most services also offer virtual numbers (often for an extra fee), a second number that you could place in an area code from where you receive a lot of long-distance calls. Friends and family in that area code can call the virtual number as a local call instead of paying long-distance fees. Most services also include features that often cost extra from analog phone providers, such as Caller ID, call waiting, three-way calling, call for-
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warding, and voice mail. And while calls made over the Internet can be plagued by delays, dropouts, and background noise—especially if you are uploading and downloading data files while talking—call quality isn’t the nightmare it once was. Another problem with VoIP services—the lack of full emergency 911 sup-



port—also may be overcome soon. At press time, most VoIP providers offered only a limited version of emergency service—usually routing your 911 call to administrative offices at call centers. You also need to tell 911 dispatchers your location because they won’t have that information available when you call. But Packet8 is the first service to



Illustrations by David Flaherty



EDITED BY SEAN PORTNOY



offer Enhanced 911 (E911), which will automatically display your name and location to dispatchers. The Federal Communications Commission recently ordered VoIP providers to offer E911 service by roughly the end of August.



AT&T CallVantage Editors’ Rating: 8.0 out of 10 Pros: Feature-packed; excellent call quality; useful interface



countries. The service’s primary weakness: no 911 support at the time of this writing. Unlike most Internet phone services, BroadVoice can use any telephone adapter supporting Session Initiation Protocol (SIP) with its service, letting you pay only a $9.95 activation fee instead of a $39.95 hardware charge to have BroadVoice provide an adapter for you. BroadVoice area codes are available in 36 states; if you live in an area where BroadVoice has service, you can transfer your current number to the service. Caller ID, call return, three-way calling, and voice mail are all part of the standard bundle, along with numerous callforwarding options. Call quality in our



Cons: Pricier than some other services AT $29.99 PER MONTH, AT&T’s CallVantage unlimited-minutes plan is pricier than those of some competitors, but for good reason: It was one of the strongest performers on our voicequality tests. You have several features at your disposal, including limited 911 support, virtual numbers ($4.95 per month extra), conference First, you need a broadband concalling, call filtering, nection. In most cases, your VoIP and call forwarding. provider sends you a telephone Though CallVantage’s adapter to connect to your analog phone. The Web interface appears adapter plugs into your broadband modem (or, if busy on first glance, it you already have a home network, your router). provides quite possibly You then handle your account via a softwarethe most useful VoIPbased interface. account interface we’ve seen. tests was average compared with the When you sign up for your service, you specify whether you want to get a other VoIP services we’ve reviewed. Calls new phone number or transfer your exwith little network traffic sounded clear isting number; area codes in 39 states but deteriorated during data downloads are available. In addition to offering a and particularly during uploads. standard telephone adapter that reGlobal Village quires a connection to a broadband Editors’ Rating: 6.7 out of 10 router, AT&T gives you the option to purchase a VoIP-enabled Linksys wirePros: Strong call quality; hardware device can ease setup less router that combines the two de-



How Does VoIP Work?



vices. It’ll save you from having to buy a router if you don’t already own one, and it’s well-equipped to juggle voice and data traffic on your network.



BroadVoice Editors’ Rating: 7.3 out of 10 Pros: Low monthly rates include international calling; can use any SIP-capable phone adapter Cons: No 911 support; average call quality IF A LARGE PORTION of your monthly phone bill consists of costly international calls, BroadVoice is a VoIP service worth considering. The $19.95 Unlimited World plan, which costs less than what many providers charge for their domestic calling plans, includes unlimited minutes in the States plus 21 other



Cons: Must purchase $99 hardware device; no local-number portability; no 911 support THE unlimited-minutes plan offered by Zoom Technologies’ Global Village is competitive at $24.95, but you have to invest about $100 in a piece of hardware to get started—either a DSL modem/router/firewall/phone adapter, or a router/firewall/phone adapter for cable modems. That results in a far heftier initial cost than the other services’ activation fees. Still, having just one device, instead of linking a router to a phone adapter and the router to your broadband modem, is convenient if you don’t already have a home network installed. Also, you may be able to use the hardware for other VoIP services if you



PC Takes The Calls One cool feature of many VoIP services is the ability to hear your voice-mail messages via a PC. Often you can be notified of new messages via e-mail if you are away from your phone; you can even have voice mail sent to you as e-mail attachments.



don’t like Global Village. You can’t port over your existing number, though Global Village gives you a choice of area codes in 39 states. While it has most of the features of the other services, it doesn’t let you choose which calls you want forwarded. The service doesn’t provide any kind of 911 support, and the company recommends you keep your landline for emergency calls. On the upside, Global Village’s call quality was consistently strong in our tests, which included two overseas calls.



iConnectHere Editors’ Rating: 6.3 out of 10 Pros: Softphone option is included Cons: No 911 service; inconsistent call quality; can’t use your existing phone number WITH ITS inconsistent call quality and lack of 911 support at press time, iConnectHere is a less-than-ideal replacement for your current phone service. The price for its unlimited-minutes plan for U.S. and Canadian calls is high at $29.99, and you currently can’t transfer over your existing phone number. On the other hand, iConnectHere provides a softphone feature, which it calls PC-



What’s a Softphone? Want to take your VoIP on the road with you? Look for a provider with a softphone option. A softphone is a downloadable program that allows you to make and receive phone calls solely through your PC. (This is what the Skype service is based on.) You just need a microphone or a headset to talk to the other party.
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limited 911 support at press time. Lingo’s call quality was inAt press time, America Online had consistent, though: just jumped into the VoIP fray with We experienced more AOL Internet Phone Service across 40 interference than major cities. For current AOL subscribers, the unwith other VoIP serlimited-minutes plan across the United States and vices we’ve tested. Canada costs $29.99; new subscribers can get AOL When you sign up Internet service and the unlimited VoIP plan bunfor Lingo’s service, dled for $39.99. The service includes full E911 callthe company sends ing support. Cable giants are getting in the mix, you a proprietary too: Cablevision, Comcast, and Time Warner Cable Primus telephone all have started offering VoIP service to subscribers. adapter. You choose a phone number to-Phone, for no extra charge. The serfrom more than 220 area codes in the vice also has the standard VoIP features, United States. For an extra $5 per including voice mail, Caller ID, call month, you get an additional virtual waiting, and call forwarding. number with a U.S. or Canadian area Sometimes our outbound calls simply code; $10 per month buys you an interdid not connect using iConnectHere. national phone number. When we did get through, inbound sound Lingo couldn’t match the audio qualiquality tended to be quite clear, but folks ty of the other VoIP services we tested. at the other end described our voice as On both ends of our calls, the audio “compressed” or “tinny, like you’re inside sounded slightly muddy, and we noticed a trash can.” On some occasions, calls minor clipping at the ends of words. sounded clear at first, then developed Packet8 static or an echo. On other occasions, Editors’ Rating: 8.0 out of 10 overall sound quality was excellent in both directions. This inconsistency would Pros: E911 support; low-cost unlimited-minutes plan; superb coverage across the United States make us wary of relying on the service.



You’ve Got VoIP



Lingo Editors’ Rating: 7.0 out of 10 Pros: Low-cost unlimited-minutes plan; limited 911 support Cons: Disappointing call quality ALONG WITH BroadVoice and Packet8, Lingo offers the least-costly monthly unlimited-minutes plan of all the VoIP packages we’ve seen. Its $19.95 fee covers calls to not only the United States and Canada, but also numerous countries in Western Europe. The plan also included



Cons: E911 service costs extra YOU NEED TO KNOW two things about the Packet8 VoIP service. First, its unlimited-minutes residential plan, at $19.95 per month, is among the cheapest you’ll find. Second, it’s the first VoIP service to offer 911 support that’s close to what you get with a traditional landline phone. Dubbed E911, the service provides the emergency operator with caller information onscreen when you call. (With other VoIP services, calls to 911 are often routed to administrative lines at emergency



call centers, and they rely on callers to provide their number and location.) Packet8 charges $1.50 per month for E911, plus a $9.95 activation fee. Alaska, Hawaii, Iowa, and Maine are the only states not included in Packet8’s coverage area. You can transfer your current number to Packet8’s service, and a virtual number costs you a $9.95



Zapped! VoIP services may be solving their 911calling issues, but there’s another emergency situation most of them can’t handle—if the power goes out, so does your Internet phone service. Of course, if you have a cell phone, you can use that until the power returns. In fact, Verizon VoiceWing lets you input a backup number to which your VoIP calls can be forwarded in case of a power outage. activation fee and $4.95 per month after that. Under light network-traffic conditions, Packet8’s voice quality is comparable to that of landline phones, but like many VoIP services, conversations proved difficult when we were uploading files to the Web during calls.



Skype 1.2 Editors’ Rating: 8.0 out of 10 Pros: Free Skype-to-Skype calls; good call quality for Skype-to-Skype calls Cons: Inconsistent call quality to landline phones with SkypeOut



EDITORS’ LEVERAGING your Internet CHOICE access to make free phone calls—yes, free—is a snap with Skype 1.2. This peer-to-peer soft-



Feature Comparison AT&T CallVantage



BroadVoice



Global Village



iConnectHere



Lingo



EDITORS’ RATING



8.0



7.3



6.7



6.3



7.0



911 Support



Limited



None



None



None



Limited



Virtual Numbers



$4.95 per month



$3.95 per month



$6.99 per month



$4.95 per month



Softphone Feature



None



None



Free



None



Activation Fee



$29.99



$29.95



$29.99



None (hardware costs extra) $24.95



$29.99



Monthly Fee (Unlimited Minutes)



$3.95 per month ($9.95 setup fee) $1.95 per month ($9.95 setup fee) $39.95; $9.95 (if you own compatible hardware) $19.95



$29.99



$19.95



COMPANY



AT&T 866-816-3815 www.usa.att.com/callvantage



BroadVoice 978-418-7300 www.broadvoice.com



Zoom Technologies 800-778-7423 www.globalvillage.com



Deltathree www.iconnecthere.com



Lingo 866-546-4603 www.lingo.com
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phone app from the makers of Kazaa lets you talk to other Skype users using VoIP for no charge. And for those friends and family you can’t convince to download and install the free app, you can still call them from your PC by using a prepaid SkypeOut account. We experienced mixed results with SkypeOut. Call quality approximated what you’d expect from a cell phone— some calls were clearer than others. On regular Skype-to-Skype calls, however, call quality was very good, with only the slightest evidence of latency. Now in beta is SkypeIn, which allows feepaying subscribers to choose a country and area code, then assigns a standard telephone number. SkypeIn customers also get free Skype Voicemail (also in beta); stand-alone Skype Voicemail subscriptions are available for a fee.



Verizon VoiceWing



UP NEXT: Wi-Fi Voip Phones HOLY ACRONYMS, BATMAN! Now there’s a more elegant alternative to hooking your analog phone to a special telephone adapter to receive VoIP service. If you already have a wireless network in place, a Wi-Fi VoIP phone eliminates the need for an adapter. Better yet, if you take the phone out and about, you can make and receive calls via public hot spots or other Wi-Fi networks you have access to.



If your provider supports Session Initiation Protocol (SIP), you can buy third-party products like Zyxel’s $249 P-2000W. But VoIP providers are also getting into the Wi-Fiphone act. BroadVoice offers the Pulver WiSIP phone for $149.95, usable with any of its unlimited-minutes plans. At press time, Vonage was planning to roll out its own WiFi phone in the fall for less than $100. —S.P.



Editors’ Rating: 6.8 out of 10 Pros: Provides a backup number in case of power outage Cons: Pricey; some calls aren’t very clear VERIZON SELLS VoiceWing as both an add-on for its existing DSL users and a separate service for non-Verizon broadband users. Without Verizon DSL, VoiceWing costs $34.95 a month for unlimited minutes, at the high end of services we’ve tested. (Verizon DSL subscribers are given a somewhat measly $5 break per month for the first year.) VoiceWing is also pricey when it comes to virtual numbers—$7.95 per month tops the competition. Currently, VoiceWing offers area codes from roughly 80 percent of the United States, but none in Canada. VoiceWing does come with a handy feature that lets you input a backup number to which calls will be routed if you temporarily lose power or your Internet



connection, something most VoIP services don’t provide. VoiceWing didn’t fare all that well on our voice-quality tests; calls exhibited a faint rustling sound in the background and quickly deteriorated when we uploaded a file to the Web while trying to carry on a conversation.



Vonage Editors’ Rating: 8.5 out of 10 Pros: Strong call quality; solid coverage area Cons: Only cable Internet subscribers can transfer existing number; softphone feature costs $9.99 per month



EDITORS’ VONAGE’S STRONG call CHOICE quality and solid coverage combine to make it the pay VoIP service to beat. At $24.99 for its unlimited-minutes plan, Vonage is in the middle of the pack price-wise.



Packet8



Skype 1.2



Verizon VoiceWing



8.0



8.0



6.8



Vonage 8.5



Full ($1.50 per month; $9.95 setup fee) $4.95 per month ($9.95 setup fee) None



None



Limited



Limited



$39 for 12 months; $13 for three months Free



$7.95 per month



$4.99 per month



None



$9.99 per month



$29.95



None



$39.95



$29.99



$19.95



Free (Skype-to-Skype calls) outside-Skype calls extra



$34.95; $29.95 (Verizon DSL subscribers)



$24.99



8x8 888-898-8733 www.packet8.com



Skype Technologies www.skype.com



Verizon 800-270-5369 www.voicewing.com



Vonage 866-243-4357 www.vonage.com



The service lets you choose among a wide variety of area codes, with coverage in most of the United States and Canada. To date, the only states not to have available area codes in the Vonage system are Alaska, Hawaii, Idaho, Montana, West Virginia, and Wyoming. You may choose to transfer your current number if you are a cable Internet subscriber. Adding virtual numbers costs $4.99 each per month, and a softphone feature costs a pricey $9.99 per month. Vonage deserves kudos for being one of only two VoIP services we’ve tested whose audio quality equaled that of analog (the other being AT&T CallVantage).



Need to Know More? Check out the “VoIP Resources” listing in our Web Buyer section for a selection of sites offering useful information on VoIP.



Using the included Linksys RT31P2 telephone adapter and Ethernet router, call quality didn’t worsen during significant upstream traffic from a PC—a rarity with VoIP providers. Reviews by Rick Broida, Matthew Elliott, and Neil Randall
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COMPUTER CURES ALFRED POOR A SCREEN WORTH SAVING I understand the need for a screensaver on a CRT monitor, but I don’t understand why you



additional benefit for notebooks: Turning off the display when idle can significantly extend battery life.



would need one on a notebook’s flat panel. Should you use a screensaver on an LCD?



Henry Poh Screensavers were originally developed to avoid “burning” an image into a CRT monitor. CRTs create an image by hitting phosphors with electrons; the phosphors emit light. Over time, the phosphors lose their brightness, and if you keep a single image onscreen for an extended period, some phosphors will lose more brightness than others, because some will be emitting all the time.



THE MOD SQUAD I want to install some Mini-ITX motherboards into nontraditional computer boxes: a Lost in Space Jupiter 2 toy, an OS/2 Warp version 4 box, and a TI-99/4A computer case. I have most of the parts, but I need lights to show hard drive activity, a power indicator, and power and reset switches. These are parts that would normally be included in a computer case. Do you know where I can buy them? To m L e e M u l l i n s



As a result, when you display a different image on the screen—or even just a full white screen—you might see a “shadow” of the original image. Screensavers were meant to turn off most of the image, but display something that indicates that the computer is still



The modding movement has created some amazing computers—for example, check out the Projects section at Epiacenter (www.epiacenter.com) for some unique and inspiring PC creations.



on, usually through some moving element.



CRTs have improved to the point where burn-in is less of a problem, and screensavers have become more a means of entertainment than a solution to a technical problem. In fact, many use largely static images—such as an aquarium tank—in which only a small portion of the image changes. LCDs can also be susceptible to image burn-in, though it isn’t as common as with CRTs. If you’re going to use a screensaver, it should have a black background with a small, moving image. The best solution, however, is to use the energy-saving feature within Windows, telling the monitor to shut off when the system has been idle for a given period. This will not only prevent burn-in but also save energy. Plus, it can extend the life of the display. An LCD uses a backlight that loses brightness over time, so it’s better to turn off the monitor—and thus the backlight—than to leave it on for some entertaining screensaver. An
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Windows’ energy-saving feature, which tells the monitor to shut off when the system has been idle for a given period, will not only prevent burn-in, but also save energy. Plus, it can extend the life of the display. Modders tend to be a self-sufficient bunch, however, and typically create their own indicator-light and switch assemblies. This gives them more flexibility in the layout and position of these components. Still, you can buy LEDs and all sorts of switches (some of which light up when the power is turned on) at any electronics-supply store or online at sites such as Performance PCs (www. performance-pcs.com), RadioShack



(www.radioshack.com), and Voyeurmods.com (www. voyeurmods.com). Add some wire and solder, and you’ve got the items you need. POKY PACKETS? It takes about three minutes to transfer a 620MB video file from one computer to another over my wired Ethernet LAN using standard TCP/IP. I calculate that to be only about 3.5Mbps. These PCs run Windows XP, and all of my hubs, routers, and Ethernet cards are rated at least 10/100Mbps. Shouldn’t I be able to get a much better rate of transfer through a wired LAN? R i c h a r d M u s g r av e The 10/100Mbps rating on the network connection is bits per second, not bytes per second. Also, not all the bits being transferred are data; a TCP/IP network breaks the data into packets, so there’s considerable overhead involved in adding an address and other information to each packet. There’s no fixed size for this overhead, but as a rough rule of thumb, divide the number of bits by at least 10 to get bytes per second. A 10BaseT connection has a theoretical maximum throughput of 10Mbps, or about 1MB per second. So a 10BaseT card would take at least 620 seconds to transfer a 620MB file, which is a little more than 10 minutes. A 100BaseT connection would require at least a little more than one minute. Plus, these maximum rates assume no other activity on the network that would slow down transmission, and that the connection has perfect signal quality so no packets have to be resent. In a real-world setting, network traffic slows transfer rates, so your reported rate does not seem grossly out of line. To get the best performance, turn off any other computers on the network, and



HELP & HOW-TO COMPUTER CURES make sure no other software that might access the network is running. If you have a clean connection and are knowledgeable about the inner workings of TCP/IP, you may be able to boost performance somewhat by increasing the packet size. This would reduce the amount of overhead as a percentage of the data being sent, but it could also create slower transfers if packets need to be resent. So I wouldn’t recommend fiddling with these settings unless you know exactly what you’re doing. NOTEBOOK DOESN’T KNOW JACK I read John Woram’s Weekend Project about digitizing LPs for burning to CD (“Vinyl Resurrection,” May, p. 104). All the information was great, except for one important omission: What about those of us with laptops that don’t have a line-in jack? I have about 100 old vinyl records I’m dying to put on CD— even with their scratches. Can you help? Fr e d Wi s e I have a couple of solutions for you. Look for a PC Card sound card or a USB external sound module, making certain it has a line-in jack. Companies such as Creative (www.creative.com), Hercules/Guillemot (us.hercules.com), and Echo (www.echoaudio.com) sell such products. I’d be more inclined to go with the PC Card type of device, as I’d expect it to be less prone to latency problems—delays caused by the interface—that could mar your recordings. The other option is to use a service to



TIP OF THE MONTH: SMARTER MEDIA Many of us are now on our second— maybe even third—digital camera. And the chances are great that the new camera uses a different type of memory card than the old one. So, what to do with those old cards? This month’s tipster has a handy suggestion.



I have some old SmartMedia cards I can no longer use since I upgraded my digital camera. I also have a USB SmartMedia-card reader. Instead of tossing these out, I realized I could use them together as a pseudoflash drive. The reader and card are small enough to carry and move between computers to shuttle files back and forth—just like a key-chain or thumb drive would. Dusan Rotarov
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digitize your records. (A Google search should turn up several options.) These companies typically charge around $20 per album, however. If you have 100 records to convert, it would be less expensive to buy a whole new computer and do it yourself.



PC IDENTITY CRISIS I have a computer running Windows XP Home Edition that I want to give to my son. He’s an adult and wants to be named as the registered owner. How do I change the original owner’s name? A l b i n S. Wi l s o n



A VIABLE VIDEO SOLUTION I have a lot of video stored on my hard drive and would like to know: What is the most efficient video format, in terms of quality per megabyte of storage? Ya n g Z h o



This information is stored in the Windows Registry, and Windows’ Registry Editor utility lets you change Registry information. The problem with this program: It has no undo command, so if you change or delete something in error, there’s no simple way to correct your mistake. You can find safer-to-use commercial and shareware Registry editors, but if you’re careful and take your time, the Windows utility can do the job just fine. Choose Start > Run, type REGEDIT into the Run window, and press Enter. Then go to Edit > Find, type RegisteredOwner into the Find window, and press Enter. The search can take several minutes if your computer’s Registry is large, so be patient. It should find the key HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\Windows NT\ CurrentVersion. Simply double-click on the RegisteredOwner item, and a window should open in which you can change the name. You can edit the RegisteredOrganization in the same way. DO NOT change anything else. Close the utility and reboot, and the new owner’s name should appear.



Asking which compression format gives you the best quality per megabyte is like asking which car gives you the fastest acceleration at the best fuel economy— there’s a trade-off involved. In fact, most compression/decompression algorithms, or codecs, let you choose your degree of compression and level of quality. But how do you measure quality? It might be very different from how I measure it because you might not mind certain types of artifacts that I would find objectionable, and vice versa. If you’re planning to view this video content on devices other than your PC, you might want to add portability/compatibility to your criteria. In that case, I expect you’ll find the MPEG family of codecs will give you the control over size and quality you seek. Plus, MPEG makes it simple to record to DVD to watch your video on other devices.



Without question, USB thumb drives have become the new floppies—except they’re smaller, faster, and larger-capacity. But a USB reader and a flash-memory card will work just as well to move files between PCs. In fact, I find it’s sometimes faster and easier to use a card and reader to transfer a file from one computer to another than to move the files over my local area network.



Belkin Hi-Speed USB 2.0 8-in-1 Media Reader/Writer



If you don’t have a USB reader for your cards, you can find them for as little as $20, and some will read eight or more different memory-card formats. One good example is Belkin’s Hi-Speed USB 2.0 8in-1 Media Reader/Writer, which we found for $23.95 at Amazon.com.



Send us your favorite tip, and you could receive a tipster’s prize package, including a coveted “Computer Cures” T-shirt, along with some other exciting items you can’t get anywhere else. “Alfred Poor’s Computer Cures,” Computer Shopper, 28 E. 28th St., 10th Fl., New York, NY 10016-7942 [email protected] Please include your name. Due to the number of letters we receive, we cannot provide personal replies, nor return any enclosures.
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WEEKEND PROJECT HARDWARE Upgrade your sound card and speakers for a mindblowing audio experience.



Immerse Yourself in 7.1 Sound



1



Choose your hardware



The market for 7.1 sound cards is dominated by Creative’s Sound Blaster Audigy 4 and Audigy 2 ZS product lines, which include Platinum and Pro versions that ship with advanced breakout boxes. We chose the $299.99 Audigy 4 Pro solution, which, in addition to the breakout box, has a wireless remote. If you’re planning a relatively simple setup, save a few bucks by selecting a less robust 7.1 board from another vendor, such as M-Audio’s $119.95 Revolution 7 or the $49.95 Catalina from Voyetra Turtle Beach.



BY DON LABRIOLA



For our 7.1 setup, we chose Creative’s Sound Blaster Audigy 4 Pro sound card and the company’s top-of-the-line GigaWorks S750 speakers.



Your choice of 7.1 computer speakers will be limited. Two popular models are Creative’s top-of-the-line $499.99 700-watt GigaWorks S750—which we chose—and the more affordable $99.99 Inspire P7800. Both offer auxiliary input jacks, wallmounting options, and the ability to automatically upmix 5.1 and 6.1 sources to 7.1. Tip: Although no match for the best sound cards, some motherboards now offer cost-effective integrated 7.1-channel audio.



audio setup may sound great, but today’s 7.1 technology pushes immersive sound even further. The two additional channels better produce sounds that travel from front to rear or pan side-to-side behind your head. For the full effect, you’ll need a 7.1channel sound card and a game that supports a 7.1-audio API. Setting it all up can be challenging, but with proper planning and attention to detail, you can achieve great results. YOUR AVERAGE 5.1-CHANNEL
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2



Install the sound card



Installing a 7.1 sound card isn’t much different from setting up any other plug-and-play PCI card, except it does require a connection to your power supply. If your system uses integrated sound rather than a separate sound card, you’ll need to disable it in the BIOS before you proceed. You can usually enter your PC’s BIOS by pressing Delete or a specific function key during the preboot power-on self-test (POST) process; the necessary keystroke is often displayed at the bottom of the screen during the POST. Next, power down your PC, unplug it from the AC outlet, and pop open the case. Touch a metal section of the case to discharge any static electricity your body may have accumulated. Find a free PCI slot on your motherboard, remove the adjacent slot bracket that exits the rear of the case, and insert the Audigy 4 card into the slot. Then attach the card’s



Guide the sound card gently but firmly into the PCI slot. Don’t forget to connect the power cable to your power supply.



power cable to your power supply, and connect the external breakout box. Close the case, reconnect the PC to its AC outlet, and power up. Windows XP should detect the new hardware and prompt you to install new drivers. Don’t—exit the wizard and run the Creative Audigy 4 install application from the included CD-ROM. Once you reboot, your new, powerful card should be up and running. Tip: Don’t force the sound card into its PCI slot. Gently but firmly guide it into place to avoid damage to your components and your fingers.



but you’ll still get acceptable results simply by tilting it to point directly at your ears. You may have to mount the rear and side satellites on stands or on a wall to place them at ear level. The circumference of your circle of sound is a matter of taste, but it’s also constrained by the size of the room. All else being equal, a larger circle will yield more room-filling sound. Closer positioning will result in higher volume levels and more precise imaging, but a more cramped soundstage. If you’ll also be watching DVDs, keep in mind the Surround channels in a DVD’s Dolby Digital 5.1 soundtrack are mixed to have a diffuse, directionless quality. Dolby recommends facing Surround satellites away from listeners—just the opposite of what you’d want for pinpoint-accurate 3D-audio gaming. Unless you want to reposition two of the satellites every time you want to watch a movie, you’ll have to resign yourself to a lessthan-optimal cinema sound experience. Once you’ve positioned all your speakers, connect them to the rear of the subwoofer using the four color-coded mini headphone-size plugs. Then attach the subwoofer to the Audigy 4 card’s rear panel via the included 7.1 audio cable. Tip: Positional 3D audio works best with a minimum of room reflections, so your listening area should be as acoustically dead as possible—carpets, drapes, and upholstered furniture help achieve this.



4



Tweak and enjoy



Positional audio requires that you balance the volume of all seven satellites at your normal lisLay out your speakers tening position. Most 7.1 sound cards provide a While installing a sound card is straightforward, speaker-calibration utility that cycles pink noise configuring a 7.1 speaker system is more of an (white noise that’s been filtered to reduce the volart. Ideally, all seven satellites should be at the ume at each octave) through each channel. You same height, which often means mounting the can use this tool (or any other pink-noise source) to set volume rear and side satellites on stands or on the wall. levels by ear. With this many speakers, you’ll need to choose An even better option is RadioShack’s $39.99 Sound Level Mea room large enough to position all seven satellites (center, ter (www.radioshack.com), held at your normal head position. front left, front right, middle left, middle right, rear left, rear For increased accuracy, mount the meter on a tripod. Then set right) to be roughly equidistant from your seating position the meter to C Weighting and Fast Response, and adjust each without creating a satellite’s volume level until all tripping hazard. produce identical readings when To get an idea of playing the noise signal. Center what you’re after, picYou can follow a similar proceFront Right ture yourself sitting in dure to set the volume of your Front Left the center of a circle of bass unit, but not all listeners Middle Right sound, with each pair want a truly accurate bass/satelof satellites placed lite balance. We suggest adjusting symmetrically on that the bass-level control manually circle at about ear while playing your favorite source height. (See chart.) material until you find a bass rePlace the front left and sponse that doesn’t muddy up the front right speakers on rest of the output. top of your desk on eiTip: If maxing out your bass level Middle Left ther side of your monistill doesn’t give you enough botRear Right tor, and, if possible, the tom, try repositioning the subRear Left center speaker atop the woofer cabinet. Placing it closer display. If you do this, it to large, flat surfaces reinforces may be impossible to low-frequency output, so moving When positioning the speakers, envision a circle of sound, with all the satellites positioned equidistant from one another, at match its height to that it into a corner should provide about ear height. of your other satellites, maximum bass boost.
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WEEKEND PROJECT SOFTWARE



1



Turn your PC-based setup into an Apple-friendly zone.



Before you begin, you’ll need to change your Mac’s workgroup name to match that of your existing workgroup. To do so, go to Macintosh HD > Applications > Utilities > Directory Access. Then click the lock icon in the lower left corner, enter your username and password, highlight the name of your router (in our case, SMC), and click the Configure button. Type in your workgroup name, and click OK. From the Apple menu, open the System Preferences option, and in the Internet & Network row, double-click the Network icon. Click the Location box’s drop-down arrow, select New Location, Our Mac will use its built-in wireless AirPort card to communicate with the and give your Mac a network’s SMC router. network name. If you’re using a wired connection, select Built-in Ethernet in the Show box. For a wireless network, select AirPort, choose the name of your network, and enter a password, if required. To give the Mac a distinctive name, reopen the Apple menu and select System Preferences. In the Internet & Network row, double-click the Sharing icon and enter a name. Then click the Services button to review the list of services. Highlight any one to view a brief description. If you’re uncertain about which option to choose, check the four Sharing options and clear the others.



Add a Mac to Your Windows Network BY JOHN WORAM



are the yin and yang of the tech universe, then these two seeming opposites should be able to coexist harmoniously. We found feng shui by adding a Mac to our combination Ethernet/ Wi-Fi home network, which consisted of two desktops, a notebook, a network laser printer, and a personal inkjet. Our Power Mac G5 joined the party via an internal Apple wireless AirPort Extreme card. Computers on the network were running Windows 98, Windows XP Professional with Service Pack 2, and Mac OS X 10.3.7.
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Illustration by David Flaherty



IF THE MAC AND THE PC
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Configure your Mac



Configure your PCs



To get your computers configured to work together, select My Network Places from your Windows XP Start menu, and in the Network Tasks column, select “Add a network place” to open the Add Network Place wizard. Then click Next, select “Choose another network location,” and click Next again. Open the drop-down menu and select \\192.168.2.xxx\username as the username. (“xxx” is your PC’s ID, and “username” is the name you’ve used on the Mac.) Then click Next, type a distinctive name, click Next again, and click Finish. You should now see a network folder icon for the Mac in the My Network Places window. Once you complete Windows’ Add Repeat this procedure Network Place wizard, an icon for your Mac should appear in the My for the rest of your Network Places window. Windows XP systems.



3



Test the connection



To ensure the systems recognize one another, open the Mac’s Go menu, select the Network option, and double-click the Network icon in the left frame of the Network window. You’ll see a few icons in the right frame, one of which is the name of your workgroup. Doubleclick it, and you should see an icon for each PC currently running. Tip: If one of the PCs on your network is running Windows 98, you’ll either have to buy special software to enable On the Mac, when you double-click the icon it to find your for your workgroup, you should see an icon Mac or upfor each PC currently running. grade it to Windows XP. If you decide on the former, we recommend Computer Associates’ $99.95 PC MacLan for Windows 95/98 (www.ca.com).
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Configure a shared printer



To allow the Mac to use a printer physically connected to a port on a networked PC, begin by opening that PC’s Control Panel. Next, doubleclick the Printers and Faxes applet, and rightclick the appropriate printer. Select the Sharing tab, and make sure the “Share this printer” radio button is enabled. Choose a Share name, then click the Apply and OK buttons. (Chances are you’ve already done this if other PCs on your network have been using this printer.) Now open the Mac’s Apple menu and select System Preferences. In the Hardware row, double-click the Print & Fax icon, click the Set Up Printers button, and then double-click the Add icon. In the first and second drop-down boxes, choose Windows Printing and Network Neighborhood, respectively. Double-click the name of your workgroup, and then on the name of the PC to which the printer is connected. Enter the username and password, or just click the OK button if neither is required. Next, highlight the name of the printer and select the appropriate settings via the Printer Model box at the bottom of the Printer List window. Then click the Add button. If you have more than one printer on the network, highlight the new printer, click the Show Info button, and enter a distinctive name to distinguish this printer from the others.



5



The Mac Printer List shows that the default printer is a Deskjet physically connected to one of the network PCs.



On our test system, a network card in our LaserJet printer was connected via cable to our router. If you have a similar setup, you’ll need to know the printer’s IP address, which will be in the form 192.168.2.xxx, in which “xxx” is a three-digit number. Although each network computer usually gets its own address dynamically, the printer address may be static—that is, it doesn’t change as your computers are powered on and off. This means an address conflict could occur if a computer picks up the printer IP address. To avoid such grief, make sure the printer address is set to a number greater than the number of computers on your network. In other words, if four computers are 101 through 104, set the printer to 105 or greater. You may need to play a certain amount of button roulette at the printer panel to discover the current address, and to change it if necessary. Consult your printer manual—each printer does things a little bit differently. Once you have the number down, open the Mac’s Apple menu and select the System Preferences option. In the Hardware row, double-click Print & Fax. Then click the Set Up Printers button and double-click Add. Entries in the two boxes at the top of the window will depend on your particular printer type. If in doubt, try IP Printing and for Printer Type, Internet Printing Protocol. Enter the printer address in the box with that name, and select the appropriate printer via the Printer Model box at the bottom of the window.



6



Print a test page



Unlike your Windows machines, the Mac printer setup lacks a test-page-printing option, so you’ll need to open a document elsewhere to ensure your network is running smoothly. For a quick check, double-click the Macintosh HD icon and open the Applications folder. Next, open the TextEdit applet and type a few test lines. Then open the File menu, select Print, and make sure the right printer is listed. Your Mac and PCs should now be getting along just fine, bringing a touch of harmony to your Windows-driven world.



Configure a network printer To give all computers access to a printer even when the host PC is off, you’ll have to move that printer to the network. Depending on the printer, this may simply require buying the right cable, an external printer server, or a plug-in network card. (On some printers, however, networkability is not an option.)



On your Mac, open the TextEdit applet in the Applications folder to send a short test file to the printer.
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BUYING ADVISOR JOHN A. BUREK



Wi-Fi for the Rest of Us A dial-up devotee wants to share Net access among several PCs wirelessly.



ly a wireless substitute for stringing a phone line to your PC, the Wireless Link doesn’t use Wi-Fi—it creates a microwaveDESPITE THE EYE-BLINK downloads of DSL way” PC must be booted up first. Plus, radio link between a transmitter/receiver and cable broadband, dial-up Net access most modern PCs, if they come with a on your phone line and another that isn’t dead yet. It’s still showing plenty of modem, have an internal software Winplugs into a laptop’s modem and USB pep, if not as much as another, much modem that creates further difficulties— ports. No software or configuration is renewer kind of connectivity—Wi-Fi. And external modems are preferable for quired, but your notebook’s internal moJohn Taylor, this month’s Advisee, is sharing dial-up. dem does the dialing in, meaning that looking to combine these old- and newOne option: Some older, wired-only machine monopolizes the connection. In school technologies. routers (now mainly eBay fodder), as well Taylor’s two-laptop scenario, he’d either “I live in the country,” says Taylor, who as a few current SMC models, have a COM need to buy two Links (and settle for surfruns a home desktop-publishing business port for an external serial-port modem. ing from only one notebook at a time) or in Grants Pass, Ore. “There are tons of But Taylor would also need a wireless do some ancillary ICS configuration, with people living in the outback like us, stuck access point (AP) to bring Wi-Fi into the one of the laptops relying on the other for with dial-up.” Cable and DSL access aren’t scheme—lots of hardware to track down. its connection over Wi-Fi. (The desktop available in his (literal) neck of the woods, It’s possible Taylor could get by with would be out of the loop entirely.) Much and satellite Interjust an external dialtoo messy, and still requires a gateway net’s too pricey. Deup modem and a stancomputer to be booted. spite dial-up’s comdard wireless AP, both Considering these trade-offs, our last parative-trickle connected to his deskoption was outright elegant. The $149.95 throughput, it does top and configured Always On WiFlyer (www.wiflyer.com) is work with today’s using Windows XP’s an external, PDA-size v.92 modem/Wi-Fi wireless networking Internet Connection WAP that also works with broadband conhardware, and that’s Sharing (ICS) utility. In nections. It eliminates the need to have a why Taylor wrote. our tests, however, setgateway PC powered on. (You needn’t wire Like many houseup sometimes reany PCs to it at all.) Setup’s easy: Connect holds, his has several quired meddling with phone, power, and (optionally) Ethernet PCs—a circa-2002 IP addresses and other cables, then peck dial-up settings into a THE CHALLENGE laptop, with a new, networking minutiae Web-browser configuration page. We did second laptop and a sure to give casual PC so, pointed our Wi-Fi laptops to the unit, User profile: John Taylor, of Grants Pass, Ore., proprietor of a desktopdesktop on the way. users the shivers. Also, and in minutes were surfing one dial-up publishing business. The desktop could be this won’t work with connection on three PCs (two wirelessly, Computing needs: Wireless access wired to a phone every AP/modem comand one via the WiFlyer’s Ethernet to a single dial-up account by two line, but Taylor wants bination. It’s worth tryport). All could launch or end a Wi-Fi-equipped laptops. (A wired-in to surf wirelessly ing if you already own session; also, a button enables indesktop’s also in the mix.) Simultanefrom the two notethe hardware, but it stant dial-ups or disconnects. ous Net access by all three is ideal. books—and, potenmay take perseverIn our tests, the WiFlyer tially, all three PCs siance. (In our delivered 220-foot range. Also, THE SOLUTION multaneously—off one tests, with a wireless security is strong: WEP The Advisor’s choice: Always On’s dial-up connection. ZyXel wireless and WPA encryption. (Note: We $149.95 WiFlyer integrates an exterThe laptops would AP and an older also considered Apple’s AirPort nal dial-up modem and a Wi-Fi access tap the connection Diamond hardware Always On Extreme—a similar Wi-Fi AP/ point. Though pricey, it’s the easiest WiFlyer way to share a dial-up connection. using built-in Wi-Fi. modem, we got modem—but gave the WiFlyer Also, any of the systhree PCs—two Wi-Fi the nod; the AirPort can be used in a Wintems should be able to dial in. laptops, one wired desktop—surfing sidows-only network but costs $50 more.) Dial-up and Wi-Fi can be reluctant partmultaneously, but could only reliably initiThe WiFlyer isn’t cheap, but if, like ners, due to dial-up’s connect/disconnect ate the connection from the desktop.) Taylor, you’re saddled with dial-up, it nature. Always-on cable or DSL is easy to Plus, the modem-connected desktop makes sharing it as laid-back as country share through a basic wireless router, but would have to be booted up before Taylor’s living. That’s worth the premium. dial-up is more complicated. A dial-up laptops could get online—not ideal. If you need help making a smart buying decision, modem needs a PC to kick-start the conAnother way is the $49 Nebo Wireless e-mail [email protected]. nection, and the modem-connected “gateLink (www.nebowireless.com). Essential-
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HELP & HOW-TO



CONSUMER ALERT NANCY A. FELDMAN



Just Say No to Rebates I’m accustomed to doling out free advice—only this time, I was the one who was in need of assistance. A while back I wrote a column on the difficulties readers experience receiving rebate checks from retailers and vendors. I recently found myself in the same boat.



AS A CONSUMER ADVOCATE,



Back in December, I purchased a Bluetooth phone and headset, both of which had rebates attached to them through Cingular Wireless. My bad on the headset—I accidentally threw out the packaging with the requisite bar code, so I was out the $30 there. But I did have the box the phone came in, and I carefully followed the instructions to receive my $50 rebate. After about three months, I got my letter back unopened with a stamp across the front saying “Offer Expired.” Indeed, the offer had expired at this point, but I mailed my documentation well in advance of the deadline. The postmark on the envelope was proof of that. When I called the number on the form, an apologetic Minnesotan (I’ve always found Midwest folk to be so much sweeter than us East Coasters) gave me an address to resend my information. Two more months passed, and I again received my unopened letter back with a stamp across the front; this time it said “Return to Sender.” Okay, now I was really miffed. I placed another call to the perpetually ebullient Minnesotans. A lessthan-apologetic customer-service rep who told me he was the supervisor stated the company had no record of receiving my paperwork (of course it didn’t; if nobody opens the envelope, it’s safe to say there would be no record), and “unfortunately, the offer has expired.” He repeated that mantra more than once, and told me in so many words that I should tell my story to someone who cares. He advised me to write to a Mr. Greg Kubal at what he claimed was the “Cingular Office of the President” in Chanhassen, Minn. My conception of cheerful Minnesotans is now officially shattered, as is my belief in their inherent wholesomeness. That’s because I also suspected that not only was Kubal not the president of Cingular Wireless, but that folksy little Chanhassen, Minn., wasn’t really its corporate headquarters. I did a Web search and came up with The Center for Public Integrity (www.public-i.org). The site lists Cingular’s headquarters as Atlanta, Ga., and



122



August 2005 computershopper.com



the president and CEO as Stanley T. Sigman. I also did a reverse lookup (www.reverseaddress. com) for that address in Chanhassen, and was not at all surprised to see the name Young America come up. This is the promotional fulfillment house that makes its living finding new and inventive ways to deny consumers their rightful rebates. Obviously, the ultimate beneficiaries are the companies that contract their services. To cover all bases, I sent my documentation to both Kubal and Sigman, with a letter explaining my plight. As I put final words to page now in June, I received a call from a Linda Myran at the real Cingular office of the president, stating she’d called Young America, and they told her they’d closed their file on me and had declined to give me my rebate. But, she said, she did post a $50 credit to my account, and indeed she had. She apologized for the inconvenience I incurred and hoped my future dealings with Cingular Wireless would go much more smoothly. Although I was happy to receive the $50 credit from Cingular, the fact that Young America denied my rebate was unconscionable. It was nice of Cingular to override the company’s decision, but you don’t have to have an MBA to figure out there are monetary incentives for such companies to issue as few rebate checks as possible. Should you find yourself in a similar situation, my advice is to call the vendor’s customer-service department rather than the fulfillment house. If that doesn’t work, track down the address of the company’s headquarters and go right to the top. Better yet, avoid mail-in rebates altogether. There’s no reason for them other than to cheat you out of the money that’s due you. A price may seem great after a rebate, but there’s no guarantee you’ll ever see the money. So compare the product to its competitors based on its price before the rebate. If it still weighs in as superior in terms of price, features, and quality, go ahead and take your chances. Who knows—you may be one of the fortunate ones who actually receive a check. But if we all say no to rebates, companies may get the message and stop offering them. And with any luck, the kind folk at Young America may be forced to find a more “fulfilling” way of making a living.



The discount may seem great, but there’s no guarantee you’ll ever see your money.



Nancy A. Feldman is executive editor of Computer Shopper magazine. Contact her at [email protected].
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Midrange Desktops Thin-and-Light Notebooks Inkjet Printers External Hard Drives 4- to 5-Megapixel Digital Cameras PC Warranties and Service Plans



NEED TO KNOW



MIDRANGE DESKTOPS ($750 TO $1,499) PROCESSOR Don’t choose an underpowered processor, but look at CPUs one or two steps down from the fastest for the power you need at a good price. Upgrade: Expect to spend $90 for every 200MHz-increment upgrade of Intel 3GHz and faster processors. MEMORY 512MB of memory is standard, but if you can afford 1GB, go for it. Otherwise, make the 512MB a single DIMM; you’ll then have more flexibility to add memory later. Upgrade: Each additional 256MB of DDR memory will cost roughly $50. GRAPHICS Look for a discrete graphics card with at least 128MB of memory. If you plan to do video editing or 3D gaming, go with 256MB of memory. Upgrade: A premium graphics card costs about $220 more than integrated graphics. HARD DRIVE Opt for two hard drives of at least 80GB apiece, configured in a RAID Level 1 array to ensure your data is always backed up. Upgrade: Each additional 40GB of storage will cost about $36.



Model



Base Price*



Processor RAM



Graphics



OPTICAL DRIVES Opt for a DVD±RW as Next month: your first choice. Two drives are better than Budget one, though, so go with a fast CD-RW or Desktops DVD-ROM for the second. CASE Be certain the case offers adequate expansion room. Also, look for a few front-panel ports and audio jacks. Upgrade: A robust power supply (400 watts and higher) will add $50 or more to the price. SOUND Integrated sound is common, and superior to what you’ll find in budget desktops. A dedicated sound card, however, is still a better choice. Upgrade: A quality sound card will cost about $70 more than onboard audio. MONITOR A CRT delivers more viewing space for a few hundred dollars less than similar-size LCDs. But it’s hard to deny the appeal of an attractive, space-saving LCD, so the choice may hinge on your budget and space constraints. Upgrade: 17-inch LCD monitors start as low as $300. —Joshua Goldman, Desktop Editor



Hard Drive



Optical Drive(s)



Monitor



Editor’s Take



Find Out More



ABS COMPUTER TECHNOLOGIES



Ultimate M5-64



$1,149



1.8GHz Athlon 64 3000+



1GB



nVidia GeForce 6600 GT



80GB



DVD-ROM



None



CPU is on the lower end, but it’s a 939-pin chip, so upgrading later is an option. Case leaves room to grow, too.



www.abspc.com 800-876-8088



www.apple.com 800-692-7753



APPLE COMPUTER



eMac



$799



1.42GHz PowerPC G4



256MB



ATI Radeon 9600



80GB



DVD/CD-RW combo



17-inch CRT



A favorite of schools everywhere, an inexpensive, all-in-one way to make the Mac switch.



iMac G5



$1,299



1.8GHz PowerPC G5



512MB



ATI Radeon 9600



160GB



DVD/CD-RW combo



17-inch LCD



Apple has really beefed up its latest iMac G5s with better CPUs, more RAM, and faster graphics.



Gamer Infinity X700 Pro



$819



3GHz Pentium 4 630



512MB



nVidia GeForce 6200



160GB



DVD-ROM, DVD±RW



None



A gamer this PC is not. Change to a tamer case, and this machine will make a decent home-office desktop.



Gamer Ultra 7500 SE



$999



1.8GHz Athlon 64 3000+



512MB



nVidia GeForce 6600



160GB



DVD-ROM, DVD±RW



17-inch LCD



A deal that seems almost too good to be true. Plus, $80 buys extra peace of mind: three years of onsite service.



Gamer Ultra SLI Elite



$1,315



2.2GHz Athlon 64 3500+



1GB



Two nVidia GeForce 6600 GT



200GB



DVD-ROM, DVD±RW



None



Dual graphics cards and a solid midrange processor add up to a choice beginner gaming rig.



Dimension 5100



$899



2.8GHz Pentium 4 520



256MB



ATI Radeon X300 SE



80GB



DVD-ROM



17-inch CRT



New midrange PC offers lots of options— good, because this starting config isn’t particularly strong.



OptiPlex GX280



$1,086



2.8GHz Pentium 4 520



256MB



Integrated



40GB



CD-RW



15-inch LCD



Three-year onsite warranty is standard on Dell business systems. $39 buys you a much-needed 256MB RAM upgrade.



Dimension 9100



$1,299



3GHz Pentium 4 630



512MB



ATI Radeon X300 SE



160GB



DVD-ROM, CD-RW



17-inch CRT



A good bargain and big enough to expand, but the 90-day warranty really hurts this package.



7310S



$799.99



2.8GHz Pentium 4 520J



256MB



Integrated



80GB



CD-ROM



17-inch CRT



Below-average component choices for the money; much better packages can be had in this price group.



9310X



$1,299



3.2GHz Pentium 4 640



512MB



nVidia GeForce 6600G



160GB



DVD/CD-RW combo



17-inch CRT



We like the case, parts, and price. We dislike Gateway’s configurator that automatically adds $300 in upgrades.



CYBERPOWER



www.cyberpowerpc.com 800-707-0393



DELL



www.dell.com 800-999-3355



GATEWAY



www.gateway.com 800-369-1409



* = Base price reflects vendor’s default configuration. Most models are configurable. Prices are subject to change. See computershopper.com for full reviews of products in boldface.
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Model



Hard Drive



Optical Drive(s)



Monitor



Editor’s Take



Find Out More



ATI Radeon X300 SE



160GB



DVD±RW



None



www.hp.com 888-999-4747



1GB



Integrated



200GB



DVD±RW, DVD-ROM



None



1GB



ATI Radeon X300 SE



160GB



DVD±RW



None



A do-it-all PC that comes loaded with software. Want more? Almost every component is configurable. We’d prefer the d4000e for its dedicated graphics. Still, this is a highly capable setup for the average user. Add $20 for an HP LightScribe optical drive that etches labels on CDs and DVDs.



1GB



ATI Radeon X600 XT



160GB



DVD±RW



None



1GB



ATI Radeon X800



160GB



DVD-ROM, CD-RW



None



1GB



nVidia GeForce 6600 GT



160GB



DVD±RW, DVD-ROM



None



2.6GHz Celeron D 330 3GHz Pentium 4 530



256MB



Integrated



40GB



CD-ROM



None



512MB



Integrated



40GB



CD-ROM



None



nVidia GeForce4 MX 420 nVidia GeForce FX 5200 nVidia GeForce FX 5900 XT



40GB



CD-RW



17-inch CRT



123GB



DVD±RW



17-inch LCD



160GB



DVD±RW



19-inch CRT



Processor RAM



Graphics



2GHz Athlon 64 3200+ 3GHz Pentium 4 630 2.8GHz Pentium D 820



1GB



1.8GHz Athlon 64 3000+ 3GHz Pentium 4 530 2.2GHz Athlon 64 3500+



HEWLETT-PACKARD



Pavilion d4000e Series



$919



Pavilion a1040n



$949.99



Pavilion d4100y Series



$999



www.hp.com 888-999-4747



IBUYPOWER



Back To School 64



$819



Gamer EX



$1,189



Gamer-SLI Special Edition



$1,469



If you are, in fact, headed back to school, it has the specs you’ll need at an outstanding price. All RAM is not created equal. For best performance, spend a little more and skip the Value memory offered here. Offers a unique graphics card with two GPUs. Good performance, but we prefer two independent cards.



www.ibuypower.com 888-462-3899



A compact gem for serious business. Specs aren’t the heartiest, but software package is a bonus. Enterprise-ready, small, and easily serviced, but costly considering the feature set.



www.lenovo.com 866-968-4465



At 256MB, RAM is a little stingy, but business users will appreciate the five-year labor warranty. A no-frills system package that offers a well-rounded set of specs and peripherals. A balanced config for taking care of business and pleasure. Includes a 19-inch CRT and 5.1 speaker system.



www.polywell.com 800-999-1278



Lots to like in Sony’s midrange PC, including an enormous hard drive and a large suite of software. Can afford the extra cost over the VGCRB30? If so, go for this model’s faster CPU and dedicated graphics card. A bump up in processor, RAM, and hard drive space over the VGC-RB34G, but still no display.



www.sony.com/pc39 866-823-7669



Not configurable, but there’s already a lot of good stuff here, including the LCD. Integrated graphics is a downer. Another solid home system config. ATI Radeon X600 will even allow for some 3D gaming.



www.systemaxpc.com 888-845-6225



Velocity Micro offers some serious desktop values, but price is too high for this configuration. A few minor upgrades, such as $15 to double the hard drive space, will make this a top-notch business PC. Able Pentium CPU and a solid mix of of parts make this desktop a good midrange buy. Athlon CPU and hearty specs are decent protection against short-term obsolescence.



www.velocitymicro.com 800-303-7866



A sound PC decision—as long as you don’t have high-performance gaming in mind. Passable midrange specs, but at this price, should really include at least a 17-inch CRT monitor.



www.ztgroup.com 866-984-7687



LENOVO



ThinkCentre M51



$859



ThinkCentre S50



$989



POLYWELL COMPUTERS



Poly 845PE-ISA



$999



2GHz Pentium 4



256MB



Poly 865PE



$1,199



512MB



Poly 939VP



$1,351



2.8GHz Pentium 4 520 2.2GHz Athlon 64 3500+ 3GHz Pentium 4 530J 3.2GHz Pentium 4 540J 3.4GHz Pentium 4 550



512MB



Integrated



200GB



DVD±RW, CD-ROM



None



512MB



ATI Radeon X300



200GB



DVD±RW, DVD-ROM



None



1GB



ATI Radeon X300



250GB



DVD±RW, DVD-ROM



None



1GB



Integrated



200GB



DVD±RW



17-inch LCD



1GB



ATI Radeon X600 Pro



120GB



DVD±RW, DVD-ROM



None



256MB



Integrated



80GB



DVD-ROM



None



512MB



nVidia GeForce FX 5200 nVidia GeForce 6600 nVidia GeForce 6600



40GB



DVD-ROM



None



120GB



DVD-ROM, CD-RW



None



120GB



DVD-ROM, CD-RW



None



512MB



SONY ELECTRONICS



VAIO VGC-RB30



$899.99



VAIO VGC-RB34G



$1,149



VAIO VGC-RB38G



$1,349



VGC-RB34G



VGC-RB38G



SYSTEMAX



Ascent AMD



$999.99



Venture HU B550



$1,199



2.4GHz Athlon 64 3400+ 3.4GHz Pentium 4 550



VELOCITY MICRO



Vector PCX



$769



Vector 64 Pro



$815



ProMagix PCX



$1,249



Vision 64



$1,299



3GHz Pentium 4 530 2GHz Athlon 64 3000+ 3GHz Pentium 4 530 2GHz Athlon 64 3200+



512MB



512MB



ZT GROUP



Performance X6545



$879



A5360



$1,029



3.2GHz Pentium 4 540 2.4GHz Athlon 64 3400+



512MB



Integrated



160GB



DVD±RW, CD-RW



None



512MB



nVidia GeForce FX 5200



160GB



DVD±RW



None



* = Base price reflects vendor’s default configuration. Most models are configurable. Prices are subject to change. See computershopper.com for full reviews of products in boldface.
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NEED TO KNOW



THIN-AND-LIGHT NOTEBOOKS (4 TO 7 POUNDS) PROCESSOR Look for a model powered by Intel’s Pentium M processor, which provides good battery life, strong performance, and cool running temperatures. Save a little by opting for lower clock speeds, such as 1.6GHz. Upgrade: Expect to pay about $100 for every 100MHz-increment upgrade of Pentium M processors. MEMORY Adequate RAM is crucial for fast performance, especially when running multiple apps. Opt for at least 512MB of high-speed DDR SDRAM. Upgrade: Each additional 256MB of DDR memory will cost roughly $65. GRAPHICS When choosing a thin-and-light, portability should be a priority. Though many Pentium M-based laptops have robust 3D-graphics chips, save some cash by opting for less-expensive integrated graphics. HARD DRIVE 60GB is a good capacity for most users. If you require speed, select a 5,400rpm drive. Upgrade: Each additional 20GB of storage will cost about $40. OPTICAL DRIVES Most thin-and-light laptops ship standard with versatile DVD/CD-RW combo drives, which should



Base Price* Processor RAM



Model



Graphics



Hard Optical Drive Drive



Next



satisfy the needs of most users. If burning DVDs month: Desktopon the road is a must, choose a multiformat Replacement DVD±RW drive. Upgrade: Expect to pay about Notebooks $140 to upgrade to DVD±RW from a DVD/CDRW combo drive. CASE A laptop chassis more than 1.5 inches thick or heavier than 7 pounds (without AC adapter) exceeds the bounds of the thin-and-light class. WIRELESS CONNECTIVITY Integrated 802.11 wireless networking (Wi-Fi) is an essential feature. Most notebooks ship with a choice of 802.11b or 802.11b/g internal Wi-Fi radios. 802.11b technology, which has a rated data throughput of 11Mbps, is fine for ordinary use. SCREEN Panoramic wide-screen displays, previously available only in larger desktop replacements, are now available in lighter systems. To watch DVD movies in letterbox style or view multiple documents at once, go with a high-res 15.4inch wide-format TFT. Upgrade: A UXGA screen will cost about $100 more than XGA. —Brian Bennett, Notebooks Editor



Wireless Display



Weight Editor’s Take



Find Out More



ABS COMPUTER TECHNOLOGIES



Mayhem G4



$1,549



1.6GHz Pentium M 730



512MB nVidia GeForce 60GB Go 6600



DVD/CD-RW 802.11a/b/g 15.4 inches 6.6 lbs. combo



Expensive, but well-stocked with speedy components and a wide screen.



www.abspc.com 800-876-8088



Aspire $800 AS1414WLCi-XPH



1.3GHz Celeron M 350



512MB Integrated



DVD/CD-RW 802.11b/g 15.4 inches 6.6 lbs. combo



Nicely priced but underpowered. Has enough oomph for basic computing tasks, but not much more.



www.acer.com 800-816-2237



Ferrari 3400LMi



2.16GHz Athlon 64 3000+



512MB ATI Mobility 80GB Radeon 9700



DVD±RW



This pricey, fire-red roadster has the famous Ferrari logo and should serve up nimble mobile performance.



ACER AMERICA



$1,999



40GB



802.11g



15.1 inches 6.6 lbs.



APPLE COMPUTER



iBook G4



$999



1.2GHz 256MB ATI Mobility 30GB PowerPC G4 Radeon 9200



DVD/CD-RW 802.11b/g 12 inches combo



4.9 lbs.



Built for students, an affordable and www.apple.com well-designed low-end Apple, though 800-692-7753 a bit underpowered for the price.



PowerBook G4



$1,499



1.5GHz 512MB nVidia GeForce 60GB PowerPC G4 FX Go5200



DVD/CD-RW 802.11b/g 12 inches combo



4.6 lbs.



Faster, smaller, and more elegant than the iBook, and outfitted with a better graphics engine.



Xplorer U3-1000



$965



1.6GHz Pentium M 725



256MB Integrated



DVD/CD-RW 802.11b/g 12.1 inches 4.1 lbs. combo



Lightweight and affordable with a zippy processor, but could use a memory boost.



Xplorer S4-1000



$1,335



1.5GHz Pentium M 715



256MB ATI Mobility 40GB Radeon 9700 Pro



DVD/CD-RW 802.11g combo



Available in an array of bright colors, but the premium 3D graphics are what makes this model stand out.



Xplorer M6-3000



$1,835



1.6GHz Pentium M 725



1GB



DVD/CD-RW 802.11b/g 15.4 inches 5.7 lbs. combo



Wide-screened, with a roomy hard drive and 1GB of memory, but not cheap.



Inspiron 6000



$849



1.3GHz Celeron M 350



256MB Integrated



40GB



DVD-ROM



None



An eminently affordable machine with www.dell.com great battery life, though not a lot of 800-999-3355 horsepower.



Latitude D610



$1,249



1.6GHz Pentium M 725



256MB Integrated



30GB



CD-ROM



802.11b/g 14.1 inches 4.7 lbs.



Inspiron 600m



$1,321



1.6GHz Pentium M 725



512MB ATI Mobility 40GB Radeon 9000



CYBERPOWER



40GB



ATI Mobility 80GB Radeon 9600



15 inches



6.1 lbs.



www.cyberpowerpc.com 800-707-0393



DELL



15.4 inches 6.7 lbs.



Update to the popular D600 targets business users but remains underconfigured for the price.



DVD/CD-RW 802.11b/g 14.1 inches 5.3 lbs. combo



More to offer than the Inspiron 1000, but specs remain unimpressive for the price.



DVD-ROM



Easy on your back and your wallet, www.fujitsupc.com though light on storage and memory. 800-385-4878 Plus, no CD burner.



FUJITSU COMPUTER SYSTEMS



LifeBook S2000



$1,199



1.5GHz 256MB Integrated Athlon XP-M 1700+



30GB



None



13.3 inches 4.3 lbs.



* = Base price reflects vendor’s default configuration. Most models are configurable. Prices are subject to change. See computershopper.com for full reviews of products in boldface.



134



August 2005 computershopper.com



Model
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Hard Optical Drive Drive



Wireless Display Weight Editor’s Take



Find Out More



FUJITSU COMPUTER SYSTEMS



LifeBook S7000



$1,399



1.6GHz Pentium M 725



256MB Integrated



40GB



DVD/CD-RW 802.11b/g 14.1 inches 4.3 lbs. combo



Lightweight, with a nice-size screen. www.fujitsupc.com Integrated graphics and lack of RAM 800-385-4878 mar an otherwise good configuration.



LifeBook S6000



$1,449



1.6GHz Pentium M 725



512MB Integrated



40GB



DVD/CD-RW 802.11b/g 13.3 inches 4.1 lbs. combo



Very light, but at this price, the small display and integrated graphics are hard to swallow.



GATEWAY



M320S



$799.99 1.3GHz Celeron M 350



256MB Integrated



40GB



CD-ROM



802.11b/g 15 inches



5.5 lbs.



A nice price, but specs are sorely www.gateway.com lacking; not enough power or memory, 800-369-1409 and no CD burner.



M210E



$1,099



1.3GHz Celeron M 350



256MB Integrated



40GB



CD-ROM



802.11b/g 14 inches



5 lbs.



This wide-screen machine may not cost much, but weak CPU and stingy amount of RAM are big trade-offs.



M275X



$1,499



1.7GHz Pentium M 735



256MB Integrated



40GB



DVD/CD-RW 802.11b/g 14.1 inches 5.7 lbs. combo



A bit bulky, but trades extreme portability for extensive Tablet PC functionality and long battery life.



450E



$1,568



1.6GHz Pentium M 725



256MB ATI Mobility 40GB Radeon 7500



CD-ROM



A fast-enough processor, but limited RAM and aging 3D graphics. Overpriced for what you get.



DVD/CD-RW None combo



802.11b/g 14.1 inches 5.8 lbs.



HEWLETT-PACKARD



Pavilion ZE2000 Series



$824



1.5GHz Celeron M 370



512MB Integrated



40GB



15 inches



6.5 lbs.



512MB RAM is decent, but the CPU, www.hp.com graphics, and hard drive in this entry- 888-999-4747 level model need upgrading.



Compaq Presario NC6230



$1,449



1.86GHz Pentium M 750



512MB ATI Mobility 60GB Radeon X300



DVD/CD-RW 802.11b/g 14.1 inches 6.3 lbs. combo



Fast, solid parts for a moderate price. Features a pointing stick and touch pad for comfy mobile computing.



ThinkPad R Series



$999



1.5GHz Celeron M 370



256MB Integrated



DVD/CD-RW 802.11b/g 15 inches combo



Bulky but well-designed. Anemic configuration explains the affordable price.



ThinkPad T Series



$1,299



1.6GHz Pentium M 725



256MB ATI Mobility 40GB Radeon 7500



DVD/CD-RW 802.11b/g 14.1 inches 4.9 lbs. combo



Strong biometric security is the high point of this underpowered, overpriced ThinkPad.



$1,265



1.6GHz Pentium M 725



256MB Integrated



40GB



DVD/CD-RW None combo



14.1 inches 4.9 lbs.



Trim and outfitted with fast processor, www.polywell.com but light on memory and graphics 800-999-1278 power. No built-in wireless capability.



PolyNote 3015AW $2,128



2GHz Pentium M 755



1GB



ATI Mobility 60GB Radeon 9600



DVD/CD-RW None combo



15.1 inches 5.7 lbs.



On the pricey side, but packs a potent CPU, lots of RAM, and respectable graphics. Again, no built-in Wi-Fi.



LENOVO



30GB



6.6 lbs.



www.thinkpad.com 888-746-7426



POLYWELL COMPUTERS



PolyNote 3000N



SONY ELECTRONICS



VAIO FS Series



$1,149



1.6GHz Pentium M 730



256MB Integrated



30GB



DVD-ROM



None



15.4 inches 6.3 lbs.



Elegant and affordable, but lack of www.sony.com/pc39 dedicated graphics, built-in Wi-Fi, or 866-823-7669 a combo drive spoil the deal.



VAIO S Series



$1,275



1.4GHz Celeron M 360



256MB Integrated



40GB



DVD/CD-RW None combo



13.3 inches 4.2 lbs.



Nicely designed and lightweight, but too expensive considering low-end CPU and integrated graphics.



VAIO B Series



$2,249



2GHz Pentium M 755



1GB



Integrated



80GB



DVD/CD-RW None combo



14.1 inches 5.1 lbs.



All business, this light machine isn’t cheap, but comes with a speedy CPU and roomy hard drive.



15 inches



Worth considering if you’re looking for www.toshiba.com affordable style. Heavy, and only 800-316-0920 outfitted to handle the basics.



TOSHIBA AMERICA



Satellite M30X



$849.15 1.3GHz Celeron M 350



256MB Integrated



40GB



DVD/CD-RW None combo



6.6 lbs.



Tecra M3



$1,499



1.6GHz Pentium M 730



256MB nVidia GeForce Go 6200



40GB



DVD-ROM



802.11b/g 14.1 inches 5 lbs.



Moderately configured, attractively styled; has both a pointing stick and a touch pad.



Portégé M200 Series



$1,799



1.6GHz Pentium M 725



256MB nVidia GeForce FX Go5200



40GB



None



802.11b/g 12 inches



Toshiba’s nicely designed convertible isn’t a bargain, but remains a solid Tablet PC choice.



40GB



DVD/CD-RW 802.11b/g 15.4 inches 6.4 lbs. combo



Even though you get a wide-screen www.velocitymicro.com display and Wi-Fi, other components 800-303-7866 aren’t great for the price.



DVD/CD-RW 802.11b/g 15.1 inches 6 lbs. combo



Once the pinnacle of mobile power, speedy machine is still a good deal but starting to show its age.



4.4 lbs.



VELOCITY MICRO



NoteMagix D71



$1,295



1.3GHz Celeron M 350



256MB Integrated



NoteMagix B50 Ultra



$1,495



1.5GHz Pentium M 715



512MB ATI Mobility 40GB Radeon 9700
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INKJET PRINTERS RESOLUTION Resolution figures refer to the maximum number of horizontal and vertical dots a printer can lay down within a 1-inch-square space. In theory, a higher-resolution printer can produce more-detailed text and images, but manufacturers inflate these numbers for marketing purposes, meaning they often have little or no bearing on real-world performance. If possible, make your decision based on viewing actual output from a printer. PRINT SPEED This spec measures how many pages or photos per minute (ppm) a printer spits out. To come up with the fastest-possible speeds, some manufacturers use basic text documents at the lowest-quality settings (draft mode) on plain paper. In our tests, using a printer’s automatic mode for text and its photographicpaper setting for photos, we typically achieve about half the speed the manufacturer promises.



Model



Price



CONNECTIVITY Most printers connect to your PC via USB 2.0, but you’ll have to buy the cable separately. For PC-free printing, look for memory-card slots, and ports that allow for direct printing from supported cameras or external storage devices. Many models also support wireless printing, using infrared, Bluetooth, and Wi-Fi access points with built-in print servers. CONSUMABLES Before you buy, consider the cost of items such as ink and paper. Replacement ink can quickly exceed a printer’s price, running anywhere from $12 to as high as $60 per cartridge. More-expensive printers may actually be more economical in the long run because they often have highercapacity ink tanks and separate tanks for each color. As for paper, use what the manufacturer recommends for the best results. These papers can cost anywhere from 10 cents to $2 per letter-size sheet. —Louis Ramirez, Hardware Editor



Max. Resolution Max. Resolution Number of Number of Max. Print (Color) (Monochrome) Cartridges* Ink Colors Speed** Editor’s Take
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CANON U.S.A.



Pixma iP1500 Photo Printer



$49.99 4,800x1,200dpi



600x600dpi



Two



Four



18ppm



Disappointing output makes this well-priced entry-level model less of a value. Step up to the iP2000.



Pixma iP2000 Photo Printer



$79.99 4,800x1,200dpi



600x600dpi



Two



Four



20ppm



Perfect for budget-conscious small businesses and multitasking families. Great speed, output, and price.



Pixma MP130 Photo All-in-One



$99.99 4,800x1,200dpi



600x600dpi



Two



Four



18ppm



Not ideal for offices because of its small ink tanks, but MFP produces good-looking text and photos.



Pixma iP4000 Photo Printer



$149.99 4,800x1,200dpi



600x600dpi



Five



Five



25ppm



A solid pick for home offices with its double-sided printing and high paper capacity. A good value.



Pixma iP6000D Photo Printer



$179.99 4,800x1,200dpi



4,800x1,200dpi



Six



Six



11ppm



PC-independent printing. Includes a memory-card reader, PictBridge support, and a 2.5-inch LCD.



Pixma i80 Color BubbleJet



$249.99 4,800x1,200dpi



600x600dpi



Two



Four



14ppm



Highly portable; optional car charger and Bluetooth support will benefit those who print on the go.



Pixma iP90



$249.99 4,800x1,200dpi



600x600dpi



Two



Four



16ppm



Update to the popular i80, but for true mobile printing, you’ll need to spring for the $100 battery.



Pixma MP760 Photo All-in-One



$299.99 4,800x1,200dpi



600x600dpi



Five



Five



25ppm



Digital-photo-friendly MFP also scans film negatives and slides. No fax or auto document feeder, though.



Pixma iP8500 Photo Printer



$349.99 4,800x2,400dpi



4,800x2,400dpi



Eight



Eight



16ppm



Offers fast printing speeds and excellent photo and graphics output that will impress photography buffs.



i9900 Photo Printer



$499.99 4,800x2,400dpi



4,800x2,400dpi



Eight



Eight



16ppm



Limited paper-type options, but prints up to 13x19. High-quality, fast color and black-and-white prints.



usa.canon.com 800-652-2666



DELL



Color Printer 720 $49



4,800x1,200dpi



4,800x1,200dpi



Two



Four



13ppm



Rock-bottom price gets you painfully slow print speeds. www.dell.com 800-999-3355



Photo All-in-One Printer 922



$79



4,800x1,200dpi



4,800x1,200dpi



Two



Four



19ppm



Lack of fax function rules this MFP out for most offices. Offers desktop preview feature for copies and scans.



Photo All-in-One Printer 942



$139



4,800x1,200dpi



4,800x1,200dpi



Two



Six



19ppm



Despite the hassle of swapping ink cartridges (and software-only faxing), an easy-to-use inkjet MFP.



Photo All-in-One Printer 962



$159



4,800x1,200dpi



4,800x1,200dpi



Two



Six



20ppm



Fast, decent-looking monochrome prints from this MFP; color output is slow. Includes fax capabilities.



Stylus C66



$69.99 5,760x1,440dpi



5,760x1,440dpi



Four



Four



17ppm



Can print black text at up to 17ppm and color up to www.epson.com 9ppm, while delivering smudge-free, waterproof prints. 800-463-7766



Stylus Photo R200



$99



5,760x1,440dpi



5,760x1,440dpi



Six



Six



15ppm



Expect mediocre text quality and slow photo-print speeds.



Stylus CX4600



$99.99 5,760x1,440dpi



5,760x1,440dpi



Four



Four



15ppm



Despite slow speeds, quality printouts make this a good value for home users.



Stylus Photo R320



$179.99 5,760x1,440dpi



5,760x1,440dpi



Six



Six



15ppm



In addition to its memory-card slots, can also print on CDs and DVDs.



Stylus CX6600



$199.99 5,760x1,440dpi



5,760x1,440dpi



Four



Four



22ppm



Photo-loving MFP is great for digital-camera fans and small offices alike.



EPSON AMERICA



* = Indicates the number of ink cartridges the printer simultaneously hosts. ** = Fastest manufacturer-rated monochrome print speed



= Editors’ Choice
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EPSON AMERICA



PictureMate Deluxe $249.99 5,760x1,440dpi Viewer Edition



5,760x1,440dpi



One



Six



Not rated



Far from a speed demon, this toaster-size model should please the point-shoot-and-print crowd.



Stylus Photo R800



$399



5,760x1,440dpi



5,760x1,440dpi



Eight



Eight



17ppm



Features an eight-color pigment-ink system with a 45-second rated speed for printing 5x7s.



Stylus Photo R2400



$849.99 5,760x1,440dpi



5,760x1,440dpi



Nine



Nine



Not rated



Expensive, but worth it for photo enthusiasts, thanks to advanced black-and-white print modes.



www.epson.com 800-463-7766



HEWLETT-PACKARD



Deskjet 3740



$34.99 4,800x1,200dpi



1,200x1,200dpi



Two



Four



10ppm



Simple and ultra-affordable; delivers 8.5x11- and 4x5-inch prints, albeit slowly.



Deskjet 3845



$69.99 4,800x1,200dpi



1,200x1,200dpi



Two



Six



18ppm



Compact and quiet; surpasses predecessor 3745’s print speeds by 4 pages per minute.



Deskjet 5740



$99.99 4,800x1,200dpi



1,200x1,200dpi



Two



Six



23ppm



Produces borderless prints in sizes up to 8.5x24 inches.



Deskjet 6540



$129.99 4,800x1,200dpi



1,200x1,200dpi



Two



Six



30ppm



One of HP’s fastest inkjets. Nice specs and features for its affordable price.



Business Inkjet 1000



$149.99 4,800x1,200dpi



1,200x1,200dpi



Four



Four



23ppm



Uses four fat ink tanks for fewer refills and better ink capacity. Boring, boxy design.



Business Inkjet 1200d



$199.99 4,800x1,200dpi



1,200x1,200dpi



Four



Four



28ppm



Solid, low-cost option for small offices that seek budget color output but can’t afford laser printing.



Deskjet 6840



$199.99 4,800x1,200dpi



1,200x1,200dpi



Two



Six



30ppm



Compatible with 802.11b/g networks; offers lightning-fast print speeds and good output.



Deskjet 9800



$299.99 4,800x1,200dpi



1,200x1,200dpi



Two



Four



30ppm



Attractively styled medium-format model is capable of prints as big as 13x19 inches.



Deskjet 450wbt Wireless Mobile Printer



$349.99 4,800x1,200dpi



1,200x1,200dpi



Two



Four



9ppm



On-the-road printer delivers great portability, excellent photo quality, and both infrared and Bluetooth printing.



Business Inkjet 3000



$599.99 2,400x1,200dpi



1,200x600dpi



Four



Four



21ppm



Includes 88MB of memory and dual processors for heavy business use.



Business Inkjet 3000dtn



$1,099



1,200x600dpi



Four



Four



21ppm



Network-ready model features HP’s JetDirect 615n internal print server.



2,400x1,200dpi



www.hp.com 888-999-4747



LEXMARK INTERNATIONAL



Z605



$51.94



4,800x1,200dpi



2,400x1,200dpi



Two



Four



14ppm



Accu-Feed technology helps prevent pesky paperfeed jams.



P707



$79.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



17ppm



Sleekly designed, with built-in memory-card reader, but delivers slow, inconsistent print quality.



Z705



$79.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



17ppm



Automatically aligns cartridges and senses paper types.



Z715



$79.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



17ppm



Prints borderless 4x6- and 8.5x11-inch photos.



Z816



$99.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



22ppm



Slick design, but is short on features for the price. Output quality is only average.



P915



$149.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



22ppm



PictBridge compatibility and a 2.5-inch LCD make it a good choice for easy photo prints sans PC.



P6250



$149.99 4,800x1,200dpi



2,400x1,200dpi



Two



Six



22ppm



Compact, beginner-friendly all-in-one isn’t exactly a speed demon; lacks stand-alone fax.



X7170



$199.99 4,800x1,200dpi



2,400x1,200dpi



Two



Four or six



22ppm



Prints great color photos, but poor text and scan quality mar this well-designed, easy-to-use MFP.



www.lexmark.com 800-539-6275



THE BEST RECENTLY REVIEWED INKJET PRINTERS Canon Pixma iP8500 Photo Printer • $349.99 • Editors’ Rating: 8.0 Great performance, simple duplex printing, an eight-color ink set, and flexible paper handling make the easy-to-use iP8500 a winner.



Canon Pixma iP8500 Photo Printer



Epson Stylus Photo R800 • $399 • Editors’ Rating: 8.0 Digital-photography enthusiasts will appreciate the versatile R800’s excellent print quality and fast photo printing. HP Business Inkjet 1200d • $199.99 • Editors’ Rating: 7.5 The 1200d’s low operating costs make it a great choice for an office that needs a durable color printer but doesn’t want to shell out for a laser.
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EXTERNAL HARD DRIVES FORM FACTOR External hard drives come in all shapes and sizes, and most can even be rested vertically to save space on your desk. Some externals are small enough to fit inside your shirt pocket, but these tend to be more expensive and offer less storage space than more conventional drives. Still, sheer portability makes them a great choice for shuttling between home and office. CONNECTIVITY Typically, external drives connect via USB 2.0 or FireWire, and some offer dual interfaces, giving you the option to connect either way. If you have a network setup, you can opt for a network-attached-storage (NAS) drive. NAS drives provide an easy, relatively inexpensive way to add storage to your network. Some are as basic as a hard drive with an Ethernet port; others provide extra USB and FireWire ports that allow you to daisy-chain additional



drives to increase your overall network storage space. If you have a wireless network, you can opt for a Wi-Fi NAS drive that combines storage space with a wireless access point. SPEED The speed at which a hard drive spins, measured in revolutions per minute (rpm), is directly related to how fast it can retrieve data. In an external drive, your best bet is 7,200rpm. BUFFER Look for a drive with an 8MB buffer, rather than a 2MB buffer. The larger buffer enables the drive to deliver data more quickly and can noticeably enhance performance. SOFTWARE Many hard drives come with backup and recovery software to ease the archiving of files on your PC. Instead of purchasing a bare-bones drive, check each drive’s software bundle for the best drive/software combo to suit your personal backup needs. —Louis Ramirez, Hardware Editor



Price



Capacity



Buffer Memory



Spin Rate



Interface



Weight



Editor's Take



Find Out More



80GB EZ Bus DTS SATA 200GB EZ Bus DTC



$139



80GB



8MB



7,200rpm



Serial ATA



2.2 lbs.



www.apricorn.com 800-458-5448



$189



200GB



8MB



7,200rpm



2.2 lbs.



40GB EZ Bus Mini



$249



40GB



2MB



4,200rpm



FireWire, USB 2.0 USB 2.0



5 oz.



100GB EZ Bus USB 2.0 Portable Hard Drive



$289



100GB



2MB



4,200rpm



USB 2.0



6 oz.



Sleek aluminum design. Uses Serial ATA interface; PCI card is included. Supports two interfaces and a variety of synchronizing options. Slow spin rate and small buffer, but tiny size and light weight make it easy to stow. Also extremely totable, this self-powered drive comes with a nylon travel pouch.



$139.99



120GB



2MB



7,200rpm



USB 2.0



3.2 lbs.



www.buffalotech.com 800-456-9799



$399.99



250GB



2MB



7,200rpm



USB 2.0



4 lbs.



Will satisfy users looking for an inexpensive, quick, no-nonsense backup solution. Wireless network-attached storage device features a print server and FTP functionality.



$119.95



80GB



8MB



7,200rpm



USB 2.0



2.2 lbs.



www.iomega.com 888-516-8467



$139.95



40GB



2MB



4,200rpm



7.7 oz.



$189.95



160GB



2MB



7,200rpm



FireWire, USB 2.0 USB 2.0



$229.95



250GB



2MB



7,200rpm



USB 2.0



2.6 lbs.



$279.95



40GB



2MB



4,200rpm



USB 2.0



3.5 oz.



Ideal inexpensive backup solution if your current drive is incredibly small. Low storage capacity, but you’re paying for pocket-size portability. A good choice whether you’re expanding a PC’s storage space or just backing up. Excellent drive for backing up large media files—without having to crack your PC case. Slightly bigger than a pack of smokes, and about 50 times more expensive.



$189



250GB



8MB



7,200rpm



FireWire



2 lbs.



www.lacie.com 503-844-4500



$199



200GB



8MB



7,200rpm



3.3 lbs.



$249



160GB



8MB



7,200rpm



FireWire 400/800, USB 2.0 Serial ATA



Light, fast and spacious, this is one Porsche you can actually afford. Plug-and-play drive is quiet, built like a tank, and supports three interfaces.



$249



100GB



8MB



5,400rpm



$279



80GB



8MB



$299



250GB



$399



Model APRICORN



BUFFALO TECHNOLOGY



DriveStation USB 2.0 External Hard Drive LinkStation Network Storage Center IOMEGA



HDD 80GB USB 2.0 Desktop HDD 40GB USB 2.0/FireWire Portable HDD 160GB USB 2.0 Desktop HDD 250GB USB 2.0 Desktop HDD 40GB Mini Hard Drive USB 2.0



2.6 lbs.



LACIE



Porsche Hard Drive 250GB d2 Hard Drive Extreme With Triple Interface d2 Hard Drive Serial ATA 160GB Porsche Mobile Hard Drive 100GB Silverscreen 80GB Ethernet Disk Mini 250GB Big Disk With Triple Interface 500GB



3.3 lbs.



5,400rpm



FireWire, USB 2.0 USB 2.0



6.4 oz. 9.5 oz.



8MB



7,200rpm



USB 2.0



3.3 lbs.



500GB



8MB



7,200rpm



FireWire 400/800, USB 2.0



5.5 lbs.



$149.95



80GB



2MB



7,200rpm



USB 2.0



3.1 lbs.



$199.95



160GB



8MB



7,200rpm



FireWire



3.1 lbs.



$229.95



200GB



8MB



7,200rpm



3.1 lbs.



$299.95



300GB



16MB



7,200rpm



$599.95



200GB



8MB



7,200rpm



FireWire, USB 2.0 FireWire, USB 2.0 USB 2.0



New SATA drive promises extreme speed; SATA PCI card comes bundled. Ultrasmall; can be shared easily among Mac and PC users. Portable; features handy A/V outputs and remote control for viewing multimedia files. Easy-to-use network storage for homes and small offices. Stylish design, tons of storage space, and triple interface make this a winner.



MAXTOR



OneTouch 80GB USB Drive OneTouch 160GB FireWire Drive for Mac OneTouch 200GB FireWire/USB Drive OneTouch II 300GB FireWire/USB Drive OneTouch II Small Business Edition
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3.1 lbs. 3.1 lbs.



Attractive but pricey. Better gig-per-dollar deals abound. Doesn’t include USB 2.0 interface, but is formatted to work with today’s Macs. Expensive, even for a high-capacity external drive with dual interfaces. Premium price, but you get lots of space and added buffer memory. DriveLock feature password-protects files in case drive is lost or stolen.



www.maxtor.com 800-262-9867



CONTINUES ON PAGE 142



TECHMARKET HARD DRIVES Model



Capacity



Buffer Memory



Spin Rate



Interface



Weight



Editor's Take



Find Out More



$179



5GB



2MB



3,600rpm



USB 2.0



2.2 oz.



www.seagate.com 877-271-3285



$179



160GB



8MB



7,200rpm



USB 2.0



2.6 lbs.



$219



200GB



8MB



7,200rpm



2.6 lbs.



$259



100GB



8MB



5,400rpm



FireWire, USB 2.0 USB 2.0



$389



400GB



8MB



7,200rpm



FireWire, USB 2.0



2.6 lbs.



Portable with a cool hockey-puck design, but speed and capacity don’t justify price. Provides a healthy amount of storage space at a relatively low price. Dual interface accommodates both Macs and PCs. Durable PDA-size drive is ideal for frequent fliers. BounceBack Express allows for fast and simple backups.



$147



120GB



2MB



7,200rpm



USB 2.0



2 lbs.



www.simpletech.com 800-367-7330



$178



160GB



2MB



7,200rpm



2 lbs.



$273



80GB



2MB



4,200rpm



FireWire, USB 2.0 USB 2.0



$369



250GB



8MB



7,200rpm



USB 2.0



2.5 lbs.



$418



400GB



8MB



7,200rpm



FireWire, USB 2.0



2 lbs.



Funky-looking desktop drive could use a boost in the buffer department. Few features for the price, save its dual interfaces. Compact and travel-friendly, but overpriced considering its features and capacity. Network-attached storage comes at a premium price with this drive. Massive storage with an equally hefty price tag.



$129.99



120GB



2MB



7,200rpm



USB 2.0



2.9 lbs.



www.wdc.com 949-672-7000



$189.99



160GB



8MB



7,200rpm



3.1 lbs.



$199.99



80GB



2MB



5,400rpm



FireWire, USB 2.0 USB 2.0



$199.99



250GB



2MB



7,200rpm



USB 2.0



3.2 lbs.



$249.99



250GB



8MB



7,200rpm



3.1 lbs.



$279.99



320GB



8MB



7,200rpm



$299.99



320GB



8MB



7,200rpm



FireWire, USB 2.0 FireWire, USB 2.0 FireWire, USB 2.0



Handy dual-option feature lets you set ondemand or automatic backups. Provides more space, speed than above drive, plus dual interfaces. Highly compact and draws power from USB; no need to carry a power cord. Bare-bones drive is short on features, but big on space. Features an attractive light-up exterior and dual interfaces. Whisper-quiet drive offers massive storage capacity at a fair price. Multimedia junkies will enjoy this spacious drive with its eight-format card reader.



Price



SEAGATE TECHNOLOGY



5GB USB 2.0 Pocket Hard Drive 160GB USB 2.0 External Hard Drive 200GB Pushbutton Backup 100GB Portable External Hard Drive 400GB Pushbutton Backup



10.3 oz.



SIMPLETECH



120GB SimpleDrive External 160GB SimpleDrive Deluxe External 80GB SimpleDrive Portable SimpleShare Office Storage Server 400GB SimpleDrive Deluxe External



1.5 lbs.



WESTERN DIGITAL



Dual-Option Backup USB 2.0 External 160GB Dual-Option Combo External Drive Passport Portable USB Drive USB 2.0 Hard Drive WD Essential Firewire/USB 2.0 Lighted Drive 320GB Dual-Option Combo External Drive Dual-Option Media Center



9.8 oz.



3 lbs. 3 lbs.
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It’s time for a really powerful monitor! By performing fast reactions to multiple information sources, DoubleSight users can experience significant productivity increases ranging from 20 to 50% by easily managing their multiple programs simultaneously.



15” DESKTOP SOLUTION



Imagine the possibilities...



NOTEBOOK SOLUTION The new DoubleSight dual LCD monitor is an attractive, space saving and cost effective alternative to large CRT monitors that consume a lot of physical desktop space or expensive LCD monitors. DoubleSight monitors provides an economic, easy to use technique for seamlessly displaying as much data as possible. For more information, please visit www.doublesight.com



19”



www.doublesight.com toll free: 1-877-896-5237
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17”



1-949-253-1535 ext. 211



NEED TO KNOW



DIGITAL CAMERAS (4- TO 5-MEGAPIXEL) RESOLUTION The quality of digital photos is measured primarily by the number of pixels a camera’s image sensor can capture. A 5-megapixel camera, therefore, should capture more image detail than a 4-megapixel model. Still, whether you choose a 4- or a 5-megapixel camera, you should be able to print good-quality images up to 11x17 inches. Lower-resolution models are better suited to snapshot-size prints. LENS The ability of a digital camera’s lens to magnify faraway action (that is, its optical zoom) is measured in x. Look for a model with at least a 3x optical zoom, or more if you often need to catch distant action. Pay no attention to digital-zoom specs. A glass lens is preferable to a plastic one, though vendors often don’t specify what you get. STORAGE MEDIUM Most digicams use wafer-thin flashmemory cards like CompactFlash, SD/MultiMediaCard, Olympus’ xD-Picture Card, or Sony’s Memory Stick. Cameras usually come with a small-capacity card, so you’ll want



Next



to invest in an additional, roomier card with at month: 3.2least 128MB or 256MB to store more photos. Megapixel If you already have a PDA or a flash-based MP3 Cameras player, consider cameras that use the same storage format so you can share cards between devices. BATTERY Some cameras offer only a proprietary rechargeable battery, usually either lithium-ion or nickelmetal-hydride, that can’t be swapped out if it runs out of power while you’re shooting. Better are models that can also handle disposable lithium or alkaline batteries you can carry with you to use in a pinch. VIDEO RECORDING Many digicams can record short video clips. (A number also record sound with the video.) Some models limit recording to 30 seconds or less, while others will record as long as your storage will allow. A number of cameras can record up to 30 frames per second and/or at VGA quality (640x480 pixels). —Sean Portnoy, Hardware Editor



Price



Resolution Optical Included Storage (Megapixels) Zoom Memory Type



Battery Type



Weight Editor’s Take



Find Out More



PowerShot A520



$279



4



4x



16MB



SD/MMC



AA



6.4 oz.



usa.canon.com 800-652-2666



PowerShot A95



$349



5



3x



32MB



CompactFlash AA



8.3 oz.



PowerShot SD20



$349



5



None



32MB



SD/MMC



Proprietary 3.5 oz.



PowerShot SD300



$349



4



3x



16MB



SD/MMC



Proprietary 4.6 oz.



PowerShot S60



$399



5



3.6x



16MB



CompactFlash Proprietary 8.1 oz.



PowerShot SD400



$399.99 5



3x



16MB



SD/MMC



Proprietary 4.6 oz.



Smaller and lighter than the bulky A95, and a longer zoom, but the same old image processor. A full feature set for its class, with impressive photo quality. Plus, it’s newbie-friendly. Offers high resolution in a tiny package, but lacks optical zoom and an optical viewfinder. Large LCD for its size; also promises fast shooting with its Digic II image processor. Nearly identical to 7-megapixel S70, but produces images with some purple fringing and slightly less sharpness. Features a 60-frame-per-second movie mode, a Special Scene mode, and the Digic II image processor.



QV-R51



$229.99 5



3x



SD/MMC



AA



$249.99 4



3x



SD/MMC



Proprietary 4.3 oz.



Exilim EX-Z50



$299.99 5



3x



SD/MMC



Proprietary 4.3 oz.



Exilim EX-Z55



$349.99 5



3x



SD/MMC



Proprietary 4.3 oz.



Exilim EX-Z57



$379.99 5



3x



SD/MMC



Proprietary 4.5 oz.



Exilim Pro EX-P505



$499.99 5



5x



SD/MMC



Proprietary 7.6 oz.



Reasonably priced for a well-built, compact 5-megapixel shooter with a 2-inch LCD. Lightweight shooter with a nice-size 2-inch LCD, but takes only so-so images. Adds an extra megapixel to the EX-Z40, but delivers the same mediocre images; few manual features. The EX-Z50 with a larger (2.5-inch) LCD, for an extra $50. Outstanding battery life. Bumps up the Exilim series’ LCD size to 2.7 inches. Onscreen RGB histogram for exposure info at a glance. Features a flip-out 2-inch LCD, along with 30-frame-persecond, VGA-quality MPEG-4 video recording.



www.casio.com 800-962-2746



Exilim EX-Z40



9.7MB (internal) 9.7MB (internal) 9.3MB (internal) 9.3MB (internal) 9.3MB (internal) 7.5MB (internal)



www.concord-camera.com 954-331-4200



Model CANON U.S.A.



CASIO



5.9 oz.



CONCORD CAMERA



Eye-Q 4363Z



$149.99 4.1



3x



16MB (internal)



SD/MMC



AA



5.6 oz.



Great price for features, but judging from past models, expect only average image quality.



$179.95 4



3x



SD/MMC



3x



$249.95 5



3x



$249.95 4



2.8x



AA or CR-V3 AA or CR-V3 AA or CR-V3 Proprietary



6.3 oz.



$249.95 5



$299.95 4



5x



$349.95 5



2.8x



$349.95 5



4x



$379.95 5



10x



16MB (internal) 16MB (internal) 32MB (internal) 16MB (internal) 16MB (internal) 32MB (internal) 32MB (internal) 32MB (internal)



Intuitive controls, strong performance, and decent images www.kodak.com make this model a good value. 800-521-0788 Compact point-and-shoot has imaging features the CX7530 doesn’t, but half the internal storage space. Bumps resolution up a megapixel, doubles internal memory, and adds a larger LCD over the CX7430. Slim design, good burst mode, and great battery life make up for anemic optical zoom. Decent price for a 5x all-glass optical zoom lens, but the LCD is only 1.6 inches. Adds a megapixel to the LS743, but maintains the same weak zoom lens. Larger zoom than the LS753, but on the hefty side for a point-and-shoot. Advanced manual and custom controls. Comes with an all-glass lens. Really steps up the optical zoom from the Z730.



EASTMAN KODAK



EasyShare CX7430 Zoom EasyShare C340 Zoom EasyShare CX7530 Zoom EasyShare LS743 Zoom EasyShare Z700 Zoom EasyShare LS753 Zoom EasyShare Z730 Zoom EasyShare Z740 Zoom



SD/MMC SD/MMC SD/MMC SD/MMC



5.1 oz. 6.8 oz. 5.8 oz.



SD/MMC



AA or 7.7 oz. CR-V3 Proprietary 5.8 oz.



SD/MMC



Proprietary 7.9 oz.



SD/MMC



AA or CR-V3



10.1 oz.
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TECHMARKET DIGITAL CAMERAS (4- TO 5-MEGAPIXEL) Model



Price



Resolution Optical Included Storage (Megapixels) Zoom Memory Type



Battery Type



Weight Editor’s Take



Find Out More



EASTMAN KODAK



EasyShare DX6490 Zoom EasyShare DX7590 Zoom EasyShare Z7590 Zoom



$399.95 4



10x



$499.95 5



10x



$449.95 5



10x



16MB (internal) 32MB (internal) 32MB (internal)



SD/MMC



Proprietary 11.9 oz.



SD/MMC



Proprietary 12.3 oz.



SD/MMC



Proprietary 12.3 oz.



Big zoom lens and lots of manual controls, offset by middling image quality. Mediocre images drop this full-featured shooter down a few notches. Larger LCD than the Z740, and adds an electronic viewfinder.



FUJI PHOTO FILM U.S.A.



FinePix A345



$249



4.1



3x



16MB



xD-Picture Card AA



4.7 oz.



FinePix E510



$269



5.2



3.2x



16MB



xD-Picture Card AA



6.2 oz.



FinePix S3100



$279



4



6x



16MB



xD-Picture Card AA



10.1 oz.



FinePix A350



$299



5.2



3x



16MB



xD-Picture Card AA



4.7 oz.



FinePix S5100



$349



4



10x



16MB



xD-Picture Card AA



11.9 oz.



FinePix F450



$399



5.2



3.4x



16MB



xD-Picture Card Proprietary 5.3 oz.



FinePix Z1



$449



5.1



3x



16MB



xD-Picture Card Proprietary 4.6 oz.



16MB (internal) 16MB (internal) 16MB (internal) 32MB (internal) 32MB (internal)



SD/MMC



AA



4.2 oz.



SD/MMC



AA



5.1 oz.



SD/MMC



AA



5.3 oz.



SD/MMC



Proprietary 5.3 oz.



SD/MMC



CP1 or proprietary



SD/MMC



Proprietary 8.5 oz.



Fuji’s A-series cameras are built for ease of use—don’t expect frills or manual features. Decent zoom lens with superb wide-angle performance, and less expensive than the 5-megapixel F450. Point-and-shoot in a dSLR body. Sweet 6x optical zoom is a bonus, though the plastic body feels a bit flimsy. $50 more than the A345 for a 1-megapixel boost and a slightly better digital zoom. Compact for a megazoom model with an advanced feature set and solid performance. Squeezes a generous-size LCD and a better-than-average zoom into a compact body. Sleek compact with an internal zoom lens. Extras like ISO up to 800 and natural-light mode will please snapshooters.



www.fujifilm.com 800-659-3854



Weather-resistant body. Creates panorama shots and features in-camera red-eye removal. No optical zoom. Offers a bargain price and 1.8-inch LCD in a chic casing. Options are basic, with most everything automatic. M407’s successor increases resolution and adds red-eye removal in a similar form factor. Pocketable and lightweight, this sleek-looking compact has a bevy of automatic and manual options. Adds an extra megapixel to the R607 while keeping all of its other features, like HP’s Real Life technologies.



www.hp.com 800-282-6672



HEWLETT-PACKARD



Photosmart M22



$149.99 4.1



None



Photosmart M407



$179.99 4.1



3x



Photosmart M417



$199.99 5.2



3x



Photosmart R607



$199.99 4.1



3x



Photosmart R707



$249.99 5.1



3x



7 oz.



KONICA MINOLTA PHOTO IMAGING U.S.A.



DiMage X60



$349.99 5



3x



2.8x



15MB (internal) 14.5MB (internal) 16MB



DiMage Z20



$399



5



8x



DiMage X50



$449



5



DiMage Z5



$649



5



Tiny pocket shooter loses viewfinder for 2.5-inch LCD. Internal zoom lens enables under-a-second startup times. AA 10.6 oz. Odd form factor has big zoom lens, but a small 1.5-inch LCD; VGA-quality video is limited to 15fps. Proprietary 4.4 oz. The first of the svelte X series to provide 5-megapixel resolution. It’s fast, too, with startup time under 2 seconds. AA 12 oz. Great 12x zoom lens is supported in movie mode—a bonus. Should appeal to tweak-hungry enthusiasts.



kmpi.konicaminolta.us 800-509-9022



SD/MMC



12x



16MB



SD/MMC



14MB (internal) 14MB (internal) 13.5MB (internal) 13.5MB (internal) 12MB (internal) None



SD/MMC



AA



4.6 oz.



www.nikonusa.com 800-645-6687



SD/MMC



AA



4.6 oz.



SD/MMC SD/MMC



CP1 or 5.3 oz. proprietary Proprietary 9 oz.



SD/MMC



Proprietary 5.5 oz.



xD-Picture Card AA or 4.9 oz. CR-V3 xD-Picture Card AA or 5.3 oz. CR-V3 xD-Picture Card Proprietary 4.4 oz.



SD/MMC



NIKON



Coolpix 4600



$199.95 4



3x



Coolpix 5600



$249.95 5.1



3x



Coolpix 5900



$299.95 5.1



3x



Coolpix 4800



$349.95 4



8.3x



Coolpix 5200



$399.95 5.1



3x



D2Hs



$3,500 4.1 (body only)



Varies by lens



CompactFlash Proprietary 2.4 lbs.



Highlights include in-camera red-eye correction and D-Lighting feature for poorly lit shots. Extra megapixel over the 4600; has an underwater mode to be used with an optional underwater housing. One of first Coolpix cams to feature a 2-inch LCD; features Face-Priority Autofocus for better portraits. Newbie-friendly, with a big zoom lens. Limited manual controls, but packed with automatic assistance. Fit for beginners looking for large prints, but the qualityconscious should look at Casio’s EX-P505 instead. Solidly built prosumer model with long battery life, but expensive for its resolution, and a steep learning curve.



OLYMPUS AMERICA



D-545 Zoom



$179.99 4



3x



D-595 Zoom



$249.99 5



3x



D-630 Zoom



$299.99 5



3x



Stylus 410 Digital Stylus Verve



$299.99 4



3x



14MB (internal) 14MB (internal) 14MB (internal) 32MB



$299.99 4



2x



16MB



xD-Picture Card Proprietary



C-5500 SportZoom $349.99 5.1



5x



16MB



xD-Picture Card AA



IR-300



$349.99 5



3x



xD-Picture Card Proprietary



IR-500



$349.99 4



2.8x



16MB (internal) 16MB



Stylus Verve S



$349.99 5



2x



16MB



xD-Picture Card Proprietary



C-770 Ultra Zoom



$399.99 4



10x



16MB



xD-Picture Card Proprietary



xD-Picture Card Proprietary



xD-Picture Card Proprietary
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Built-in help system—plus 19 scene modes—will please beginners, though little here for manual tweakers. Options for manual aperture and shutter-speed control give budding shutterbugs room to grow. Compact model manages to house a 2-inch LCD; don’t expect to shoot VGA-quality video, however. 5.6 oz. A compact, splash-proof model with 10 scene modes. A/V connector for directly displaying images on a TV. 3.7 oz. Eye-catching design can’t hide the weak zoom lens; no optical viewfinder, and mediocre photos. 8.6 oz. Bulky sport-centric shooter with fast startup time, good zoom lens, and high-speed 2.7fps sequential shooting. 4 oz. Part of Olympus’ Total Imaging Solution line, this pointand-shoot has many auto settings and easy-share options. 5.5 oz. A step down in zoom and resolution from IR-300, but adds a larger, rotating LCD, VGA video, and manual controls. 4.1 oz. Higher resolution than the original Verve, along with new all-weather body, but keeps weak 2x zoom. 10.6 oz. Full manual controls, versatile zoom, and solid battery life. Lack of RAW-format support may dissuade enthusiasts.



www.olympusamerica.com 888-553-4448



Model



Price



Resolution Optical Included Storage (Megapixels) Zoom Memory Type



Battery Type



Weight Editor’s Take



Find Out More



Movie mode is strictly low-res, but its zoom, imagestabilization feature, and 2-inch LCD are worth the price. Same compact design and specs as the DMC-LZ1, but adds an extra megapixel of resolution for $50 more. 2.5-inch display, and great resolution and zoom for its small size. Pricey considering its other specs, though. Lowest-cost 12x zoom, but comes with a paltry memory card and small (1.5-inch) LCD. In addition to a resolution increase over the DMC-FZ4, doubles the size of memory card. A remarkable zoom lens, solid manual focus, and generally speedy performance. Handling is just mediocre, however. Well-made advanced-shooter’s cam with several unique and efficient analog controls, though large and heavy.



www.panasonic.com 800-662-3537



Affordable compact that takes pleasing images. Shooting speed, on the other hand, is quite slow. Stylish ultracompact has lots of modes to offer and decent picture quality. Tiny size may not work well for big hands. One of the smallest, lightest 5MP cameras around; a function key lets you create shortcuts to adjust settings. WP equals waterproof. Take this feature-laden cam into the pool for close-ups with its internal zoom.



www.pentaximaging.com 800-877-0155



Pocket cam that’s as light on features as it is in actual heft. Good price and resolution, but little else. For $40 more than the A402, you get a lot more, including a 2-inch LCD, 3x zoom, and VGA video with audio. Like the A402, small and light, but lacks features found on other 5-megapixel models—notably, optical zoom. Good specs for the price, plus a handful of manual controls. Uses colored lights to relay system status. Includes interesting features like auto macro, plus the ability to charge using a cell-phone charger.



www.samsungcamerausa.com 800-726-7864



Entry-level Stamina series model promises better battery life; solid specs, but the 1.5-inch LCD is too small.



www.sony.com/pc39 866-823-7669



PANASONIC



Lumix DMC-LZ1



$249.95 4



6x



SD/MMC



AA



7.8 oz.



SD/MMC



AA



7.8 oz.



3x



14MB (internal) 14MB (internal) 16MB



Lumix DMC-LZ2



$299.95 5



6x



Lumix DMC-FX7



$399.95 5



SD/MMC



Proprietary 4.8 oz.



Lumix DMC-FZ4



$449.95 4



12x



8MB



SD/MMC



Proprietary 11.5 oz.



Lumix DMC-FZ5



$499.95 5



12x



16MB



SD/MMC



Proprietary 11.5 oz.



Lumix DMC-FZ20



$599.99 5



12x



16MB



SD/MMC



Proprietary 1.1 lbs.



Lumix DMC-LC1



$1,599



3.2x



16MB



SD/MMC



Proprietary 1.4 lbs.



11MB (internal) 10MB (internal) 9.3MB (internal) 10.5MB (internal)



SD/MMC SD/MMC



AA or 6.3 oz. CR-V3 Proprietary 4.2 oz.



SD/MMC



Proprietary 4.2 oz.



SD/MMC



Proprietary 4.8 oz.



SD/MMC



AA or 3.9 oz. CR-V3 AA or 4.9 oz. CR-V3 Proprietary 3.9 oz.



5



PENTAX IMAGING



Optio S50



$299.95 5



3x



Optio S5i



$299.95 5



3x



Optio S5z



$349.95 5



3x



OptioWP



$349.95 5



3x



SAMSUNG ELECTRONICS



Digimax A402



$139.99 4



None



Digimax A400



$199.99 4



3x



Digimax U-CA 505 $209.99 5



None



Digimax A5



$239.99 5



3x



Digimax U-CA5



$289.99 5.1



3x



16MB (internal) 16MB (internal) 16MB (internal) 16MB (internal) 32MB



SD/MMC SD/MMC SD/MMC SD/MMC



AA or 5.9 oz. CR-V3 Proprietary 4.6 oz.



SONY ELECTRONICS



Cyber-shot DSC-S40



$199.95 4.1



3x



32MB (internal)



Cyber-shot DSC-L1 Cyber-shot DSC-S60



$249.95 4.1



3x



16MB



$249.95 4.1



3x



32MB (internal)



Cyber-shot DSC-S90



$299.95 4



3x



32MB (internal)



Cyber-shot DSC-F88



$399.95 5.1



3x



32MB



Cyber-shot DSC-T33 Cyber-shot DSC-H1



$399.95 5.1



3x



32MB



$499.95 5.1



12x



32MB (internal)



Cyber-shot DSC-T7



$499.95 5.1



3x



32MB



Memory Stick, Memory Stick Pro Memory Stick Duo, Pro Duo Memory Stick, Memory Stick Pro Memory Stick, Memory Stick Pro Memory Stick, Memory Stick Pro Memory Stick Duo, Pro Duo Memory Stick, Memory Stick Pro Memory Stick Duo, Pro Duo



AA



4.8 oz.



Proprietary 4 oz. AA



7 oz.



AA



7.1 oz.



Quick, slick ultracompact with excellent battery life and easy operation. Image quality is subpar. Boosts the DSC-S40’s LCD size by half an inch, and adds options like control over aperture and shutter speed. Raises the DSC-S60’s 2-inch LCD to 2.5 and adds highcapacity NiMH batteries and charger.



Proprietary 6 oz.



Unique rotating lens captures shots at all angles. Excellent macro abilities, plus strong image quality and battery life.



Proprietary 5.3 oz.



32MB of built-in memory, 2.5-inch LCD, and 10 preset scene modes, all packed in a sleek body just 0.75 inch thin. Uses optical image stabilization to reduce camera shake on distance shots; includes 2.5-inch LCD, manual mode.



AA



1.5 lbs.



Proprietary 4.7 oz.



No lack of features, but ultraslim size contributes to the cost.



THE BEST RECENTLY REVIEWED DIGITAL CAMERAS (4- TO 5-MEGAPIXEL) Canon PowerShot SD400 • $399.99 • Editors’ Rating: 7.4 Long battery life and improved image quality make this high-performance ultracompact one of the better choices in the current Canon Digital Elph lineup.



Casio Exilim Pro EX-P505



Casio Exilim Pro EX-P505 • $499.99 • Editors’ Rating: 7.2 One of the best attempts at combining high-quality photo capture and decent video capabilities with a 5x zoom that is fully functional while recording video. Konica Minolta DiMage X50 • $449 • Editors’ Rating: 6.8 A slim, speedy, and stylish compact camera that’s as easy on the eyes as it is to use with extras like in-camera editing and resizing.



computershopper.com August 2005



145



NEED TO KNOW



WARRANTIES & SERVICE PLANS FOR DESKTOPS & NOTEBOOKS TERM Major vendors such as Dell and Gateway are trying to set the benchmark for support at 90 days, but no PC owner should settle for a warranty that short. If you’re looking at a term shorter than one year, consider an extended service plan. Fine Print: Most extended plans require you to purchase them before the standard warranty has expired. PARTS COVERAGE As a rule, standard warranties cover your computer’s main hardware components (CPU, hard drive, RAM). Software and peripherals, such as monitors and keyboards, are usually covered by their manufacturers’ warranties or an optional service plan. Keep in mind that extended service plans for PCs still won’t cover these extras—they only lengthen the coverage period of the standard warranty. Fine Print: Some vendors don’t cover parts you’ve upgraded from a PC’s base configuration. DAMAGE PROTECTION Under a standard warranty, vendors will repair computers damaged during shipping or with defective parts. Notebook owners and the accident-prone should invest in an accidental damage protection (ADP) plan



Plan



Price



to insure their PCs against falls, spills, and regular wear and tear. Fine Print: ADP plans aren’t available in all states. REPAIRS Many vendors offer depot service, which requires a customer to return a PC to an authorized factory or service center for major repairs and parts replacement. If you get a service plan that includes onsite repair, a computer technician will fix your PC at your home, usually by the next business day. Fine Print: A host of eligibility restrictions usually apply to getting onsite service. Consult your service contract before buying. TECHNICAL SUPPORT Phone and online chat are generally the most effective forms of tech support, but an easily navigable online knowledge base can help you solve simple computer problems at home, without waiting on hold. TERMS & CONDITIONS While the warranty and support information below applies to most of each vendor’s offerings, terms and conditions can vary by system or system line. Always review the terms for your particular PC carefully before buying. —Erin Kandel, Editorial Assistant



Term



AccidentalDamage Onsite Repair/ Free Online Protection Return-to-Depot Knowledge (ADP) Service Base



One year



No



No/yes



Yes



11:30 a.m. to 8:30 p.m. (ET)



Yes/no



Marred by limited phone hours. Plan includes online help forum, but no live chat.



Toll-Free Phone Support Hours



E-Mail Support/ Live Chat



ABS COMPUTER TECHNOLOGIES



Standard Warranty



Free



Editor’s Take www.abspc.com • 800-876-8088



APPLE COMPUTER



www.apple.com • 800-692-7753



Limited Warranty



Free



One year



No



No/yes



Yes



24 hours daily (90 days)



Yes/yes (90 days)



Apple’s massive knowledge base is one of the best in the biz, but skimpy 90-day support is a real bummer.



AppleCare Protection Plan



$149 to $349



Three years



No



Yes (desktops)/yes



Yes



24 hours daily



Yes/yes



A necessity for all but the bravest to bolster the standard, measly 90 days of support. Covers hardware and software.



Free



One year No (notebooks); three years (desktops)



No/yes



No



24 hours daily



Yes/no



Cyberpower doesn’t sell an extended plan, but the free limited warranty provides decent long-term protection. But the company doesn’t cover shipping costs for depot repairs.



Limited Warranty



Free



90 days



No



Yes/yes



Yes



24 hours daily (one year)



Yes/yes



Onsite repair and one year of phone support don’t justify this plan’s paltry 90-day term.



Extended Services Plan



$19 and up



One to four years



No



Yes/yes



Yes



24 hours daily



Yes/yes



Three- and four-year plans include global support for laptops and additional onsite-repair hours.



CompleteCare Agreement



$59 (desktops); $79 to $199 (notebooks)



One to four years



Yes



Yes/yes



Yes



24 hours daily



Yes/yes



Nicely priced plan has some caveats: doesn’t cover all components, and notebooks require at least a threeyear contract.



CYBERPOWER



Limited Warranty



www.cyberpowerpc.com • 800-707-0393



DELL



www.dell.com • 800-999-3355



FUJITSU COMPUTER SYSTEMS



www.fujitsupc.com • 800-385-4878



International Limited Warranty



Free



One year



No



No/yes



Yes



24 hours daily



Yes/yes



Solid, no-frills coverage provides peace of mind for one year, but doesn’t include shipping costs for depot repairs.



Extended Warranty



$99.95 (one year); $179.95 (two years)



One year; two years



No



No/yes



Yes



24 hours daily



Yes/yes



Note: This warranty extension must be activated within 30 days of the date of notebook purchase.



Executive Mobile Service



$49.95 (one year); One year; $149.95 (three years) three years



No



Yes/yes



Yes



24 hours daily



Yes/yes



Adds onsite repair but no damage protection; must buy two-year extended warranty with the three-year contract.



Value Plan



Free to $149.99 (desktops); free to $229 (notebooks)



One to four years



No



No/yes



Yes



24 hours daily



Yes/yes



Basic warranty falls short, with just 90 days of free support. For additional coverage, the Value Plus Plan is a better buy.



Value Plus Plan



$99.99 to $139.99 One to (desktops); four years $99.99 to $299.99 (notebooks)



No



Yes/yes



Yes



24 hours daily



Yes/yes



Value Plan upgrade adds onsite repair—and includes advanced live chat with tech-support reps who can view, control, and troubleshoot your PC over the Web.



Total Protection Plan



$149.99 to $259.99 One to (desktops); four years $99.99 to $199.99 (notebooks)



Yes (notebooks only)



Yes/yes



Yes



24 hours daily



Yes/yes



Speedy tech-support options and next-day onsite repair are standout features, but at this price, notebook-only damage-protection limits the appeal for desktop users.
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Plan



Price



Term



AccidentalDamage Onsite Repair/ Free Online Protection Return-to-Depot Knowledge (ADP) Service Base



Toll-Free Phone Support Hours



E-Mail Support/ Live Chat



HEWLETT-PACKARD



Editor’s Take www.hp.com • 888-999-4747



Basic Warranty



Free



One year



No



No/yes



Yes



24 hours daily



Yes/no



Knowledge base is impressive, but lack of support via online chat weakens this basic support plan.



Extended Service Plan



$99.99 to $219.99 (desktops); $99.99 to $179.99 (notebooks)



Two years; three years



No



No/yes



Yes



24 hours daily



Yes/no



Covers displays purchased on same invoice as PC, and notebooks get express three-day repair, but we’d like either damage protection or onsite service at this price.



HP House Call for Desktops



$199.99 to $269.99 Two years



No



Yes/yes



Yes



24 hours daily



Yes/yes



Plan only applies to eligible desktops and Media Center PCs; includes live chat.



Yes



No/yes



Yes



24 hours daily



Yes/no



Adds damage protection to Extended Service Plan package, but plan doesn’t cover damage from user wear and tear. Must be bought within one year of PC purchase date.



Accidental Damage $149.99 to $199.99 One to Protection Extended (desktops); three years Service Plan $99.99 to $349.99 (notebooks) IBUYPOWER



www.ibuypower.com • 888-462-3899



Limited Warranty (Desktops)



Free



One year



No



Yes/yes



No



Mon to Fri, 11:30 a.m. to 8 p.m. (ET)



Yes/no



Limited phone-support hours, and no online knowledge base, but iBuypower includes onsite service.



Limited Warranty (Notebooks)



Free



One year



No



No/yes



No



Mon to Fri, 11:30 a.m. to 8 p.m. (ET)



Yes/no



Average notebook coverage weakened by limited techsupport options.



Depot Service Warranty (Notebooks)



$29



One year



No



No/yes



No



Mon to Fri, 11:30 a.m. to 8 p.m. (ET)



Yes/no



To cover shipping costs for repairs, notebook buyers should shell out the $29 for this plan.



Extended Warranty (Desktops)



$49 (two years); $79 (three years)



Two years; three years



No



Yes/yes



No



Mon to Fri, 11:30 a.m. to 8 p.m. (ET)



Yes/no



Great price, but use onsite support carefully—there’s a $165 service charge for software problems.



Limited Warranty (Desktops)



Free



One to four years



No



Yes/yes



Yes



24 hours daily



Yes/no



Terms vary greatly from model to model; some plans offer mail-in instead of onsite service.



Limited Warranty (Notebooks)



Free



90 days to four years



No



Yes/yes



Yes



24 hours daily



Yes/no



Aside from a few models with 90-day terms, notebooks get better-than-average coverage here.



Warranty Service $35 to $293 Upgrade (Desktops)



One to four years



No



Yes/yes



Yes



24 hours daily



Yes/no



The most-expensive upgrades provide long coverage plus 24/7, same-day onsite service.



Warranty Service $49 to $549 Upgrade (Notebooks)



One to five years



No



Yes/yes



Yes



24 hours daily



Yes/no



Lenovo’s willingness to cover notebooks for five years is reassuring, but we wish damage protection was an option.



Varies by model



No



No/yes



Yes



24 hours daily (one year)



Yes/no



Parts coverage is based on individual manufacturers’ warranties; five years of labor coverage for PCs $1,000 and up.



No



Yes/yes



Yes



24 hours daily



Yes/no



Depending on the price of your PC, this plan option can cost a bundle—plus, it requires the purchase of an onsite-service contract. No knowledge base.



No



No/yes



Yes



24 hours daily



Yes/yes



Solid limited warranty enhanced by superior knowledge base and live-chat support.



LENOVO



www.lenovo.com • 866-968-4465



POLYWELL COMPUTERS



www.polywell.com • 800-900-5836



Basic Warranty



Free



Enhanced Basic Warranty



3 percent of price One year; (one year); 8 percent three years of price (three years)



SONY ELECTRONICS



www.sony.com/pc39 • 866-823-7669



Limited Warranty



Free



One year



Express Ship (Notebooks)



$124.99 to $429.99 One to four years



No



No/yes



Yes



24 hours daily



Yes/yes



Sony’s most basic warranty extension for notebooks, this plan shoulders express shipping costs for depot repairs.



Onsite Service (Desktops)



$149.99 to $379.99 Two to five years



No



Yes/yes



Yes



24 hours daily



Yes/yes



Covers lightning damage if your surge protector fails, but no complete damage-protection plan is offered.



Onsite Service with ADP (Notebooks)



$199.99 to $439.99 Two to four years



Yes



Yes/yes



Yes



24 hours daily



Yes/yes



Pricey but well-rounded package covers all the bases for long-term laptop protection.



TOSHIBA AMERICA



www.toshiba.com • 800-316-0920



Limited Warranty



Free



90 days to three years



No



No/yes



Yes



24 hours daily



No/no



Best to upgrade if you’re stuck with a skimpy 90-day term. No live-chat or e-mail support.



At-Home Repair



$79 to $169



One year; three years



No



Yes/yes



Yes



24 hours daily



No/no



Same coverage as limited warranty, but with onsite support; a better deal when purchased with an extension.



SystemGuard Accidental Damage Coverage



$99 to $178



One year; three years



Yes



No/yes



Yes



24 hours daily



No/no



Well-priced damage-protection plan is offered in more term lengths when bundled with a warranty extension and/or at-home repair.



Extended Warranty



$99 to $399



One to four years



No



No/yes



Yes



24 hours daily



No/no



Most expensive for Qosmio laptops; for extra protection, consider adding the accidental-damage-protection plan.



Limited Warranty



Free



One to three years



No



Yes/yes



Yes



Mon to Fri, 7 a.m. to 11 p.m.; Sat, 10 a.m. to 6 p.m.



Yes/yes



Phone-support hours aren’t the best, but user-friendly live chat and up to three years of free onsite service can’t be beat.



VelocityCare



Free; $49 to $79 (varies by model)



One to three years



No



Yes/yes



Yes



24 hours daily



Yes/yes



This plan rounds out limited-warranty features with 24/7 phone hours; comes free with most models.



VELOCITY MICRO



www.velocitymicro.com • 800-303-7866
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WEB BUYER



149 149 150 152 152 154



Tech Products Mobile and Travel Accessories Sites for Audio Enthusiasts Direct PC Vendors Software VoIP Resources



THE BEST SITES FOR ONLINE SHOPPING • BY KEVIN SAVETZ



>>TECH PRODUCTS acortech.com Inexpensive PC accessories abound at Acortech. com. We found 17-inch LCD monitors for under $300, flash drives for under $20, optical mice for less than $5, and other low-cost goodies for certified tech geeks.



allstarshop.com When you wish upon Allstarshop.com, you’ll find low prices on a shimmering collection of cases, graphics cards, motherboards, and peripherals. The company provides free shipping on many items and plenty of information about each product.



circuitcity.com Plug in to Circuit City, where you can choose from a quarter million movies, video games, and CDs. The inventory also includes digital cameras, flat-panel televisions, and PDAs, which you can have delivered or pick up in a Circuit City store.



compusa.com The well-organized CompUSA rounds out the usual selection of PC hardware, peripherals, and accessories with areas devoted to home electronics and wireless gadgets. Set your own price on PCs at CompUSA’s auction site.



computergate.com Computer Gate offers a large selection of PCs and peripherals—everything from cases and chargers to mods and memory. Many items are automatically discounted if you buy more than one, and the company offers a 30-day return policy on its entire selection of PCs and peripherals.



computers.ebay.com eBay is an unparalleled auction site and a unique shopping experience. Shoppers can set their own prices on components, including new and used PCs, software, tech books, and vintage computers.



computers4sure.com At Computers4Sure, you’ll find 21 departments well-stocked with a broad spectrum of products, including networking gear, PDAs, and scanners.



cpusolutions.com Asus Vento 3600 from Allstarshop.com



CPU Solutions will entice you with inexpensive computer components and upgrade kits. The site offers several complete desktop computers for under $500, plus PC kits for under $300.



amazon.com



crutchfield.com



Amazon.com is an unparalleled superstore with a massive inventory equaled only by its special features, such as personalized product recommendations and mobile access. The Early Adopter Products pages show what’s fresh in electronics, video games, and DVDs.



Crutchfield.com showcases an impressive catalog of camcorders, digital cameras, and audio/video products for your home and car. Visit the Crutchfield Advisor for glossaries, guides to choosing components, and installation tips. The return policy—a 30-day money-back guarantee with free return shipping—is a bonus.



bestbuy.com Our readers voted Best Buy their favorite place to buy peripherals, handhelds, and storage. The selection in each department is comprehensive and impressive. The best part? You can have your gadget delivered, or pick it up at a nearby store.



buy.com Buy.com’s vast million-product inventory includes computer hardware, software, electronics, video games, books, music, and DVDs. Sister site BuyMusic.com delivers music downloads starting at 79 cents a song.



Illustrations by Bill Rieser



cambridgesoundworks.com Cambridge SoundWorks sells home audio and home theater products that will please everyone from budget-minded buyers to demanding audio buffs. Take advantage of the free shipping, as well as the 45-day price-protection and satisfaction guarantees.



cdw.com In addition to a wide selection of hardware and peripherals, CDW offers an Outlet section where you’ll find deals on clearance merchandise and customer returns. Click the Mac Warehouse tab to reveal a medley of Apple hardware and peripherals.



MOBILE AND TRAVEL ACCESSORIES



c-source.com The catalog at 14-year-old CompSource overflows with all types of PC products—more than 200,000 in all. Scrutinize the Best Sellers lists to find other customers’ favorite products in 17 categories, including printers, cameras, motherboards, and more.



cyberguys.com Cyberguys specializes in low-cost computer accessories and supplies. The catalog includes hard-tofind cables, fun PC add-ons, electronics tools, and networking equipment. Look for under-$4 gizmos in the Bargain Bin.



directron.com Directron.com has the stuff tinkerers dream of. The massive selection of PC gear includes cases, storage, mods, lighting, motherboards, and more. Plus, orders earn you the right to pick through the Free Stuff bin.



dirtcheapdrives.com Dirt Cheap Drives delivers low prices on a wide selection of hard drives. The Best Sellers page will show you the most popular units—we’ve found several nicely priced high-capacity drives there.



garmin.com Garmin specializes in Global Positioning System (GPS) receivers. Check out its StreetPilot units, which add color-screened moving-map navigation to any vehicle. The Purchase Assistant will help you choose the right model for your needs. igo.com Browse iGo’s selection of power accessories to stay in touch on the go. The superslim MobilePower 6000 universal battery will give your laptop an additional 5 hours of power. Or get the Juice charger, which can recharge two devices at once. laptoptravel.com Take a trip to Laptop Travel, a useful site selling notebook travel accessories, including foreign electrical and phone adapters, voltage converters, cases, and mobile desks. Check out the Travel Tips section for helpful advice before you hit the road. magellangps.com Thales Navigation’s Magellan line of GPS products includes receivers for outdoor adventures, driving, and marine use. The company also offers software packages to help you map out your trip. mobileplanet.com MobilePlanet has a world of hardware and accessories for travelers. MP3 players, wireless phones, and GPS receivers highlight the site’s offerings. The Accessorizer will show you compatible add-ons for the mobile devices you already own. radioshack.com Keep your gadgets running everywhere you go using the selection of power adapters and voltage converters at RadioShack. Look for the auto/air adapters, which charge your laptop in a car or from an aircraft’s in-flight power source. www.shop.teleadapt.com The “global travel products” at Teleadapt include regional phone and power converters and adapters that let you safely plug your laptop’s modem into a hotel’s phone system. If you want to keep your hardware safe even on questionable foreign power grids, consider a portable surge suppressor.
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WEB BUYER SHOPPING SITES discountlaptops.com



Complete Model Listing page provides a one-page comparison of the site’s 50-plus new laptops.



Check out Discount Laptops for reasonably priced new and refurbished notebooks from Chem U.S.A., Panasonic, Sager, and Twinhead. The handy



dvdempire.com



SITES FOR AUDIO ENTHUSIASTS



Browse the collection of videos, CDs, and video games at DVD Empire. You’ll find new and future releases, plus best-sellers in each category. Visit the Bargains section for cheap PC and console games.



ecost.com Look to eCost.com for deals on PC components, software, electronics, and DVDs, with free shipping on orders over $25. You’ll be enticed by short-lived but sweet deals in the Bargain Countdown area.



ergoindemand.com abtelectronics.com If you salivate at the thought of a 400disc CD changer or a thumping surroundsound speaker system, check out Abt Electronics. In business for 69 years, this site has everything an audiophile could want, including amps, tuners, cables, and headphones, all with inexpensive shipping. audioasylum.com Audio Asylum is a site run by self-described “audio lunatics.” Use the busy message boards to discuss the minutiae of audio systems—cables, speakers, and vintage gear. avsforum.com For advice on building your dream audio system, check out the AV Science Forum, a thriving community of home theater buffs. Join discussions on topics such as hi-fi audio and high-definition televisions.



At Ergo In Demand, you’ll find monitor arms, telephone swivel arms, copy holders, and keyboard trays—no object will ever have to touch your desk again. The company’s elegant flat-screen-monitor arms hold two or more LCDs.



fwdepot.com



monstercable.com Quality cables can mean the difference between good sound and phenomenal sound. Monster Cable Products sells high-performance cables, including THX-certified wiring for your home entertainment setup. Visit the Hookup & Learning Center for guides to connect it all together. tweeter.com Tweeter offers home audio products, plus plenty of iPods and other portable music players, with free shipping on most items. Click the Research link for shopping guides and articles.
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ncix.com NCIX.com makes it easy to learn about the computer hardware and accessories it sells. Customer ratings and reviews are included on every product page, so you can see if previous shoppers were satisfied.



newegg.com Newegg.com is a nest of good stuff for do-it-yourself PC upgraders. The selection focuses on hard drives, motherboards, CPUs, optical-storage add-ons, and consumer electronics.



outpost.com Shoppers at Fry’s Outpost.com enjoy an ample catalog of hardware, software, cameras, and video games. Notable features include the Power Search function, special deals, and a 30-day money-back guarantee on most products.



FireWire Depot stocks FireWire enclosures, external optical drives, PCI host adapters, hubs, and other accessories. You’ll also find high-speed USB 2.0 products, including cards, enclosures, and connectors.



insight.com Insight delivers IT products for businesses, including networking hardware, projectors, and servers. Check the Top Sellers in desktops, memory, and hard drives to find popular deals.



Linksys Wireless-G Broadband Router With SRX (WRT54GX) from Insight



Sony PlayStation Portable from Fry’s Outpost.com



pcclub.com



ecoustics.com eCoustics.com provides an abundance of information for home-audio hobbyists. Search thousands of links to product reviews—more than 500 in the CD Player section alone. Plus, the Hot Deals section, merchant ratings, and price-comparison tools help you find the bestsounding value. 800stereo.com At 800 Stereo, you’ll find a wide range of speakers, A/V receivers, high-end CD players, turntables, and other audio gear. The home theater section abounds with DVD recorders, plasma and LCD televisions, projectors, and even home theater furniture.



cialty modules. You’ll also find memory for your digital camera and notebook. Don’t forget to check out the deals on the Close Out page.



Here’s a club you’ll want to be a member of. PC Club stocks a full gamut of peripherals, as well as custom-built PCs. Weekly Specials deliver hot deals on storage, monitors, and accessories.



pcmall.com Catering to businesses of all sizes, and consumers, PC Mall’s catalog includes more than 100,000 products, with hot deals on notebooks, LCD monitors, and digital media. Sister site MacMall is devoted to Apple hardware and software.



journeyware.com



pcsound.com



Journeyware.com is a travel- and tech-gear site that sells ergonomically friendly laptop bags and rolling cases, plus cases for your PDA, camera, and cell phone. Shipping is free on orders of more than $50.



Listen up, y’all. Lone Star PC Sound sells sound cards from Creative Labs, M-Audio, SIIG, Turtle Beach, and other manufacturers. Put that card to work driving one of the site’s speaker sets—the selection includes models from 15 manufacturers.



monitoroutlet.com



pdaaccessories.net



From inexpensive CRTs to elegant and pricey plasma screens, Monitor Outlet sells a wide range of displays, with free shipping on everything. The site sells units from more than 20 manufacturers, plus specialty monitors such as touch screens, wideaspect-ratio screens, and projectors.



After a trip to PDA Accessories.net, your handheld will be all charged up and cozy. At this site, you’ll find PDA cases, chargers, holsters, and styli. Plus, the company offers free USPS shipping on every order.



www.motherboardsdirect.com



Shhh! For a PC that’s both cool and quiet, look to SilenX, a site that manufactures fans and heat sinks for your case, chipset, hard drive, and graphics-processing chip. Get a silent power supply to end your PC’s ceaseless drone.



When you buy a mobo from Motherboards Direct, the company installs everything and provides free technical support for as long as you own the board. You can even upgrade your whole system while you’re there; the site also sells drives, add-on cards, and other PC upgrades.



mushkin.com Mushkin Enhanced Memory sells a wide range of RAM, from double-data-rate (DDR) SDRAM to spe-



silenxusa.com



smarthome.com Smarthome specializes in home automation products, including security, lighting, and home theater. You can get an X-10 system to remotely control all the lights and appliances in your house, or choose a



WEB BUYER SHOPPING SITES touch screen that controls your thermostat, alarm system, and lighting.



machines, gamers’ dream systems, Media Centers, and budget PCs for everyday use.



surpluscomputers.com



dell.com



Surplus Computers buys and sells corporate excess, overstock, and slightly obsolete PC hardware and software. The hardware choices include desktops, laptops, and parts. For software, choose among older operating systems and office suites.



Dell’s electronic storefront has always led the way in ease of use. The site is jam-packed with detailed information that makes it a snap to match a machine to your needs. Each system is configurable to the nth degree, and you can get quick access to online support customized for your PC.



svcompucycle.com Silicon Valley Compucycle specializes in products that will keep your PC cool, including CPU heat sinks, fans, and chipset coolers. Power supplies, processors, and memory round out the choices for PC builders.



tigerdirect.com When you’re looking for deals and discounts, look to TigerDirect. This sizable catalog includes low-cost PC components, PDAs, and office equipment. Geeks on a budget can find desktop PCs for as little as $250, and laptops under $500.



usbflashstore.com USB Flash Store stocks a large selection of flashmemory drives and cards. Pick up a miniature Microdrive hard drive that lets you add 1GB to 4GB of fast storage to your digital camera or other portable device. Free same-day shipping is available on every item the site sells.



zipzoomfly.com ZipZoomFly.com targets savvy shoppers who want performance computer upgrades without frills. You’re bound to discover unbeatable bargains on peripherals, software, and accessories. More deals are up for grabs in the Open-Box shop and Rebate Center.



Dell’s Latitude X1



Once you get your talons on a Falcon Northwest PC, you won’t want to let go. The heavyweight desktops and totable FragBox computers include the hardware you want, the way-cool look you crave, and the personalized system-rescue discs you may one day need.



gateway.com One of the biggest players in online computer sales, Gateway has an enormous and informative site that sells custom-built desktops and notebooks. For your living room, Gateway also sells wide-screen plasma and LCD televisions.



hpshopping.com At this site, choose between Hewlett-Packardand Compaq-branded desktop and notebook computers, plus networking accessories, printers, handhelds, and digital cameras. Need computing power that’s faster than fast? Go hypersonic. Check out Hypersonic PC for gaming systems, workstations, and laptops outfitted with the latest high-performance peripherals. “Enthusiast options” include 3D-graphics optimization and case customization.



alienware.com Alienware can custom-build your dream game machine—desktop or laptop. Each is available with out-of-this-world cases in a rainbow of colors. Buyers get a personalized owner’s manual and toll-free technical support any time of the day or night.



buympc.com MPC Computers sells desktops, notebooks, and servers. You can custom-configure a high-performance Millennia desktop, tuned to your specifications, for business, multimedia, or gaming.



cyberpowersystem.com Power up with a customized Intel or AMD system from Cyberpower. The selection includes 64-bit
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The custom-configured notebooks and Tablet PCs at Toshiba Direct range from budget models to the unique Qosmio laptops, which combine PC, TV, DVD, and audio features.



us.fujitsu.com/shop falcon-nw.com



There’s a zone for whatever you need at Zones: the home page for hardware and software, the Mac Zone for Apple stuff, the Creative Pro page for graphics pros, and the Zones Clearance section for special buys.



Expect gaming, multimedia, and business PCs aplenty at ABS Computer Technologies. The company offers a choice of Intel or AMD processors, a three-year parts and lifetime labor warranty, and toll-free technical support. Visit the Outlet Store for short-lived specials.



Sony Style is a sleek-looking site selling Sony’s line of VAIO desktops and notebooks, plus digital cameras, displays, and storage devices.



toshibadirect.com



hypersonic-pc.com



abspc.com



sonystyle.com/vaio



The Apple Store’s well-designed site allows you to custom-configure any Macintosh, and offers a wide array of Mac-compatible software and accessories. For frequent (or compulsive) customers, the one-click-ordering feature makes purchases extra-simple.



zones.com



>> DIRECT PC VENDORS



Each computer in ProStar Computer’s line of notebook PCs is backed by a 30-day money-back guarantee, a speedy-repair promise, and free tech support.



store.apple.com



techforless.com What happens to the PCs and peripherals that customers return to the store? Some of them end up at Tech for Less, which tests and resells them to budget-minded shoppers like you. A 30-day return policy applies to all products, but you may not get a warranty beyond that.



shopprostar.com



ibuypower.com iBuypower can power up your workspace with a 64-bit PC for less than $500. Even the company’s least-expensive PCs include large hard drives, dedicated graphics cards, desktop speakers, and other essentials. All products are backed by a 30-day money-back guarantee.



Fujitsu’s site focuses on portable computing, including notebook PCs and pen-based tablet computers. Each computer includes several warranty options.



velocitymicro.com Looking for a 64-bit processor to push your games to the limit? They’re in Velocity Micro’s Gamer’s Edge and Raptor models. The customconfiguration menus offer a mind-boggling array of component choices.



viciouspc.com Creating “hardware for the hard-core,” Vicious PC sells desktops with clear cases, high-output ventilation, easy-access sliding rails, and front-accessible USB ports. Washable air filters mean your computer’s innards will remain dust-free.



voodoopc.com Nobody else can do the voodoo that they do so well. VoodooPC specializes in high-end PCs for gamers, with a choice of Intel or 64-bit AMD processors. Take your pick among tower systems, laptops, and portables—all thoroughly customizable, of course.



winbook.com WinBook Computer sells laptops and desktops with a 30-day money-back guarantee, a one-year warranty, and free tech support. Ironically, some of the best deals,“Web specials,” can only be ordered by phone.



idotpc.com Find a customized desktop, an economical barebones PC, or a personalized laptop at iDotpc.com. Menus let you create the PC that’s right for you, letting you specify the processor, memory, optical drive, and other necessities.



maingear.com



WinBook’s PowerSpec MCE 410



MainGear specializes in premium PCs with advanced specs for gamers and other power users. The selection includes sleek-looking and colorful desktops, space-saving X-Cube machines, and powerful laptops.



>> SOFTWARE



sagernotebook.com



atomicpark.com



Specializing in notebook computers, Sager offers a variety of options, from budget machines to speedy multimedia units. Service includes a 72-hour repair-turnaround guarantee and free lifetime tech support.



AtomicPark.com’s entire selection of business and productivity apps includes free shipping. Plus, you’ll never pay a restocking fee. The new Direct Downloads section lets you use new software in minutes, not days.



WEB BUYER SHOPPING SITES bigclearance.com



distrowatch.com



Offering current-version software at clearance prices, the big selection at BigClearance.com includes wares from Microsoft, Macromedia, Corel, and others.



Keep up-to-date on the latest Linux and FreeBSD distributions with DistroWatch. You’ll find news about free operating systems and links to the most popular distros in categories such as multimedia, beginner-friendly, and live CDs.



buycheapsoftware.com The name says it all. Buycheapsoftware.com’s selection consists primarily of business and utility apps. The company offers flat-rate $5 shipping on small orders and free shipping on orders over $200.



VoIP RESOURCES



www.fcc.gov/voip The Federal Communications Commission’s Voice over Internet Protocol (VoIP) page explains the technology and its hardware requirements in plain English. Also look for the downloadable fact sheet and news about federal rulings regarding VoIP.



liberatedgames.com Check out Liberated Games to get your free, legal game downloads. The site catalogs commercial game titles that have been released for free by the developer or publisher—sometimes with the source code.



ebgames.com EBgames.com is a gamer’s paradise, selling new and pre-owned titles for PCs and every game console under the sun. Check the Hot Deals list for short-lived discounts.



Linux Games brings news and reviews of new games (both open-source and commercial), plus links to downloadable titles. In the forums, discuss your favorite PC pastimes, game-development projects, and more.



filebot.org



nothingbutsoftware.com



Buy software, download it, and get instant gratification with FileBot. This site sells a wide variety of audio apps, system utilities, business titles, and games. Free trial versions are available for many programs.



You’ll make much ado about Nothing But Software. This catalog of apps includes games, educational titles, graphics programs, utilities, and more— all with flat-rate shipping. Try the programs in the Bargains section for as little as $5.



5dollarsoftware.com Stock up on software without breaking the bank. As the name implies, everything at 5 Dollar Software costs just $5, including games, educational titles, and utilities. Flat-rate shipping for orders of any size costs $3.



pulver.com Pulver.com offers a wealth of information about VoIP, including news about services and trends. The company’s Free World Dialup project lets you use your broadband connection to make free phone calls.



gamerang.com



www.voipuser.org VoIP User is a consumer-information guide devoted to Internet telephony. You’ll find VoIP router and phone reviews, downloadable voice-chat software, and a busy discussion forum. Click the Top List link to see the most popular articles on the site. voip.weblogsinc.com Readers of The VoIP Weblog get the lowdown on the latest in voice-on-theNet, including sneak previews of new services, details about emerging trends, and industry news.
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Jumbo is a fitting name for this monstrous file archive, featuring shareware, freeware, and commercial-software demos for PC, Mac, and Linux.



CNET Download.com will help you find shareware and free software, linking to thousands of programs for PC, Mac, and mobile devices. Wellwritten newsletters and down-to-earth reviews help you find the perfect program. (CNET Networks is Computer Shopper’s parent company.)



gamehippo.com



voipreview.org VoipReview.org will help you find an Internet phone service that meets your exacting criteria. Use the drop-down menus to find a service for home or business with a phone number in your area code. The FAQ and VOIP 101 sections answer basic questions about voice services.



jumbo.com



download.com



ordervoip.com OrderVoIP.com provides comparative reviews of six major VoIP services. Once you’ve decided on the service that fits your needs, the site’s special offers can sweeten the deal.



voip-info.org VOIP-Info delivers extensive information about everything related to Internet voice services. Comparison shoppers will find links to service reviews around the Web, and technical folks can delve into details about network design.



and add-ons are available for hundreds of Windows games. If you had a tail, it would be wagging.



GameHippo.com provides more than a thousand absolutely free downloadable PC games. You’ll find descriptions, ratings, and easy-to-read icons that show whether a game supports multiple players, a network, and so on. Check the Top 20 Rated Games to discover other players’ favorites. For $15 per month, Gamerang will rent you one console video-game title at a time. You can swap games as often as you want, or keep a game for as long as it piques your interest. Shipping is free both ways.



gamesondemand.yahoo.com Play full-version commercial games without a CD drive at Yahoo Games on Demand. Armed with a broadband connection, you’ll enjoy unlimited play of up to 10 games per month, or you can try one game for just a few days. The site also provides reviews, previews, and game headlines.



gamespot.com With game news, reviews, and cheat codes, GameSpot is a one-stop shop for PC and console gamers. Downloadable previews and a pricecomparison tool will help you get good deals on games you’ll love. (GameSpot is owned by CNET Networks, Computer Shopper’s parent company.)



gamestop.com GameStop.com is an elegant site that specializes in new and used games for consoles and PCs. Recent price drops, top sellers, and “just arrived” products are highlighted, so you’ll always know the score.



handango.com Just like your PC, your PDA and mobile phone need software, too. Handango delivers hundreds of commercial-software downloads for Palm OS, Pocket PC, BlackBerry, and other handhelds. Browse the bestselling or newest software, then download apps for your device.



happypuppy.com Happy Puppy sniffs out games like a bloodhound. You can download files, read reviews, trade cheats, and talk about games with other fanatics. Patches



linuxgames.com



palmgear.com Palm OS users will appreciate the large selection of free and commercial programs downloadable from PalmGear.com. Check out the list of “essential” apps, then sign up to get software news and tips.



pricebustersoftware.com Who you gonna call? PriceBuster Software, that’s who. The site sells applications and utilities from Corel, Macromedia, Microsoft, and other top-shelf publishers, with sensible shipping fees.



snapfiles.com Download shareware and freeware in a snap with SnapFiles. This site will point you to the latest software releases and top-10 titles. The $19.95-per-year Pro version of the site adds e-mail software alerts, user ratings, and other features.



software-blowouts.com Software Blowouts is home to oodles of inexpensive Windows and Mac OS software, with flat-rate shipping. Peruse the Blowouts page for education, entertainment, and utility titles, many for just $9.95.



softwareoutlet.com Plug in to SoftwareOutlet.com, a veritable virtual bargain bin. You’ll find dirt-cheap applications and hardware accessories. The selection includes older software and wares from defunct companies, plus some modern, mainstream titles.



softwarepatch.com Make cranky software behave with help from The Software Patch. Download patches, upgrades, service packs, and hardware drivers for Windows and the software that runs on it. Start at the Top Downloads area for the most-popular upgrades.



versiontracker.com Keeping the software updated on your PC, Mac, or Palm OS device doesn’t have to be a chore. VersionTracker reports on the latest versions of shareware, freeware, and commercial software. Top downloads and editors’ picks highlight which new software is worth your time.



winsite.com/free WinSite has a stash of free software for Windows 95 through XP, including thousands of games, utilities, and screensavers. Browse by category, or set your sights on the week’s most popular downloads.



HELP & HOW-TO



BUYING BASICS HOW TO BUY



The Right Desktop-Replacement Notebook BY SEAN PORTNOY SHOPPING SPECS



PROCESSOR Once used only in thinner and lighter models, the Pentium M mobile processor is now found even in high-end gaming systems. Look for the 915 chipset, part of Intel’s newest version of the Centrino group of mobile technology called Sonoma, for maximum performance. Among other perks, it has PCI Express support for faster exchange of data between the CPU and other components.



GRAPHICS ACCELERATION If you’re looking for a notebook that can handle graphics-intensive programs, the Intel 915PM chipset provides support for a PCI Express notebook-graphics solution, like the 128MB ATI Mobility Radeon X600. More-budget-conscious buyers should look for a 915GM-based laptop with a builtin Intel Graphics Media Accelerator 900, which borrows RAM from the main memory supply.



DISPLAY



Toshiba Qosmio G25-AV513



Ready once and for all to junk that big PC cluttering up your office? A desktop-replacement laptop provides all the functionality of a traditional desktop computer in a portable package. 3 GREAT BUYS GOOD HP Pavilion ZD8000 (www.hp.com, starting at $1,199) The ZD8000 still relies on a Pentium 4 processor, but even the base configuration features a 17-inch wide-screen display and Bluetooth support, plus a PCI Express slot to configure the system with Radeon X300 or X600 mobile graphics.



Look for a laptop with at least a 15-inch display if you plan to replace your primary desktop. (A 15-inch LCD provides roughly the same viewing space as a 17-inch CRT monitor.) If you don’t plan on moving your notebook from your desk often, you might want to splurge on a unit with a 17-inch display. Get a wide-screen LCD if you plan on watching a lot of DVDs on the laptop.



WIRELESS NETWORKING Whereas the previous generation of Centrino systems had built-in 802.11b/g Wi-Fi support, the newest laptops have a chip supporting 802.11a/b/g networking. Some notebooks also feature built-in Bluetooth support, which makes it easy to wirelessly sync with compatible mobile Stephanie Bruzzese contributed to this article. devices.



BETTER Dell XPS Gen 2 (www.dell.com, starting at $2,361) Ideal for gamers, our $2,650 XPS Gen 2 test configuration packed the latest Pentium M CPU (the 2.13GHz Pentium M 770), as well as nVidia GeForce Go 6800 Ultra graphics with 256MB of video memory, a 17-inch wide-screen display, and 802.11b/g Wi-Fi networking.



BEST Toshiba Qosmio G25-AV513 (www.toshiba.com, starting at $2,999) A laptop for those who want it all, this Qosmio has a 2GHz Pentium M 760 CPU, a 17-inch wide-screen LCD, PCI Express support, and built-in 802.11a/b/g networking. It also runs the Windows XP Media Center Edition 2005 OS and includes a built-in TV tuner. = Editors’ Choice
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